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Chapter 1. Introduction
1. Purpose
neuroVIISAS is a generic framework for data integration, analysis and visualization in neuroscience. It has been
developed since 2004 to its present 0.2x version and can be used on Microsoft Windows, Linux and MAC 32Bit
and 64Bit operating systems. The framework generates ontologies, assign terms of ontologies to image regions
(mapping) and administrate connections between regions derived from tracing studies. The ontology, image and
connectivity data can be visualized in 2D and 3D. The connectivity data are represented as networks which can
be quantitatively characterized by basic matrices of directed and weighted graphs, analyzed with global and local
network parameters and explored statistically by applying randomization models. The connectivity of regions of
nervous systems can be represented on different scales of the ontology (neuroanatomical hierarchy of regions)
or on one scale (simple list of regions) only. Selections of brain regions are allowed to be defined interactively
and analyzed by network analysis tools. Selections of regions and their underlying connectional structure can
be used for population based large scale simulations by generating PyNEST scripts for the simulation engine
NEST (Gewaltig M-O and Diesmann M (2007) NEST (Neural Simulation Tool) Scholarpedia 2(4):1430; http://
www.nest-initiative.org/index.php/About_Us). The results of simulations are analyzed and visualized in 2D and
3D in neuroVIISAS in the context of their inherent spatial and connectional structure.

neuroVIISAS is generic because it can generate and compare multimodal atlases or connectomes of

• the human brain (e.g., http://imaging.mrc-cbu.cam.ac.uk/imaging/MniTalairach)

• the mouse brain (e.g., http://mouse.brain-map.org/)

• the rat brain (e.g., http://software.incf.org/software/waxholm-space)

• the macaque brain (e.g., http://cocomac.org/home.asp)

• Caenorhabditis elegans (e.g., http://www.wormatlas.org/)

• Zebrafish (e.g., https://humboldt.edu/gahtan_lab/connectome)

• Human connectome database (http://umcd.humanconnectomeproject.org/browse)

• brains of other organisms (hamster, birds, dogs, rabbit, gerbil, feline, pigeon etc.)

In summary, neuroVIISAS is a generic and integrative framework for organizing, analyzing, visualizing and sim-
ulating data of nervous systems. Currently two languages are supported: English and German.

2. Dependencies
neuroVIISAS uses

1. The Visualization Toolkit VTK (http://www.vtk.org/)

2. InfoNode Docking Windows (http://www.infonode.net/)

3. Yusuke Kamiyamanes Fugue Icons (http://p.yusukekamiyamane.com/)

4. Michael Thomas Flanagans Java Scientific Library (http://www.ee.ucl.ac.uk/~mflanaga/java/)

5. DobuDish (Agynamix®) (http://www.agynamix.de/products/dobudish/)

6. The Colt open source libraries for high performance scientific and technical computing in Java (http://
acs.lbl.gov/software/colt/)

7. EpsGraphics 1.0.0 by Thomas Abeel
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3. Software export, import and interaction
neuroVIISAS exports to

1. CGV (http://www.informatik.uni-rostock.de/~ct/software/CGV/CGV.html)

2. Cytoscape (http://www.cytoscape.org/)

3. Protege (http://protege.stanford.edu/)

4. Mavisto (http://mavisto.ipk-gatersleben.de/)

5. Graphviz (dot graph language) (http://www.graphviz.org/)

6. Circos (http://circos.ca/)

7. MySQL

8. openSlide (http://openslide.org/)

neuroVIISIAS imports

1. Contour data from Matlab®

2. CoCoMac contours from xml files (http://scalablebrainatlas.incf.org/main/coronal3d.php?
template=PHT00&plugin=CoCoMac)

3. NifTI data

4. Lists of tabulator separated connectomes with or without weights

5. XML data from BAMS2 (http://brancusi1.usc.edu/connectome/)

6. DTI connectivity data from the UCLA multimodal connectivity Database (http://
umcd.humanconnectomeproject.org/update/5)

neuroVIISAS interacts with

1. NEST (http://www.nest-initiative.org/index.php/About_Us)

2. PyNEST (http://www.nest-initiative.org/index.php/PyNEST)

3. BibTex reference lists (http://jabref.sourceforge.net/)

4. Further material
In this help and on the neuroVIISAS webpage (http://neuroviisas.med.uni-rostock.de/index.html) many contours
and reconstructions are based on The Rat Brain In Stereotaxic Coordinates (2007) of George Paxinos and Charles
Watson. Most contour data were linear registered and manually completed especially those regions that overlap
or possess open shapes.
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Chapter 2. Installation
1. Windows 32 Bit
1. Download http://neuroviisas.med.uni-rostock.de/versions/setup_neuroVIISAS_0.106_beta_win32.exe

2. Install setup_neuroVIISAS_0.*_beta_win32.exe

3D visualization and the generation of Python (PyNEST) scripts for simulations are possible. Simulations can
only be performed on Unix system. The PyNEST script that was generated on a Windows system can be copied
to a Unix machine with installed NEST to perform the simulation. The results of the simulation are stored in a
results file that can be copied to the Windows system for analysis and visualization in neuroVIISAS.

2. Windows 64 Bit
1. Download http://neuroviisas.med.uni-rostock.de/versions/setup_neuroVIISAS_0.106_beta_win32.exe

2. Install setup_neuroVIISAS_0.*_beta_win32.exe

3D visualization and the generation of Python (PyNEST) scripts for simulations are possible. Simulations can only
be performed on Unix system. The PyNEST script that was generated on a Windows system can be copied to a
Unix machine with installed NEST to perform the simulation. The results of the simulation are stored in a results
file that can be copied to the Windows system for analysis and visualization in neuroVIISAS.

3. Linux 32 Bit
1. Download http://neuroviisas.med.uni-rostock.de/versions/neuroVIISAS_0.106_beta_Linux_32.tar.gz

2. tar xfvz versions/neuroVIISAS_0.*_beta_Linux_32.tar.gz

3. Execute sh ..\neuroVIISAS\run.sh

To perform a simulation NEST and Python must be installed. In terms of 3D visualization problems VTK must
be compiled (see below).

4. Linux 64 Bit
1. Download http://neuroviisas.med.uni-rostock.de/ver-

sions/neuroVIISAS_0.106_beta_Linux_x86_64_suse11.4.tar.gz

2. tar xfvz neuroVIISAS_0.*_beta_Linux_x86_64_suse11.4.tar.gz

3. Execute sh ..\neuroVIISAS\run.sh

To perform a simulation, NEST and Python must be installed. In terms of 3D visualization problems VTK must
be installed (see below).

5. Updates
If an older version of neuroVIISAS is already installed an update of neuroVIISAS.jar from http://
neuroviisas.med.uni-rostock.de/versions/ can be copied into the program directory of neuroVIISAS and overwrite
neuroVIISAS.jar.

6. Linux derivatives
neuroVIISAS has been extensively tested on the OpenSuse Linux distribution. On Debian and Ubuntu Linux
distributions VTK-Java is installed in /usr/lib/jni which need to be added to LD_LIBRARY_PATH.
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7. vtk compilation for a Linux OS
1. YAST2 install appropriate cmake version for Linux distribution

2. YAST2 install appropriate jdk version for Linux distribution

3. vtk download from http://www.vtk.org/download/

4. unpack sources

5. start cmake-gui from consol (graphical frontend of cmake)

6. define source code path

7. define binary path

8. checkmark "Aadvanced"

9. Press "Configure" and select "Unix Makefile"

10. Checkmark vtk_Wrap-Java

11. Press "Configure" again until not red messages in the console window appear and all lines in the main window
are with white background instead of red background

12. Press "Generate"

13. Go to vtk*\bin directory and open in console

14. From console enter "make"

15. Copy binaries and link files to the program directory ../neuroviisas/vtk
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Chapter 3. Projects and Data
The basic data structure of neuroVIISAS is a project. A project file contains an ontology container, image modal-
ity data, connectivity data and configuration data like coordinate system (stereotaxic coordinates, native image
coordinates, coordinate scaling and pixel transformations into a metric scale) of an image modality.

1. Main Window
If a project file does not exist it can be generated. In the following the necessary steps to generate a project and
a project file are described.

1. Open neuroVIISAS.

2. File.

3. Click on "Settings" -> "Select language" -> Select either English or German.

4. Create new project (Strg + N).

5. Open an image sequence (or a dummy image).

6. Select the first image of an sequence of *.png, *.tif, *.jpg images. The sequence of images is determined by
the image file name using the sorting scheme of the operating system. The path to the images can be modified
within a project by selecting "Settings" -> "Change project setting" -> "Specify new image directory".

7. Continue.

8. The question "Should all Images be tested?" can be answered with "No" if each image has the same width
and height.

9. The number of images that have been found are indicated.

10.Pixel width, pixel height, Distance of sections can be assigned in the format 1 or 1.0, not 1,0.

11.Continue.

12.By using the mouse wheel we can zoom the image. Press the mouse wheel and hold it for shifting the image.
Zooming can be also performed

by clicking the right mouse button on the image.

13.If an existing hierarchy of terms or ontology should be used, it can be imported now. Because we want to
generate a new hierarchy of terms just "Continue" should be pressed.

14.The name of the new project is defined here, e.g., "rat".

15.Press "Ready".

16.The project file can be generated directly by selecting "File".

17."Save project". Then it is possible to directly close neuroVIISAS otherwise the user will be asked were to store
the project.

Attention: The name of the project (12) need not to be identical with the name of the project file (14).

After defining the project, neuroVIISAS appears as shown in the following figure. The figure shows the main
window of neuroVIISAS. The left part contains the project tree (Modality), terminology variant trees, and the
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specific region tree. The "Name" field at the button is used for searching region names or parts of regions names
of the hierarchy. Parts of longnames can also be searched (nigr compac --> Substantia nigra pars compacta). If
multiple longnames match the searched expression than the shortest longname will be shown in the first row of the
search result table followed by alphabetically sorted longnames. Left or Right or All results can be switched on and
of to reduce the number of matches. Multiple shortnames can be selected and Ctrl+c copy them into the temporary
memory (to put them into a external spreadsheet application). The windows which shows the results are always in
the foreground of the desktop. After the size is adapted for a small notebook screen or large screens the size and
location of the result window will be used again after closing and opening. The hierarchy can also be searched
for abbreviations in the "short name" field or connections. In the middle of the main window the image modality
(atlas, histology, MRI, CT, autoradiography, in situ hybridization, immunohistochemistry etc.) is shown. In this
case one of 4224 Gallyas stained sections of one rat brain is shown. In the right part of the main window a low
resolution navigation image is shown. Below there are two tab fields whereby the "Brainregion" tab is selected.

On the left side a frame appears that contains the root node "rat brain" of the hierarchy. We are using this root
node to develop or refine the hierarchy.

1. Click with right mouse button on the root node "rat brain"

2. Select "New node"

3. Give the full name of the new region, e.g. "Nervous_system"

4. After "Nervous_system" has been written it is necessary to press Enter.

5. Then click on the empty cell below "Short name" and write the abbreviation of the region, e.g. "NS"

6. Enter (after pressing Enter the black frame around the cell disappears).

7. Press "Accept"
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Figure 3.1. The customizable window for defining new regions.

A right mouse click on the row offers the following options:

1. Add row.

2. Remove row.

3. Duplicate row.

"Use previous values" is a useful option to automatically use the last used bibliographic link for the new region.

It is possible to add a publication terminology of a region (where subdivisions or part are the leading part of a
longname) to the atlas terminology (where superior regions build the first part of a longname and subdivisions or
part build the last part of the longname). Highlight the part of the longname that should be put before the longname
by clicking with the left mouse key to the first position (start) that should be clipped:
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Figure 3.2. The mouse pointer has clicked just before the "m" of medial indicated by a
vertical bar.

The part of the longname that should be rearranged is now marked:

Figure 3.3. Marking of the part shat should be rearranged.

Then clicking on the right mouse button to open the "Add rearranged alias name" option:
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Figure 3.4. Opening of the "Add rearranged alias name" option.

After clicking on the "Add rearranged alias name" option a new row is added and the marked part of the first
longname has been put forward by adding a "of_the_" automatically.

Figure 3.5. The new alias name has been generated.

2. A neuroVIISAS project

neuroVIISAS is build to work with nervous systems of all organisms. Different project can be opened as shown
in the following figure (the two smaller windows under the large "Modality" window in the left part of the main
window). A neuroVIISAS can be defined and specified by generating a modality tree. The modality may contain
a phylogenic, gender, developmental, weight, body part specification (organ), technical, section orientation and
staining subtree as shown in the following figure.
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Figure 3.6. The modality tree of a neuroVIISAS project.

The modality tree is stored with a particular project. The "File" menu in the main window offers the storage,
opening and generation of a new modality hierarchy. The neuroanatomical terms of the nervous system of model
organisms like mice and rats change rapidly at the level of finer subdivisions of neuroanatomical entities. To
represent the development of a terminology of a particular organism a variant hierarchy can be generated that
includes multiple differences of terminological hierarchies. All terms of all variants are organized in a container
hierarchy. The variant hierarchy of the hypothalamus is shown in the following figure.
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Figure 3.7. Variant tree of the hypothalamus.

Those nodes that contain either a change of a term or a change of the subtree structure are marked with red. Terms
that do not exist in the variant terminology are marked with yellow and are canceled. Using variant trees it is
possible to visualize and analyze with a specified terminology. Nodes that are only highlighted by yellow indicate
a movement of the region to another branch of the hierarchy.

3. Controlling the hierarchy

The following figure shows the hierarchy of anatomical and neuroanatomical regions of the organism rat.
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Figure 3.8. Overview of the main windows with the rat organism hierarchy in the left part
of the window.



Projects and Data

13

Figure 3.9. Detail from the last figure to show the structure of a hierarchy.

Hierarchies can be defined by the demand of a user. Here, an example is shown. It is not necessary to build a hierar-
chy of regions to perform mappings and visualizations, however, terms have to be arranged in a list. A hierarchy in
neuroVIISAS contains always a root node and is an acyclic graph. The root node in this example has the name "Or-
ganism". It can be changed by clicking with right mouse button and then select "Rename". Basically, subdivisions
of nervous systems can be realized with regard to neuroanatomical entities (regions, structures), functions (vision,
olfaction, motoric, sensoric etc.), connections and compositions of them. In the rat project the whole organism is
considered. Hence, there exists a subtree for "Organs" and the "Peripheral nervous system". At the 4th level of the
hierarchy the node "Central_nervous_system" divides into the childnode "Central_nervous_system_left_L" and
"Central_nervous_system_right_R". For conventional atlas projects a subdivision into left and right hemispheres
or parts of a nervous system is not necessary because these atlases are intended to be used for navigation and
orientation. Because neuroVIISAS allows to work with ipsilateral and contralateral connectivity information a
mechanism has been implemented that allows the differentiation of a left and a right part of a nervous system. In
order to facilitate navigation, e.g., jumping from a region in the left part of the nervous system to the corresponding
region in the right part, it is possible to tell neuroVIISAS what is the left and what is the right root of a nervous
system. A further option to jump through large hierarchies is the backtrace function which allows to jump to the
last selected region in the hierarchy by pressing the shift key and the "left arrow" key. The combination of the
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shift key and "right arrow" key allows to jump forward in the hierarchy. The blue rectangle around "Organism"
indicates a selection, that has been made by clicking with the left mouse button on the node. A further element is
the thin vertical blue line: this line indicates a relation between a region and its neighbours (at the same levels),
its parents (upper level) or its children (lower level). The blue circle with the vertical line indicates a branching.
By clicking on a branching circle the subtree will be expanded. Between the branching circle and the name of the
region three symbols may appear: a gray star (no contour exists), a yellow star (a rendered contour exists) and a
polygon sign (a contour that is not rendered exists). A colored square with a check box indicates if a region with
its contour is selected. If a check mark is set into the check box then the contour of the region will be highlighted
in those images where it appears. If an image is displayed that does not contain the region that has been selected in
the hierarchy it is possible to jump to the first, last or next image where the contour of the selected region appears
by pressing the polygon plus button beside the triangle button (fast scrolling through image stack) or the minus
polygon button. The green plus or red minus image step buttons allows to select the next/last, next/last 5, next/
last 10 or next/last 100 image. Furthermore, the "Go to image:" field allows to go to a specific image. The arrow
circle button beside the "Go to image:" field switches the image navigation bar to an image scroll bar. If a region is
selected in the left subtree, respectively, left part of the nervous system, we can jump directly to the contralateral
region by pressing "r" (to the right side) or "l" (to the left side).

Figure 3.10. Image navigator bar.

Many terms of regions consists or more than one word. These words are connected by underscores to be compatible
with owl naming conventions. The last character of those regions that occur on a left and a right side of an organ or
nervous system indicates the side (L for left and R for right). Hence, it is possible to map asymmetric regions, e.g.,
the Broca area in the human brain. The rat central nervous system consists of many asymmetric neuroanatomic
entities like, e.g., the corpus callosum or the intermediodorsal thalamic nucleus. To allow differentiation of left and
right parts of these structures they can be attributed as "asymmetric" (see below) and subdivided in the hierarchy
into a left and a right corpus callosum or intermediodorsal thalamic nucleus. The hierarchy is sensitive by moving
the mouse on a node. Then a tool tip will be displayed showing information of the region (see figure). In this
example the mouse pointer has been moved on the node "Rat". The node has no afferents (inputs = indegree) or
efferents (outputs = outdegree). However, the subtree contains 120068 links (indegree + outdegree) and 11187
subregions.
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Figure 3.11. Tool tip of the node "Rat".

By clicking with the right mouse button on a node of the hierarchy a menu will be opened that allows some
operations of node, subtrees and the whole hierarchy.
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Figure 3.12. Menu for hierarchy operations.

• Rename: Rename a term of the hierarchy.

• Edit attributes: The tree of attributes can be defined or an attribute can be assigned to a node (see below "4
Attributes").

• Edit relations: The tree of relations can be defined or an relation can be assigned to branch of the hierarchy
(see below "3 Relations").

• Edit connections: The connection editor window will be opened. The same operation can also be performed by
pressing the button "Edit connections" in the left part of the main window (see below "6 Connections").
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• New node: a new node can be added. A dialog is opened containing the longname, respectively, the term of the
parent node, e.g., "Pars_cranialis_x_L". At the position "x" a new word or spatial definition (e.g., anterior_part
or "anterolateral_subdivison_of_mediodorsal_zone_of_posterolateral_aspect") is expected. The abbreviation
of the parent node is given in order to be modified or changed for the new subregion. A relation with regard to
the parent node can be defined based on the relation definitions (see below "3 Relations"). Synonyms can also
be added into the table by clicking with the right mouse button on a row and then select "Add row". The plus
sign button on the right expands the table and shows the columns "Bibliography" and "Language".

Figure 3.13. The dialog for defining a new node.

In the field "Bibliography" a reference can be selected by clicking with the right mouse button in this field an
opening alphabetically sublists of references (see figure below). The list of references is administered in JabRef
(see "6 Connections").

Figure 3.14. Selection of a reference which have used the newly defined term.
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After defining the node it must be integrated in the consisting hierarchy. This can be done on the side of the
hierarchy were the parent node of the new region exists or automatically on the contralateral side, too. In the later
case, the check box "Make changes on both sides" must be check marked. If several new regions of the same
publication have to be added to the hierarchy, it is possible to use previous bibliography information that will be
inserted after pressing the "Use previous values" button. To take effort of the new region definitions the "Accept"
button must be clicked.

• Create multiple subregions: Many areas of the cerebral cortex have the same pattern of lamination and consists
of 5 (agranular), 6 (granular) or fewer (dentate gyrus) basic layers. This pattern of lamination can be generated
automatically by the "Create multiple subregions" function. If 6 layers of the "Posteromedial barrel subfield
A1" should be generated then we have to set "6" in the field "Number of Subregions", changing the abbreviation
(=short name) template, check mark the "Make changes on both sides" and then press "Accept".

Figure 3.15. The "Create multiple subregions" menu.
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Figure 3.16. 6 newly generated cortical layers have been generated on the left side (as
shown here) and on the right side.

• Delete node: Delete a node of the hierarchy ipsi- or bilaterally.

• Copy node: Makes a copy of a node with all subregions. The copy can be added into any other part of the
hierarchy by selecting a node and clicking on "Insert node".

• Cut: Moves a node with its subtree to another node.

• Insert node: Inserts a copy of a node with subtree or a cut out node with subtree.

• Insert children nodes as Copy: Inserts only the children nodes of a copy or a cut.

• Delete contours: Deletes the contours of a single node.

• Check for unused contours: Contours in the project file will be removed if the corresponding regions do not exist.

• Remove subtrees without contours: All nodes without contours will be removed. Using this function basic
atlases of the rat brain from Paxinos and Watson (2007) or Swanson (2004) can be generated.

• Choose as left root: A node with all its subnodes is assigned to a left part of an organ or the nervous system.

• Choose as right root: A node with all its subnodes is assigned to a right part of an organ or the nervous system.

• Select all subregions: Put check marks to each check box of a subtree, All these nodes will be visualized 2D or
3D. This function is also useful if someone wants to know of which regions the hindbrain is composed of and
how the assemble of subregions looks like in 2D or 3D.

• Unselect all: Unselects all check marks of a subtree.

• Move down: moves a node down within its subtree (usefull for regions that should be not sorted alphabetically
like thoracic segments T1, T2, T3, T4, T5, T6, T7, T8, T9, T10, T11, T12, T13)
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• Move up: move a node up within its subtree

• Sort children nodes: Sorts the nodes in one subtree alphabetically.

• Sort subtree: Sorts the nodes in all subtrees alphabetically.

• Distinct color scheme in subtree: Generates colors with high contrasts of regions that are neighbors.

• Restore color scheme: Reset the color scheme to the state before the "Distinct color scheme in subtree" function
have been used.

• Find double name: This is an control function that searches for long names in the hierarchy which occur several
times.

Figure 3.17. 2 double names have been found.

• The two regions of the left side "Olfactory_nerve_layer_L" and of the right side can be merged by clicking
on the button "Manage hierarchy". Then double click on a source region that should be merged with a target
region. Thereafter, click in the "Manage hierarchy" window on "Set source" and repeat this with the target
region followed by clicking on "Merge nodes" button. The same have to be done for the contralateral side. All
definitions and connections are merged into the new target node.
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Figure 3.18. Merging of regions.

• Find regions only existing in container: Detection of regions that exist only in the container terminology, how-
ever, not in any variant.

• Find errors in hierarchy:

• Find asymmetrical regions: Detects regions that exist on one side only.

• Shut all: closes all subtrees.

• Open all: expands the whole hierarchy down to the level of leafs.

• Left = Right: synchronizes the left and the right part of the hierarchy.

• Settings: Opens a dialog to define the layout of the hierarchy. Fonts, font appearance, colors, underscores and
the suffix of terms can be controlled. Furthermore, the node tool tip settings are defined in this dialog. The same
dialog can be opened by clicking on "Settings" -> "Change program settings".
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Figure 3.19. The settings dialog of the hierarchy layout.

• Close project: Selecting this item will close the project and all changes of the project data can be saved. The
configuration of the project (path to images, coordinate system setting etc.) will be saved.

The "Manage hierarchy" dialog should be used if iterative or special changes (copying color schemes, transferring
contours from one node to another, merging nodes) of the hierarchy terms are performed.

The following basic changes of terms in the hierarchy can be performed:

• Attaching or deleting test of all nodes in a subtree.

• Replacing test in the long name or the short name of a node.

• Replace all umlauts (ä, ö, ü; e.g. "Fuse area of Kölliker").



Projects and Data

23

Figure 3.20. Dialog for iterative changes of terms and special functions to interchange
settings and features in between nodes.

Each node posses basic features like a "long name" an abbreviation (short name). These basic features and some
more features can be edited after clicking on the tab "Brainregion" in the right of the main window.

Figure 3.21. The "brainregion tab" allows to define and edit basic features of a region
in the hierarchy.
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At the top of the window the expression "Rat:NS:CNS:CNL:PACr:PRC:BAF:MBFNC:B" provides the short form
of the path through the hierarchy from the node "rat" to the node "Basal_nucleus_Meynert_L". If a particular
region possesses more than one name a "Displayname:" can be selected in this list. The relation to the parent
region can be determined. "Aliasnames" are listed in a table. Their appearance in reference can be selected from
the bibliography and set in the "Reference field". The "Comment:" can be closed or opened by clicking on the
"-" button. To edit more detailed attribute tables of a particular region, see below (5 Attribute tables). If new
terms and/or abbreviations are added these can be added automatically on the contralateral side by check marking
"Make changes on both sides" and click on the "Accept" button. By clicking with a right mouse click on a row
the following options are available:

1. Add an empty row

2. Duplicate row on which the mouse is pointing

3. Remove row

A right mouse click on a filed of the "Bibliographical Reference" column offers options for selecting a biblio-
graphic link (where the region has been mentioned). The region specific color (also used for contours, 2D, 3D,
connectivity and simulation visualization) is defined here. A distinct color grading for distinct regions can be
generated here by check marking "Colorize subregions" and "Grade colors of subregion". Then select the "RGB"
tab define a color by shifting the scroll bars of the color channels.

4. Exchange of data between projects
Sometimes it could be useful to exchange data between projects, e.g., if a complex atlas project with thousands
of contours have been rendered and only a few connections from another project of the same organism should be
added to the atlas project. In the following the procedure to add a hierarchy and all its connectivities and additional
data to a project with rendered contours.

1. Export source hierarchy: Hierarchy -> Export Hierarchy with variants (wait until there appears the message
"File saved.")

2. Target project (Contour export): Contours and surfaces -> Export all contours (wait until there appears the
message "File saved.")

3. Target project (Coordinate system export): Contours and surface -> Export coord system (wait until there ap-
pears the message "File saved.")

4. Delete root node in target project

5. Import source hierarchy in target project: Hierarchy -> Import hierarchy

6. Import contours in target project: Contours and surfaces -> Contour import -> Open exported contour

7. Import rendered surfaces in target project: Contours and surfaces -> Import surfaces -> Existing surfaces will
be overwritten! Proceed? Answer with "Yes"

8. Import coordinate system in target project: Contours and surfaces -> Load coord system

5. Relations
Now we can add new regions to the hierarchy by using the right mouse key and clicking on the node that have sub
nodes. The information of a node is shown by clicking on the Tab "Brainregion" in the right part of neuroVIISAS
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main window. Here, it is possible to define the type of relation of a node with regard to its parent or upper level
node. In a new project no types of relations appear in the list of "Relation to parent region". It is necessary to
define these relations:

1. Right mouse click on any node of the hierarchy.

2. Select "Edit relations"

3. Right mouse click on "Relations"

4. Select "Create relation"

5. Define a relation, e.g., "is part"

6. The relation "is part" can be assigned to the single node "Nervous_system" or in terms of a larger hierarchy
to the whole hierarchy or part of the hierarchy.

Figure 3.22. Definition of relations that can be used to establish an ontology.

6. Attributes
To each node, respectively, region of the hierarchy one or more attributes can be assigned. The attributes can be
defined and administrated in the attribute environment (see figure below).
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Figure 3.23. Assignment of attributes to regions.

To the node "Pars_cranialis_L" the attributes Geometry and Histology are assigned. The tree (a list is also possible)
of attributes can be defined by the user. The attribute tree as shown above is not integrated into the neuroVIISAS
system, however, it can be defined by neuroVIISAS and it is stored automatically within a project file. If a certain
attribute, e.g., "gray matter" should be assigned to a whole subtree then the user have to click on the check box
"Make changes in whole subTree" after selecting an attribute and then click on "Add selected attributes". A new
attribute can be added or an existing attribute can be deleted by clicking with the right mouse button on a node
of the attribute tree.

7. Attribute tables

The basic elements of an ontology are nodes and relations. The use of relations is restricted because the content of
the ontology are spatially organized regions and not features of the regions that are arranged in the same network
(an acyclic graph). Features of ontologically arranged regions can be defined tables.

1. Click in the "Brainregion Tab" on "Show and edit attribute tables".

2. Click on "Edit" and then on "Edit tabs and tables".

3. Click with the right mouse bottom into the "Created tabs" window to define a panel of tables.
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4. Click on "Add tab".

5. Then give the table a name, e.g., "General".

6. Click with the right mouse bottom into the "Created tables" window.

7. Select "Create new table"

8. Click on the "new table" with the right mouse bottom and give the table name, e.g. "Spatial location"

9. Press "Accept"

10.Click with right mouse bottom into columns of the table to generate a new column

11.Give the column a name, e.g., "Definition"

12.Specify the "Column type", e.g. "Text"

13.Click on "Spatial Location" table in the "Manage tabs" windows under "Created tables" and press the "+" button
to assign the table to the table panel "General"

14.Close the "Manage tabs" window by clicking on the cross in the upper right window corner.

15.The new table panel "General" with one table "Spatial Location" only, will be shown.

This table panel and table definition will be used for all terms of the ontology and can be modified (with new
tables and panels) dynamically. However, it is not possible to define individual panels and tables for single terms
of the ontology. The result of the definition process described above is shown in the following figure.

Figure 3.24. Attribute tables can be defined using the table generator.

We have added text in the first row of the table by clicking on the empty row and terminating the text input by
pressing "Accept". By clicking with the right mouse bottom in the row with the text a new row can be generat-
ed. A more complex definition of a many panels (Special information, Chemoarchitectonics, Electrophysiology,
Quantitative information) with many tables (Definitions, Functions, Cell populations, Commentaries) is shown
in the following.
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Figure 3.25. Some features of region are have been added to a subtable of the table panel.

8. Project statistics

To obtain an general overview of the quantitative features of a project the project statistics can be computed by
clicking on "Analysis" -> "Project statistics". If the project is large then the computation will take a few seconds.
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Figure 3.26. Upper part of the project statistics table.
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Figure 3.27. Lower part of the project statistics table.

9. Connections
A further basic source of data in neuroVIISAS are connections between regions. These connections are represen-
tations of neurobiological connections that have been described in tracing publications. To define connections be-
tween regions a manual editor can be used or structured text table as a *.csv file can be imported. In the following
both methods will be described.

If the "Edit connections" window is minimized on a Linux Desktop then the main window of neuroVIISAS waits
for a user interaction (every key and menu is blocked) in the "Edit connections" window. To bring the "Edit
connections" window back press Alt+Tab and move with Tab to the "Edit Connections" window.

1. Click on "Edit connections" in the left part of the main window. The "Edit connections" window appears.

2. Search the source region for the connection by writing it into the field "Name", e.g., striatum.

3. Select Caudate_putamen_L from the hierarchy view.

4. Click on the button "New connection".

5. Click on "From" respectively "Fr...". Then Caudate_putamen_L (the left caudate putamen region) is set as the
source region for the connection.

6. Search the target region for the connection by writing it into field "Name", e.g., nigra.

7. Select Substantia_nigra_compact_part_L from the hierarchy.

8. Click on the button "To:". Substantia_nigra_compact_part_L is set as the target in the target field and the
connection name F_CPu_L_T_SNC_L (From CPu Left To Substantia nigra pars compacta Left) is generated.

9. Now the Weight can be selected and further specifications of the connection like "Transmitter", "Effect", "Cell
type", "Receptor" (the items of these specifications can be generated by the user because text files in a subdi-
rectory of the neuroVIISAS program directory are read by neuroVIISAS).

10.Then the connection can be specified with regard to ipsilaterality, contralaterality and bilaterality. If the check
box "Symmetric" is selected only then an ipsilateral reciprocal connection is generated
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that consists of the following two connections: F_CPU_L_T_SNC_L (the primary definition) and
F_SNC_L_T_CPu_L (the reciprocal connection that was generated automatically by neuroVIISAS).

11.If the connection should be generated in the left and right hemisphere automatically then click on the check box
"Create automatic" and select "Ipsilateral". Then the two connections F_CPu_L_T_SNC_L (left hemisphere)
and F_CPu_R_T_SNC_R (right hemisphere) are generated.

12.If "Bilateral" is selected then neuroVIISAS will generate 4 connections (2 ipsilateral and 2 contralateral):
F_CPu_L_T_SNC_L, F_CPu_R_T_SNC_R, F_CPu_L_T_SNC_R, F_CPu_R_T_SNC_L,

13.These connections can be deleted by selecting the connection in the connection table and clicking on "Delete
connection".

14.Each connection can be assigned to a reference by opening on the "Bibliographical Reference" listbox and
selecting a reference. References can be administered by the external JabRef application (they should be stored
in a ISO-8859-1 (=Latin 1) character set). If a Bibtex key of a reference should be changed in neuroVIISAS,
the "Settings" menu of main window must be opened and "Change project settings" has to be selected then
click on "Rename BiBTex-Entry". The path to the BiBTEx file that contains all references can also be changed
within the project by opening "Settings" -> "Change project settings" -> "Choose new document directory".

Figure 3.28. The "Edit connections window".

The Tab "Experiments" (figure below) allows to set certain projection specific features like:

1. Soma: Abbreviation of the location of the soma (=source) of a connection (=projection).

2. Terminal: Abbreviation of the location of the terminal (=source) of a connection (=projection).

3. Determination of brain region can be defined after clicking on the button right hand site below the "Soma:"
entry.

4. Cat: A "Category" (a character variable) can be used to classify a connection according to the quality of the
report and the experimental labelling density (Burns, 1997, p. 44)
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5. Cat#: "Category number" (an integer variable) from 1 - 13 for the "Category" variable.

6. Tracer: Abbreviation of the used tracer, e.g., PHAL (Phaseolus vulgaris).

7. Con. Strength: The connection strength is the verbal description or semiquantitative estimation of the number
of somata (efferents) which project to a target or the number of or density of terminals (afferents).

8. Tracing Type: Abbreviation for anterograde = "a", retrograde = "r", anterograde and retrograde "a/r" or no
information of tracer in a review publication: "review".

9. Tracer Code: Abbreviation of a tracer: PHA-L, TB (True blue), FG (Fluorogold) etc.

10.Connection type: IPSI, CONTRA, IPSICONTRA, LL (within the left site from a left region to another left
region), RR (within the right site from a right region to another right region), LR (only from left to right), RL
(only from right to left). Unilateral Connections of regions which are asymmetric (like the left ventricle of the
heart) with regard to the median axis of the body can be encoded by U-type: UL (the unilateral region which
do not have a contralateral region has a connection a region of the left side. The region of the left side must
have a contralateral region). Same for UR with an unilateral region and a bilateral region of the right side.
Furthermore, LU, RU and a UU connection is possible.

11.Case: The number of a tract-tracing experiment within a publication.

12.Soma notes: remarks regarding the soma (neurotransmitter, receptor, protein or gene expression).

13.Terminal notes: remarks regarding the terminals (neurotransmitter, receptor, synapses).



Projects and Data

33

Figure 3.29. The connection specific data are shown in the "Experiment tab". Here, 9
experiments (two of the same report) describe the same connection from the CPu to
SNC. Krzywkowski:1999 used WGA-ApoHRP as a retrograde (r) tracer and reported
and projection strength, respectively, weight of 3, ipsilateral.

To allow the selection of groups of tracers (viral, non-viral) for a connectome analysis it is possible to click on the
bottom "More" to open a table of those tract tracing substances that have been already imported into a neuroVIISAS
project and to indicate if a tracer belong to a particular group of tract tracing substances:
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Figure 3.30. Table for interactive tracer classification.

The "Edit connections" windows offers advanced administrative tools:

1. The search for a author (encoded in a Bibtex key) is continuous. If the author "Meddle" should be found click on
the search list window and type in "M" and then "e" and the display jumps to Me... Then confirm the selection
with "Enter" and just press the "Empty space" key to execute a further search to find all connections mentioned
in this publication.

2. If left and right hemispheric connections were defined then asymmetric connections can be detected by pressing
the button "Find asymmetric connections".

3. The button "Update weights" performs a control of weights within alls experiments of all connections. If ex-
periments are found that describe the same connection with different weights then the largest weight is set as
an operation weight for further analyses (Advanced connectivity analysis). If their exist weights that do not
match the numeric format or the weight classes that were defined then these are indicated as corrupt weights.
If corrupt weights were found a table is opened to change these weight definitions. Move the mouse over a the
weight column to obtain a list of keys that can be applied to correct a weight.

4. The "Double links" button searches for connections that are established more than one time with the same
bibliographic and experimental data.

5. The "Non conform syntax" button searches for link names that have a problematic syntax.

6. The "Search for double entries" button searches for double entries in experiments.

7. The "Synchronize sides" button synchronizes the connections of the left side with the connection of the right
side and vice versa.
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Figure 3.31. Advanced tools to administrate connections.

To obtain a list of all publications of the references.bib file from which connections were read out the "Info" button
must be pressed. Bibtex key that are not found in the references.bib file are listed and can be corrected either in
the references.bib file or by renaming the Bibtex key (see "Rename BiBtex-Entry").

Figure 3.32. List of connections that were read out of publication. Bibtex keys that can
not be found in the bibtex reference list of the project are indicated.

If an experiment should be added to an existing connection the "Add" button has to be pressed. An experiment
can be removed from a particular connection by pressing the "Remove" button. If a mistake within an experiment
of a particular publication has been found the experiment can be corrected and assigned to all connections within
the publication or a subset of the connections of the publication that is listed in the connection list. A new exper-
iment can be created by pressing the "Create new experiment" button. The experiment is assigned to a specific
connection that has been chosen from the connection list. If "Take over last experiment" is checkmarked then the
last experiment is assigned to all connection that have been highlighted in the connection list.

The second possibility to add connections aims to import structured lists of connectivity tables generated in spread-
sheet applications like Microsoft Excel® or OpenOffice Calculator©. In the following figure the basic structure
of the connection table is shown:
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Figure 3.33. Connectivity table with header row in a spreadsheet program.

The first row contains the header, respectively, column information and must be exported to the text file that will
be imported by neuroVIISAS.

Meaning of columns:

1. S: primary abbreviation of the source (where the somata of a connection are located)

2. T: primary abbreviation of the target (where the terminals of a connection are located)

3. d: density of connection (labelling density, semiquantitative estimation of the number of retrogradely traced
somata or anterogradely traced terminals)

Weight (d) Meaning

-3 unknown weight

-2 fibers of passage

-1 not clear

-0.5 exists

0 not present

0.5 very light

1 light, sparse

1.5 light to moderate

2 moderate

2.5 moderate to strong

3 strong



Projects and Data

37

Weight (d) Meaning

4 very strong

4. IC: indicates if the connection is wholly ipsilateral, contralateral or bilateral (i, c, ic, i>c, c>i) (see Burns, 1997,
p.41).

5. Nc: Number of publications that reported a specific connection (see Burns, 1997, p. 301).

6. Reference: Bibtexkey of a reference (see JabRef figure below).

7. I: Tracer abbreviation (in the work of Burns, 1997 p. 41: I is a label of a specific experiment).

8. Case: Number or code of a tract tracing experiment within a publication.

9. M: Code for the type of tracer (Burns, 1997 p.41).

10.λ: Labelling density of the connection report (Burns, 1997, p.41), see also the "d".

11.Soma: Abbreviation of source region where the some is located.

12.Soma Notes: Notes about protein, gene, receptor expression of the soma.

13.Soma ipsi - contra: If the projection is ipsilateral: IPSI; If the projection is contralateral: CONTRA.

14.Terminals: Abbreviation of terminal region where the terminals are located.

15.Terminal Notes: Notes about protein, gene, receptor expression or synapse features of the terminals.

16.Terminal ipsi - contra: If the projection is ipsilateral: IPSI; If the projection is contralateral: IPSI.

17.T: tracer transport direction: a: anterograde, r: retrograde, a/r: anterograde and retrograde.

The abbreviations of source and target regions are case-sensitive. They should be exactly written as the primary
abbreviation of the project where the connectivity file should be imported. In order to facilitate the input of con-
nectivity data into the spreadsheet table the following features of neuroVIISAS support this work:

1. By clicking on a region within the hierarchy window and hitting the key combination Ctrl+d or Strg+d the
longname of the region is copied to the temporary buffer. After selecting a field in the spreadsheet application
the content of the temporary buffer can be copied directly into it by (Ctrl+c or Strg+c).

2. If a region in the hierarchy window is selected by a mouse click, the primary abbreviation is written to the
temporary buffer and can directly copied, e.g., into a spreadsheet application.

3. In the "Brainregion" Tab you can select the abbreviation field and double click on the abbreviation (not behind
the abbreviation within the abbreviation field) and then perform explicitly Ctrl+c.

4. If a longname has been searched and a list of longnames with primary and further abbreviations are listed in the
search result table then the primary abbreviation of the first row is copied to the temporary buffer and can be
inserted directly in the spreadsheet application by Ctrl+c or Strg+c. If another abbreviation should be used from
the search results table just select the field and perform Ctrl+c or Strg+c. In the case of multiple abbreviations
all abbreviations will be copied. To copy only the first abbreviation (which is necessary for importing new
connections) perform a right mouse click on the abbreviation field and select "copy".

5. It may occur quite often that a subdivisions, subregions, parts of subdivisions are not defined in the hierarchy.
As described above new regions can be added easily (Right mouse click on father node of the new node and
then select "New node"). Then the longname of the new region and a new abbreviation can be edited. After
pressing the "Accept" button the primary abbreviation of the new region is copied to the temporary buffer and
can be directly inserted into the spreadsheet application by Ctrl+c or Strg+c.
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The table must be exported as a text file without delimiters around the table elements, however, with one tab
delimiter between each column (see figure below).

Figure 3.34. Structure of connectivity text file that is intended to be imported in the "Edit
connections" window.

The number of connections and complex terms of subregions can be quite large. To support the selection of
abbreviations of sources and targets for connection coding in spreadsheets a "Search history" tool can be activated
by selecting "View" -> "Open search history list". Then a table is shown which contains the region abbreviation and
longnames that have been searched before. Only the first most similar hit of the search list will be put automatically
in the search history list if the user leaves directly after a search session neuroVIISAS to switch to the spreadsheet
application where the region abbreviation should be copied. Furthermore, all regions are automatically copied
to the search history list, which were selected by interactive navigation through the terminology followed by a
directly switch to the spreadsheet application.
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Figure 3.35. Regions are added to the search history (upper left) after search (upper
right; first hit of search is copied to the search history list) and directly switch to another
application (lower left) or after navigating through the hierarchy of regions or generating
a new region (lower right) and directly switch to another application.

The coding of collaterals and pathways (transsynaptic virus tracing) is shown in the following. It also includes an
overview of all possibilities of coding. It is important to note that the laterality code may use only the following
values LL (left to left exclusively), RR (right to right exclusively), LR (left to right exclusively), RL (right to left
exclusively), IPSI (left to left and right to right), CONTRA (left to right and right to left), IPSICONTRA (left to
left and right to right and left to right and right to left). For colateral, transsynaptic pathway coding it is allowed
to use LL, RR, LR or RL exclusively. IPSI, CONTRA or IPSICONTRA is not allowed for coding colateral or
pathway connections. Sometimes a pathway has been documented in transsynaptic virus studies, however, the
regions lying in between the source and target are not documented. In these cases it is necessary in the "T" (tracing
type) column the code "t".
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Figure 3.36. Coding of connectivity as used in the following figure.

The modality column is used to indicate if the description or coding of a colateral begins ("C") or the coding of
a pathway with more than one internode ("P). The row that contains the last colateral or pathway node does not
have a "C" or "P" in the Modality column!
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Figure 3.37. The rows of this coding table refer to the previous figure.

To allow more flexibility it is possible to import connectivity tables with non standard columns by selecting
"custom table" after clicking on "Import" button in the "Edit connection" window, like a "Description of source"
and a "Description of target" column as shown bellow. Complex tables with connections and additional information
(or just tables with other sequences of source and target columns) can also be imported by selecting "Import" ->
"Custom". After selecting the csv-file a table header preview allows to change delimiters:

Figure 3.38. Table header preview.
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Figure 3.39. After selecting the delimiter of a csv table columns can be assigned to
neuroVIISAS values.

After pressing "OK" another example of a import-relations table is shown:
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Figure 3.40. The "Import relations table" is used to assign columns of the csv-file to data
field of a neuroVIISAS project file.
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The Bibtex key of the reference column can be administered in the JabRef application:

Figure 3.41. A compatible list of references linked by Bibtex-keys with connections in a
neuroVIISAS project.

The reference that was used in the export example is highlighted. The bibtex file is located in the subdirectory ../
documents within the neuroVIISAS program directory. More then one spreadsheet file (each may contain a list of
connections of one publication) can be appended within one spreadsheet table to generate a collection of connec-
tions of different tract tracing publications.To append all Excel xls spreadsheet files located in one directory the
RDBMerge plugin is useful. To import the structured text files into neuroVIISAS click on "Edit connection" in
the Main Window and then on the "Import" button in the "Edit connections" window.

Connections can be imported independent of a preexisting hierarchy. For example, the cat.mat, macaque71.mat,
macaque47.mat, fve32.mat, fve30.mat (https://sites.google.com/a/brain-connectivity-toolbox.net/bct/datasets)
and celegans131.mat, celegans277.mat, mac95.mat (http://www.biological-networks.org/?page_id=25) Matlab
connectivity files can be transformed in Matlab by using the following Matlab-script:

function saveAdjMatrixToCSV(fileName, matrix, names)
fileID=fopen(fileName,'w');
for i=1:length(matrix)
     for j=1:length(matrix)
         if matrix(i,j)~=0
             fprintf(fileID,'%s\t',names(i,:));
             fprintf(fileID,'%s\t',names(j,:));
             fprintf(fileID,'%1.0f\n',matrix(i,j));
         end
     end
end
fclose(fileID);

The variable "matrix" has been initialized in matlab by matrix = csvread('Pigeon.csv'). Pigeon.csv is a comma (!)
delimited textfile that contains numbers (and commas as delimiters) only:
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Figure 3.42. The connectivity matrix that is converted into a connectivity table by the
saveAdjMatrixToCSV function.

The "names" variable was initialized by names=char(importdata('names.csv')). Now the variables names and ma-
trix are available in the matlab workspace and can be used by the saveAdjMatrixToCSV function.

The names.csv file has such a content (a list of full names or abbreviations):
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Figure 3.43. The names.csv file.

The saveAdjMatrixToCSV function generates then the following csv file:
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Figure 3.44. The csv file that can be imported by neuroVIISAS.

The csv file can be imported into a new project (this has to be created before: File -> Create new project) before
opening "Hierarchy" -> "Import connectivities and create regions under selected node" click on the root node of
the new project. Then the project file can be saved.
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Most connectome-projects (tract-tracing metastudy based project. DTI connectomes are in most cases completely
bilateral) are fusing left and right-hemispheric connections (ipsi- and contralateral connections appear in a adja-
cency matrix without left-hemispheric and right-hemispheric regions). neuroVIISAS allows to export connections
(direct edges between selected leaves of a tree and/or indirect edges between not selected subregions of a tree) to
a csv table. First of all, select from the Analysis menu the Advanced connectivity analysis item. Then make your
selection of regions (or if all connections should be exported then the selection of regions is not necessary) and
don't forget to right click on the triangle hierarchy and select Sync sides if a full bilateral connectome with left and
right hemispheric connections is available. Then choose File -> Export direct connections (csv) or choose Export
all connections in subtree (csv). If the root node of the hierarchy has been selected and Export all connections in
subtree (csv) was selected then all connections will be exported. Then these csv files can be loaded by a spread-
sheet application and all connections (LL, RR, LR, RL) must be changed either to LL (Left->Left) or RR (Right-
>Right). The bilateral connectome is then fused to a redundant unilateral connectome with many reduplicated
connections. However, reduplicated connections will be generated only once after by importing the new csv file
by Edit connections -> Import -> Custom table. Before this is done a new project (File -> Save project as...) should
be written to harddisk, then delete in the new project all connections (right click on hierarchy in the main windows
and select "Delete all connections of the project").

The NeuronConnect.xls file of C. elegans has been downloaded from http://www.wormatlas.org/im-
ages/NeuronConnect.xls:

Figure 3.45. Original format of the C. elegans neuron connections.

The data has been reformated as shown in the following figure. The third column contain the weights of a con-
nection (in this case a constant weight of "2" meaning "moderate").
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Figure 3.46. The tabulator separated connection file without header of C. elegans.

After importing the file a list of regions, respectively, neurons is generated (a "flat hierarchy") and connectivity
analysis can be performed is described later.

Figure 3.47. C. elegans neuron connectivity represented in the adjacency matrix.
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Figure 3.48. The whole adjacency matrix of C. elegans.

The connectivity data of cat.mat (cerebral cortex of the cat) are shown in the following:

Figure 3.49. Connections of the cat cerebral cortex with colour coded weights.

The Brain Architecture Management project (BAMS2) allows open access to connectome data of the rat brain.
The connectome data can be exported as xml files or text files. A list of abbreviations of sources and targets and
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a third column of weights can be imported by clicking on "Hierarchy" and then "Import connectivities and create
regions under selected node". Before, a new project should be defined and activated (just clicking into the project
hierarchy windows). After importing the txt file the new project can be stored as a neuroVIISAS project file. The
connections of the 503 regions of the rat connectome of BAMS2 are shown in the following adjacency matrix:

Figure 3.50. The adjacency matrix of 503 brain regions of the rat brain from BAMS2.

The import of a XML file from BAMS2 is possible by clicking on "Hierarchy" and then "Import connectivities
and regions from BAMS xml-files" after a new project has been created.

Connectivity data set from DTI measurements can eb found in the UCLA Multimodal Connectivity Database. The
following link http://umcd.humanconnectomeproject.org/update/5 points to 4 text files

1. Region Names Full File

2. Region Names Abbrev File

3. Region Xyz Centers File

4. Connectivity Matrix File

that can be downloaded from the webpage and directly imported into neuroVIISAS. These files should be stored
in one subdirectory. Then create a new project in neuroVIISAS. Click into the hierarchy window of the new
project. The click on "Hierarchy" and then "Import connectivities and regions from UMCD-UCLA-files" opens
the "Choose file" window, then select the first text file that contains the long names:
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Figure 3.51. Choose file window for the import of UMCD-UCLA files.

After successful import the following adjacency matrix is available:

Figure 3.52. The imported connectivity matrix of UCLA_ICBM_1004_DTI (Network
Name of UMCD UCLA).

9.1. Removal of connections which were imported before

Connections with all there experimental data can be removed completely from a project or connections which
a related to a specific reference can be removed. If a list of connections should be deleted then open the "Edit
connections" window and selected the connections in the connection table followed by clicking on the "Delete
connection" button. Then all observations from all references or authors of the deleted connections will be deleted.

If all connection of a particular reference should be deleted then select the appropriate reference followed by
clicking on the button "Delete experiments".
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10. Export a whole neuroVIISAS project to a MySQL
database

A neuroVIISAS-project can be exported to a MySQL-database that can be, e.g., used for sharing data and data pre-
sentation on webpages. On the computer on which neuroVIISAS is running a MySQL-process must run (rcmysql
start) (Linux) or on a Windows OS XAMPP can be used. Then select the menu item "Hierarchy" -> Hierarchy and
Connections in MySQL export (Default name of the database is "neuroviisas" and the default user-name is "root").
Then the password for the database (new root password that have been entered within my_secure_installation,
see below) must be entered. The database directory on a Linux OS can be found in /var/lib/mysql and on a WIN-
DOWS OS in the XAMPP-directory. The generated database tables are located in the directory which has the
name of the database (in the default-case it is neuroviisas) and the data are in the file ibdata1.

In the case, that MySQL has not been started before then it must be configured with my_secure_installation. The
requested root pwd is the root password of the system, that is used to change the root password of the mySQL
database in the following step. New password: xyz. Remove anonymus user: Y, Disallow remote: Y, Reload
privileg: Y.

If "rcmysql status" responds with a service failure, then change as root to /var/lib/mysql and delete the neu-
roVIISAS database directory and ib_logfile0, ib_logfile1 and ibdata1. Then change to /var/lib/mysql as root and
enter the following command: touch /var/lib/mysql/.force_upgrade. Then rcmysql stop, then rcmysql start. Now
it should work.

If the database should be used on a Webserver then MySQL must be stopped there with "rcmysql stop". Copy
the directory neuroviisas, and the files ib_logfile0, ib_logfile1 and ibdata1 from the computer where the database
has been generated in neuroVIISAS and then exported by rcmysql to the /var/lib/\mysql webserver. After this,
the database on the computer where it has been generated must be exported to /tmp/neuroviisas.sql. The export
is performed by entering the command mysqldump -u root -p neuroviisas > /tmp/neuroviisas.sql in the console.
Or the export can be done with the aid of phpMyAdmin within a webbrowser to the SQL-format, however, this is
limited to small databases, only. Then copy the file neuroviisas.sql on to the server e.g. /var/lib/mysql. Next step
is to start phpMyAdmin and to create a database: neuroviisas (first tab). Now the empty database has been created
and neuroviisas.sql can be imported into the database neuroviisas. The import of neuroviisas.sql is done with the
following command: mysql -u root -p neuroviisas < /var/lib/neuroviisas.sql. Then restart MySQL with rcmysql
start. Maybe rcapache2 must be stopped and restarted (rcapache2 stop, rcapache2 start)

The export of a large neuroVIISAS project into a MySQL database my take several hours (6 database tables are
generated). Within this process the progress can be displayed after starting the apache server: rcapache2 start and
then enter localhost/phpMyAdmin into a webbrowser (phpMyAdmin can be installed via YAST).

Step by step:

1. "Hierarchy" -> Hierarchy and Connections in MySQL export (Write database from neuroVIISAS: default name
of the database is "neuroviisas" and the default user-name is "root"

2. cd /var/lib/mysql/neuroviisas

3. mysqldump -u root -p neuroviisas > /tmp/neuroviisas.sql

4. copy /tmp/neuroviisas.sql to the webserver /srv/neuroviisas.sql

5. mysql -u root -p neuroviisas < /srv/neuroviisas.sql (import the mysql database neuroviisas.sql. The rcmysql
process must run. The neuroviisas.sql database is written to /var/lib/mysql/neuroviisas/neuroviisas.sql on the
webserver.)

6. rcapache2 restart
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11. Mapping in a stack of atlas images

The annotation of names of regions that are structured in a simple hierarchy or a hierarchy enriched with relations
and attributes (ontology) is described. Such assignments and region definitions are a requirement for 3D visual-
ization. The tracing of regions in images can be performed either in stacks of images that are not aligned (image
registration) or in stacks of images that are aligned like those in the atlases of the rat brain (Paxinos and Watson
2007, Swanson 2003). In the following the mapping of regions in the rat brain atlas of Paxinos and Watson (2007)
is described. Then the same method is applied to a linear affine and elastically registered stack of images (4224
images) with a three dimensional isotropic resolution of 5 µm / voxel edge. A precondition for mapping a stack
of atlas images of the rat brain as those published by Paxinos and Watson is that they have been converted from
the printed form to a digital image or by extracting labelled images and detected contours (by writing a script that
extracts some or hopefully most of the contours in the *.ai files) from the Adobe Illustrator® files that can be
found on the CD-ROM of the atlas. Such images and the extracted contours can be used for assigning regions of
the neuroVIISAS hierarchy to regions in the images or specific contours.

1. Click on the region (by interactive navigation through the hierarchy or searching a region) in the hierarchy that
should be traced in an image (e.g., caudate putamen: CPu, see figure below).

2. Click on the "Draw" tab in the right part of the main window.

3. Select the radio button "Draw".

4. Click on "New polygon"; now the hierarchy changed to light gray, indicating that neuroVIISAS is in the drawing
mode.

5. Click with the left mouse key on any part of the contour of the region that should be traced.

6. Repeat by clicking on new parts of the contour, either always in clockwise or counterclockwise direction. If
the image should be to large or to small use the mouse wheel for

zooming in or out. Press the mouse wheel and hold it for shifting the image.

7. If the same contour is expected on the contralateral site then select "Paste polygon mirrored on other side".

8. Click on the button "Accept".

9. If the contour should be copied contralateral then click on "Copy polygon" and then on "Paste polygon" ("Paste
polygon mirrored on other side" should be selected).

10.If the contralateral contour is added automatically it will be assigned also to the contralateral region in the
hierarchy which is selected after the tracing and copying process.

Just click on the button "Left" or "Right" to jump to the last site that was traced or continue with tracing on the
actual site in the next image by clicking on the "image plus sign"

to move one image forward or backward for the next tracing.

11.A selected region trace can be deleted or linearly transformed (rotation, scaling, shifting) by clicking on the
"Transform" button.
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Figure 3.53. A region in an atlas image which is outlined by a user defined closed contour.

In addition to the functions of contour drawing described above, neuroVIISAS allows to split one contour or to
fused two contours:

The polygon of region M2 should be splitted in 2 polygons within the same section.

Figure 3.54. The two regions M1 and M2. M2 consists in this stage of one polygon within
this section.

Select a node of the contour with the left mouse button and hold it. The dialog "Split polygon on this point?"
appears, then press "Yes". Now the region is splitted into two contours or polygons. Both two polygons are assigned
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th the region name witch was related to the source contour before splitting. Please note, that Polygon displays
now "1/2".

Such two region which belong to a single region in the region hierarchy or list can be jointed. It is not possible to
join contours which belong to different regions in the hierarchy of regions.

Figure 3.55. Now the single polygon of M2 is splitted into two polygons.

Now the two polygons can be joint to a single polygon.Select the node of the contour or polygon 1 of a particular
region and move it a contour point of polygon 2 of the same region and the same section or image. The dialog
"Join regions?" appear. Press the "Yes" button.
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Figure 3.56. Now the two polygons of M2 are joint at one point of the polygons.

By selecting a point of the new joined polygon the polygon can be modified again:

Figure 3.57. The modified new polygon of M2.

The traced region can be visualized by further methods by selecting the "View" tab in the right part of the main
window.

• The opacity can be reduced to find regions that are not traced.

• The contours can be enlarged by enlarging the line width.
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• A stereotaxic coordinate can be searched.

• Coordinate display can be activated.

• A coordinate grid can be shown in the overlay.

• A crosshair can be activated to facilitate navigation in an image.

• The area of traced regions can be completely filled without any transparency.

The following figure shows a combination of coordinate display, display of a grid, crosshair and opacity of 63%
to read the labels in the atlas images. A complete mapping of the left hemisphere in atlas image 45 is shown. The
selection of regions that should be displayed is controlled by selecting a region on a high level of the hierarchy,
e.g., "Central_nervous_system_left_L" with the right mouse key and then clicking on "Select all subregions".
Then, all subregions of the left part of the central nervous system are selected.

Figure 3.58. Coordinate, grid and crosshair display in combination with opacity.

12. Exporting images

Any type of image (atlas,histology, MRI) with specific "View" definitions, coordinate and grid settings can be
stored as *.png images. This can be done for a particular image or for a complete stack of images. Click on "File"
in the main window and select "Save image" or "Save image stack". The following image shows an example of
a single image export with sterotaxic coordinates.
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Figure 3.59. Exported atlas image as a png-image file.

13. Mapping in a stack of contours and atlas images

If contours have been extracted from an Adobe Illustrator formated atlas, or contour detection processes developed,
e.g., in Matlab or process that generates xml coded contour data, these contours can be used in combination with
labelled atlas images to map regions with the hierarchy of region names.

1. Click on "Contours and surfaces".

2. Click on "Contour import".

3. Click on "Extended contour import". Now the contours are loaded from a zip file and all contours are displayed
in red. Shifting and scaling can be adapted to individual contour image

or all (see figure below). Here, an y-Offset of 130 pixels was used to match the contours with the labelled image.

4. The "Contour import" window have to be left open in order to use the prepared contours and assign them to
regions in the hierarchy.

5. Now select, e.g., CPu or Caudate_putamen_L and click inside the CPu contour.

6. This assignment can be repeated through all contours until all regions are mapped.

7. Save the project File->Save project to store the mapping work.
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Figure 3.60. Available contours within the import dialogue.

14. Importing NifTi data
The C57BL/6J mouse Waxholm space (WHS) is a coordinate-based reference space for the map-
ping and registration of neuroanatomical data in the mouse brain that was made available in october
2009 http://civmvoxport.duhs.duke.edu/voxbase/studyhome.php?studyid=132 and http://software.incf.org/soft-
ware/waxholm-space. Data are available as a multi-spectral dataset of a T1-weighted Atlas, T2*-weighted atlas, a
Nissl-stained optical histology atlas, a T2-weighted atlas and a labeled atlas (version 0.5.1) from the INCF Soft-
ware Center (http://software.incf.org/software/waxholm-space/download). To use the MRI image stacks of the
Waxholm dataset an already existing hierarchy of regions can be used or a new hierarchy or list of regions can be
build. By opening "File" -> NifTi-Viewer and choosing, e.g., CLabel.nii.gz the following viewer window opens.

Figure 3.61. The NifTi viewer with three plane navigation.
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The views can be turned, mirrored, scaled and then exported to a directory that contains each image of the stack.
The next step is to load the MRI images of a particular MRI modality into a neuroVIISAS project that has been
prepared before.

Figure 3.62. A MRI modality of the the Waxholm data.

Now it is possible to assign the labels of the images which has been extracted from the *.nii.gz file before (see
above). Click on "Contours and surfaces" -> "Contour import" -> Import contour (Segmented Images) go to the
directory which contains all extracted images with gray level coded, respectively, labeled regions and select the
first image. The import may take some time and then the following "Assignmetn" window opens.

Figure 3.63. Assignment window with a selected labeled image. By clicking onto a gray
level coded region the corresponding row is highlighted.

By clicking on the "Name" column the name from the hierrachy of the current neuroVIISAS project will be
assigned. In this case "Caudate putam" and ENTER has been typed and list of available terms is opened.
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Figure 3.64. List of terms for "Caudate putam".

Then "Caudate_putamen_L" has been chosen.

Figure 3.65. Now the shortname and brainregion information have been assigned.

After assigning all labeled regions to the hierarchy all contours of the gray level labeled images are extracted and
assigned to the MRI images of the project data: Checkmark "Replace existing contours" and click on "Assign"
button. Each region to which a contour has been assigned is now labeled by the polygon glyph in the hierarchy.
Now all regions can be selected (Right mouse click on root node "waxholm" and then select "Select all subregions")
and the surfaces of the contours can be calculated by applying the marching cube algorithm of VTK: click on
"Contours and surfaces" -> "Calculate surfaces of all selected regions". For the relative coarse resolution the MRI
dataset the following parameters are recommended: "Number of subdivisions": 7, "Skip images": 0, "Smoothing
factor": 100, "Marching cubes": on. After computing surfaces, volumes can be computed also. Then the Waxholm
project need to be stored. A typical reconstruction using the color scheme of the particular Waxholm project file
in neuroVIISAS is shown in the following:
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Figure 3.66. 3D-visualization after rendering the contours of the Waxholm data. The
inner ear with cochlear and semicircular ducts can be seen also yb using a relative large
"Number of subdivisions" of 7 for the marching cube computation.

15. Importing virtual slides
Virtual slides that were generated by the Zeiss Mirax slide scanner can be imported by selecting "File" and then
"Virtual Slide Viewer". Then the *.mrs file has to be selected and the virtual slide will be loaded in the following
window:

Figure 3.67. A virtual slide from the Zeiss Mirax scanner.
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Figure 3.68. In the magnified view medium spiny cells within the caudateputamen are
clearly visible.

Zooming in and out is controlled be the mouse wheel. Holding the left mouse key allows to shift the image.

The virtual slide can be exported in the form of tiles. The dimensions of the tiles are defined by the user. Click on
"File" then on "Save complete image in current magnification". In the new export window the user can determine
the dimension of tiles that will be saved.

These images are now available for, e.g., cell recognition algorithms in Matlab. Recognized cells can be imported
from a csv file by clicking on "File" in the virtual slide window and then on "Import cells".

In the following a code snip is shown to demonstrate the principal loading of stacked tiles of images and the cell
feature vector output to a csv file in Matlab:

baseDir='/raid/vlib/research/seg/'; %base folder with subdirectories

%List of subdirectories of a stack of the tiles of virtual slides which
%were converted by neuroVIISAS before
d = dir(baseDir);
isub = [d(:).isdir]; %# returns logical vector
nameFolds = {d(isub).name}';
nameFolds(ismember(nameFolds,{'.','..'})) = [];

ext='.png'; %i=5
for folder=1:length(nameFolds)
 disp(folder);
 basePath=char(strcat(baseDir,nameFolds(folder),'/'));
 imList=dir([basePath '*' ext]);
for i=1:length(imList)   
   fp=[basePath imList(i).name];
   fp1=strcat(basePath,imList(i).name(1:end-4),'.csv'); 
   if exist(fp1) %has been already analyzed
   else
   img=imread(fp);
   
   %now doing segmentation, splitting and classification
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   end
    
   %cell detection has been done and each cell is coded in the label image
   %now a feature vector is computed
   s = regionprops(L,img,'Area','Centroid','EquivDiameter','Perimeter','MajorAxisLength','MeanIntensity');
    
   
   %Save the feature vector to a text file which can be read by neuroVIISAS
   %"Import cell" function
   t=struct2table(s);  
   t(t.Area < 10,:) = []; %remove small objects     
   writetable(t,fp1);
end
end
end

The import of virtual slides in neuroVIISAS is available after installing on a Linux machine the libopenslide0
library (typically with Yast). Then the linux64.tar from the neruoVIISAS download server must be unpacked in
the neuroVIISAS installation directory. Then the run.sh has been aligned to let neuroVIISAS find the path to the
openslide library (it may look like: export LD_LIBRARY_PATH=$PWD/vtk/linux_x86_64:$PWD/openslide/
linux64:$LD_LIBRARY_PATH) and the whole run.sh may look like

#! /bin/bash
export LIBXCB_ALLOW_SLOPPY_LOCK=1
export LD_LIBRARY_PATH=$PWD/vtk/linux_x86_64:$PWD/openslide/linux64:$LD_LIBRARY_PATH
java -splash:Images/logo_splash.png -jar -Xmx4096m -Xss24M neuroVIISAS.jar

16. Mapping in a stack of histological images

The mapping of regions in histological images uses the same steps as assigning atlas regions to region names in
a hierarchy.

1. Select a region in the hierarchy that should be traced in an image, e.g., Caudate_putamen_L (blue highlighted
region in the figure below).

2. Then click on the "Draw" tab, then on the "Draw" radiobutton, then on the "New polygon" button.

3. Click on the region boarders either in clockwise or counterclockwise direction.

4. Terminate the tracing by clicking on the "Accept" button.

5. If the same region is sectioned several times in the same image, then further regions can be traced and assigned
to the same region name in the hierarchy. After each trace the "Accept" button must be clicked.
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Figure 3.69. Delineation of a region.

After tracing regions in histological images it is possible to perform analysis in these image regions.

1. Click on the region name in the hierarchy that should be analyzed. A yellow star indicates that a contour of
this particular region exists.

2. Click on the empty box between the yellow star and the region name. Then a check mark appears (see figure
below).

3. Click on the "Analysis" tab in the right part of the main window.

4. Check mark "Show subdivision".

5. Click on the button "Partition at beginning".

6. Click on the button "Finer" until an appropriate quadrangulation has been reached (see figure).

Figure 3.70. Defining a quadrangulation of a region.

7. Check mark "Display evaluation" and click on "Mean gray value" to show the mean gray values of each quad-
rangle.



Projects and Data

67

Figure 3.71. Mean gray values of the quadrangulated region.

17. Defining a coordinate system

neuroVIISAS allows the transformation of pixel positions of an image digitized (or mapped as an atlas image) from
a section of tissue of known thickness and distance to the following section to an user defined three dimensional
coordinate system with redundant axes as used in sterotaxic atlases. The menu "Settings" -> "Change project
setting" has an interface for setting the pixel width, pixel height and the distance of sections in µm. The image stack
has an orientation (frontal = coronal, sagittal or horizontal. This can be set in the listbox "Image stack alignment".
The color of the scales that will appear in the images are selected by pressing the button "Change color of scale".
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Figure 3.72. The color of scale was set to green. Below, the interface for basic settings of
the coordinate system is shown.

Some atlas projects (CoCoMac, Larry Swanson: Brain Maps: Structure of the Rat Brain, 2004), or sagittal sections
of the rat brain atlas of George Paxinos and Charles Watson (2007) consists of one side of the cranial part of the
central nervous system. This unilateral part can be mirrored to obtain a bilateral data set which will be useful for
analyzing and visualizing contralateral and ipsilateral connectivities. Mirroring of image stacks can be performed
by pressing the "Mirror image stack and contours" button.

Figure 3.73. The possibilities of mirroring images together with their contours and
hierarchy.

The first part of defining the coordinate system is followed by setting up the coordinate axes.

1. Right mouse click on the image in the main window.

2. Click on "Manage Coordsystems" then the following dialog appears.
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Figure 3.74. The dialog to assign a "neuroanatomic" axis to an image volume axis.

3. Basically their are no predefined axes (available axes) assigned to one of the three image volume axes (x-axes,
y-axes, z-axes). SAGR: sagittal axis, DV-INTER: dorsoventral

interaural axis with the origin of coordinate (0) at the line between the left and right acoustic meatus, DV-
DURA: dorsoventral axis with the origin of coordinate (0) at the

surface of the dura mater at bregma, AP-INTER: anteroposterior interaural axis with the origin of coordinate
(0) at the line between the left and right acoustic meatus,

AP-BREGMA: anteroposterior bregma axis with the origin of coordinate (0) at the surface of the dura mater
at bregma. All these axes are defined with regard to the flat

skull position.

4. To assign the SAGR axis to the x-axes click with left mouse button on SAGR in the column "Available axes",
then it is highlighted (see figure below).

Figure 3.75. Selecting an axis (SAGR) that should be assigned.

5. Then click again with the right mouse key on the highlighted SAGR axis and choose, e.g., "Choose axis as
x-axis".

6. Repeat this with all other axes (see following figure).
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Figure 3.76. All available axes were assigned to image volume axes.

7. "Short name:" SAGR, "Axis notation:" Sagittal, "Display negative coordinates positive:" check box, "Short
name of the negative axis range:" SAGL (L: left), "Length of reference

unit:", 1000.0 µm and the "Scale unit for visualization:" mm can be defined here. Then the axis must be posi-
tioned in an image by setting the x-axis pixel (here 1512) of the

image to the origin of coordinate (0) and a second reference pixel (here 1682) to coordinate 1.0. The settings
must be finished by clicking on the "Accept" button.

Figure 3.77. Defining the x-axis as a sagittal axis.

8. These axis specific definitions should be performed for all five axes.

Figure 3.78. DV-Interaural axis definition.
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Figure 3.79. DV-Dura axis definition.

Figure 3.80. AP-Interaural definition.

Figure 3.81. AP-Bregma axis definition.

9. Now the axis can be visualized in the images by clicking the right mouse button on an image and selecting
"Arrange coordinate view".
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Figure 3.82. Activation of features of axes for visualization.

10.After applying these settings the axes and local mouse coordinates (check mark of "Show coordinates") will
be displayed.

Figure 3.83. Mouse pointer coordinates with regard to the defined axes and axes display
at the image borders.
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11.A definition of a coordinate system can be exported by clicking on "Contours and surfaces" -> "Export coord
system". Coordinate systems can be imported in a project by clicking on "Contours and surfaces" -> "Load
coord system".
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Chapter 4. Navigation in ontologies
and hierarchical region selection for
connectivity analysis
Mapping is the assignment of a term of a region to a region in a image or a stack of images. The terms of regions of
nervous systems and more generally of systems of organs in anatomy are often organized in a hierarchical manner.
The size, location and function of physical structures are considered for organizing regions in a hierarchy. The
very detailed subdivision of regions in the neuroscience literature especially those of the descriptive and semi-
quantitative tract-tracing studies may exceed the 800 regions of the central nervous system of the rat brain atlases
of Paxinos and Watson (2007) or Swanson (2004) by 5-6 sublevels. Thus, the size of a hierarchical terminology
can be very large. Then it is necessary to navigate efficiently through these data.

1. Searching regions
The simplest way to find a region is to use the search option. "Name" accepts parts of region names (e.g., nigra
compact). After pressing Enter all regions will be listed (see figure below). It is also possible to look at a certain
short name whereby upper and lower cases are ignored.

Figure 4.1. The table of search results after search "nigra compact" in the "Name" field.

By double clicking on a row of search results in the table, e.g., Substantia_nigra_compact_part_caudal_tier_L,
neuroVIISAS will jump to the region into the hierarchy and leave the table open for a further search. It is al-
so possible to mark the row by a left mouse click and then click the "Select" button. Then the table of results
will be closed and neuroVIISAS will jump to Substantia_nigra_compact_part_caudal_tier_L. If we want to find
Substantia_nigra _compact_part_dorsal_tier_L in the atlas image this region have to be highlighted, followed by
a click on the find first or last appearance of the selected region symbol (-red or +green polygon symbol) in the
image navigation bar.

The regions that were found can be filtered by their side by clicking on the corresponding radio button. The
abbreviation of the region in the first row is automatically copied to the temporary buffer in order to copy it
directly to a filed of a spreadsheet application. If another row is selected from the search results table then it is
necessary to click with the right mouse button on the abbreviation field and pressing the "Copy" button. If more
than one abbreviation exists for a particular region, then the first or primary abbreviation is automatically used.
It is also possible to select a "block" (many continuous fields) of abbreviations and copy them into a spreadsheet
application. The search results can be reduced by applying All, Left or Right filters. Input and output connections
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can be switched on and of to see directly the connectivity of search result. To work with the search window on
a small laptop screen the search window can be placed and configured at a certain position on the screen. After
closing the search window it will appear exactly at the previous place and size. To reduce further the extension
of the window Commentaries can be switched on and off, too.

Figure 4.2. The abbreviation of the region of the first row "SNCD" is automatically copied
to the temporary buffer.

Figure 4.3. The found region is marked by a thickened contour. All other contours have
been unselected (right mouse click on hierarchy).

By using shortcut SHIFT + -> neuroVIISAS goes back to the previous region in the hierarchy that have been
selected. By using shortcut SHIFT + <- neuroVIISAS goes to the last region that have been passed in the hierarchy.

A subtree can be directly searched through by selecting "Search name in subtree" in the search area. If all regions
should be found in the trigeminal nucleus that contains the term "caudal" then we can first search for "trigem nuc"
in the "Name" field thereafter selecting "Search name in subtree" and then enter "caudal" in the "Name" field.

The other way to search in large subtrees for a certain expression is to right click on a result of a search in the
search results window and select "Search name in subtree".

2. Searching regions by stereotaxic coordinates
Stereotaxic coordinates are often used in publications to provide unambiguous information of the location of a
tract tracing experiments or electrode locations. It is possible to determine
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visualize the typical location of a 6-OHDA lesion experiment in the right medial forebrain bundle (mfb) with
reference to bregma at AP-BREG (anterior-posterior): -2.3, SAGR (lateral): 2,

DV-Dura (ventral): 8.3. The coordinates have to put in the "View" tab as shown in the following figure. The
coordinate can be marked by a red circle.

Figure 4.4. The found stereotaxic coordinate is highlighted by a circle in the right medial
forebrain bundle (mfb). The coordinate display in the upper left corner indicates the
current mouse pointer position.

3. Comparing histology with synchronized atlas im-
ages

neuroVIISAS supports the navigation through stacks of histological images by synchronized atlas images in order
to determine regions in histological images. The stack of atlas images must be fitted to the histological dataset.
This can be done by selecting "Settings" -> Set up the atlas of Paxinos in the main window. Then the histological
images can be assigned to atlas images by the dialog shown below.
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Figure 4.5. Assignment of 4224 (5 µm thick) histological images to 161 (140 µm thick)
atlas images.

After finishing the fitting, the atlas images are displayed by clicking on "View" in the main window and then on
"Display atlas of Paxinos" (see figure below).

Figure 4.6. The histological AP-BREG coordinate is -6.2672 and the atlas coordinate -6.72.

4. Sagittal navigation

Most histological work is done in frontal, respectively, coronal sections. To support the navigation in large stacks
of frontal images a sagittal atlas image can be loaded to indicate the spatial location of a frontal section. Open the
menu "View" and then "Open Side View". A new window with the sagittal image is opened (see figure below).
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Figure 4.7. The histological section 2524 and the estimated location in the sagittal atlas
view of the rat brain atlas of Paxinos and Watson (2007).

5. High resolution navigation

A high resolution image of the currently displayed image in the main window can be loaded in a separate window
(see next figure). "View" -> "Show Raw Image". Use "F3" to decrease resolution and "F4" to increase resolution
and "F5" to obtain the original size of the image.

Figure 4.8. The raw image window offers some further options by clicking on "View" and
"Settings".

The next example shows the left substantia nigra pars compacta after pressing 3 times F4 for higher resolution.
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Figure 4.9. Higher resolution of reticular and compact parts of the left substantia nigra.

6. Navigation in orthogonal slices

Before orthogonal slices can be used for navigation they have to be computed: "View" -> "Create orthogonal
slices". This could take some time! Thereafter, we can open the "Orthogonal views" window ("View" -> "Open
orthogonal view" (see next figure).

Figure 4.10. The "Orthogonal views" window.

To get the orthogonal views in on the display select "File" -> "Add current project". Then, 3 new subwindows are
generated and in the first a frontal section appears. Subwindows and size of sections can be adapted, coordinate
systems can be defined as described elsewhere. It is possible to load another image stack from another project and
(e.g., transgenic mice image stack) and to compare the control stack with the transgene animal stack synchronized
in 6 subwindows (with dual displays). By selecting "Choose reference axes for inter-project comparison" adaption
of images between projects is possible.
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Figure 4.11. Subwindows and sizes of views can be defined independently. The crosshair
is located within the substantia nigra compact part. The display of coordinate axes have
been defined for each view.
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Chapter 5. Visualization of regions
and connections
1. Rendering

Before 3D visualization is possible the regions that should be visualized have to be traced (see above) to obtain
their contours. This is followed by rendering. Rendering can be performed by clicking on "Contours and surfaces"
in the main window and select "Calculate surfaces of all regions".

Figure 5.1. The dialog "Options for surface calculation" show typical parameters for
rendering the rat brain atlas.

The followings sets of all contours can be rendered:

• Calculate surface of current region (region that has been selected in the hierarchy).

• Calculate surface of regions with updated contours.

• Calculate surface of all checked regions.

Hence, rendered regions may differ in their rendering parameters. For example the large hull of the cen-
tral nervous system from the olfactory bulb down the cauda equina can be rendered with only 5 subdi-
visions and a large smoothing factor of 300. Small regions like the substantia nigra pars compacta can
be rendered with 7 subdivisions and a smoothing factor of 200. After rendering, the project should be
stored to save the rendered data. In the next figure the rendering effect with 6 subdivisions and a smooth-
ing factor of 200 of the Lateral_agranular_prefrontal_cortex_L (=left hemispheric primary motor cortex) ap-
plying the "Marching cubes" method is shown after selecting the "Calculate surface of all checked re-
gions" and check marking the Lateral_agranular_prefrontal_cortex_L in the hierarchy. The 3D-view of the
Lateral_agranular_prefrontal_cortex_L from dorsal is generated by "View" -> "Open 3D-view" (the 3D-view win-
dow should not be kept open when rendering is performed).
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Figure 5.2. A fine rendering of the left primary motor cortex.
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Figure 5.3. A coarser rendering with strong smoothing of the same region as shown in
the last figure.

Rendering by using the "Delauney as one object" method is more time consuming. The #-parameter is the maximal
distance of the neighbor of a node for the Delauney triangulation in percent of the maximal site length of the
corresponding bounding box. By using an α of 10% a less fine contour is obtained.
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Figure 5.4. Delauney rendering using an α of 10% of the primary motor cortex.

If "Delauney layer wise" has been selected and an α of 10% is used then we get the result shown in the next figure.
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Figure 5.5. Layer wise Delauney rendering using an α of 10% of the primary motor cortex.

Contour renderings of all regions or check marked regions of a project can be exported and imported by selecting
the function in the "Contours and surfaces" menu. This is useful if we like to derivate a most authentic atlas of the
brain containing only those regions which are used in other atlas work like the rat brain atlas of Swanson (2004)
or Paxinos (2007).

A consistency check of all regions with contours can be performed by selecting the "Seek for inconsistencies of
contours". Inconsistencies could be that

• a region lies fully or partly outside another region at a higher level of the hierarchy,

• a contour of a region appears in one image and in the image after the next, however, not in the next image.
Hence, "contour gaps" are detected.

Some of these inconsistencies can be corrected to increase the rendering quality and the quality of the derivation
of supercontours (see next section). In the next figure the result of an inconsistency check is shown.
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Figure 5.6. The contour inconsistency detected, e.g., contours of the Rubrospinal_tract_L
lying partly outside the "Central_nervous_system_L (sometimes only one pixel apart) or
has contour gaps in between images.

After controlling inconsistencies of contours it is possible to estimate contours as contours hulls that contain
manually defined contours. After opening "Contours and surfaces" select on of the surface calculation options
(see next figure).

Figure 5.7. Check marking "Summarize surface from subregions" allow to estimate
contours.

So far, it is possible to estimate contours with successive rendering of those regions that contain contour informa-
tion. An estimator for regions that are not traced and without contour information of subregions is not available.
The thalamus is a region which contains hundreds of nuclei, subnuclei and parts of nuclei that are specified in
neuroscience research. However, a delination of the thalamus as a compact region is not available in stereotaxic
atlases. In the following figure an estimation of the left and right thalamic surface is shown:
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Figure 5.8. The surfaces of left and right thalamus and the transparent surface of the right
pars cranialis.

Figure 5.9. The subnuclei of the left thalamus and the surface of the right thalamus.

2. Estimating region volumes

The volumes of region can be estimated after rendering have been performed successfully. "Analysis" -> "Calcu-
late volume of current region" or "Calculate volume of current region and its subregions" or "Calculate volume
of selected regions". The calculation should be stored within the project. After computing the volumes they can
be displayed if configured in the "Settings" menu (right mouse click on hierarchy window -> "Settings" -> check
mark "Volumes". Volumes are displayed in tool tips by pointing to a region in the hierarchy windows or in the 3D-
view. Volumes can be used for estimating neuron populations for simulations. The volumes of those regions which
do not possess a contour, however, contain regions with contours at lower levels can be estimated by clicking on
"Analysis" and "Estimates volumes of regions without contours".

3. 3D-visualization of regions

3D-visualization in the context of visualization of neuroanatomical entities can start by opening the 3D-view:
"View" -> "Open 2D-view". If regions in the hierarchy display were check marked and contain rendered contours
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then these regions will shown in 3D automatically after opening the 3D-view. If many regions were check marked
the computation of the 3D-view may take some time. If a region in the hierarchy window were selected before
or after the 3D-view is opened then the abbreviation of that region will be displayed int he 3D-view. If this is not
intended then click on a region that is not check marked or that contain no rendered contour. In the following a
3D-visualization process is described.

1. Right mouse click in hierarchy window and check mark "left = right" to perform automatic check marking on
the contralateral site.

2. Check mark Ventrolateral_thalamic_nucleus_L (VL), Lateral_agranular_prefrontal_cortex_L (AGl),
Caudate_putamen_L (CPu), Globus_pallidus_L (GP), Substantia_nigra_reticular_part_L

(SNR), Substantia_nigra_compact_part_dorsal_tier_L (SNCD),
Substantia_nigra_compact_part_ventrall_tier_L (SNCV), Substantia_nigra_compact_part_medial_tier_L
(SNCM),

Subthalamic_nucleus_L (STh).

3. "View" -> "Open 3D-View" then a 3D-view should be seen as shown in the following figure.

Figure 5.10. The 3D-view of the regions that were selected by check marking in the
hierarchy.

4. Click on the grey button left beside the "Display connections" checkmark box. The a menu appears and click
on the button "Top". The menu and the change of view from top

is shown in the next figure.
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Figure 5.11. The 3D menu and the 3D view after pressing the "Top" button.

5. If we want to know the names of the visualized regions a checkmark can be set in the checkbox "Show labels
for all regions". Further information of a region o which the mouse pointer is located

can be displayed in a tooltip or an external window (see next figure).

Figure 5.12. Labels (region abbreviations) can be changed with regard to size and
position. Pointing on the left AGl provides the information shown in the window below.

6. The 3D-visualization can be zoomed by holding the right mouse button an moving the mouse up (zoom out)
or down (zoom in). The left mouse button is used for rotating and pressing the mouse wheels allows shifting
the 3D-view.



Visualization of re-
gions and connections

90

To edit complex contours in large datasets like the stack of images of cryosections of the rat (approximately 9000
section) it is helpful to visualize a contour in exactly the 2D-section and localize it simultaneously in 3D.

In the following image the function "Show current slice image" has been checkmarked and the corresponding 2D-
section in the main window is simultaneously displayed. If another image or section in the 2D-window will be
selected then the corresponding section is updated in the 3D-window.

Figure 5.13. The corresponding 2D-section is visualized in the 3D-window.
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Chapter 6. Connectivity visualization
and analysis
Neuronal connections can be visualized with regard to tract tracing studies and/or combinations of sources and
targets in 2D atlas images or in 3D. In addition, neuroVIISAS offers further possibilities of connectivity visual-
ization in combination with network analysis which will be described in section 4. The subwindows connectivity
visualization window can be dynamically arranged by using the docking options in the upper right window corner.

1. Tract tracing and atlas based visualization of con-
nections

After opening "Analysis" and "Connectivity visualization" a windows will be opened that consists of a left table
and a right filter administration part (see next figure).

Figure 6.1. The connectivity visualization window with a left table and right filter
administration part.

The first 4 columns of the connectivity table contains colors and indices (L: left, R: right) of source ("From")
and target ("To") regions followed by the column of connection names, a connection weight column (maximum
weight of all publications that describe the same connection), the publication column contains the bibtex item(s) of
the publication(s) in which the particular connection has been described and a "Weights" column that contain all
weights of all publications of a specific connection. By clicking on the column heads the columns can be sorted.
A filter allows the selection a particular publication or several publications by applying logical operators "AND,
"OR" and "NOT". By doing a right mouse click the following menu is shown:
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Figure 6.2. The "Create filter" menu.

After selecting "Publication filter" a publication table with checkboxes and number of connections per publication
is generated:
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Figure 6.3. The publication table.

All publications of one author were selected that contain connectivity data. Another publication (e.g., Abraham-
son:2001) is selected to show the function of logical operators. After pressing "Accept" we are able to combine
these selections by logical operators:
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Figure 6.4. Applying logical operators to publication filtering.

The filter list contains 4 rows. The first and the second contains the selections that were made in the publication
table (see above). Does the publication of Abrahamson:2001 contain a connection that has been also published in
at least one of the five publications of Allen? To obtain an answer the first two rows must be checkmarked that
click on "AND" and the third row will be generated. The answer is: no connection of Abrahmson:2001 fit any of
the connections in the five Allen publications. If we connected the Abrahamson:2001 and all Allen publications
with an "OR" then we get the fourth row and with 408 connections. Complex filter expressions can be generated,
stored and loaded by using the buttons in the right lower corner. A filter can be applied by selecting the row with
a left mouse click (blue highlighted and then press "Apply filter" to generate a connection table that contains the
results of the filter application:

Figure 6.5. The connection table after applying the filter in the fourth row of the filter list.

All connections are listed that have been described in the five Allen publications or the Abrahamson:2001 pub-
lication. In this example there exist some authors that have also found the connections described by Allen and
Abrahamson:2001. Thus, further authors may be listed for a particular connection. The table can be exported by
selecting a first row and a last row with mouse clicks, Crtl+C followed by Crtl+V in a n appropriate spreadsheet
application or text editor (Columns are separated by tabulators). By clicking on the header of a particular column
of the table the table will be sorted. The selected connections can be visualized in the atlas (View -> Atlas view):
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Figure 6.6. The atlas view: On the left a scrollable list of atlas thumb images with their
corresponding plate number and on the right the customizable visualization window is
shown.

In this example the atlas images 6 to 147 contain source and target regions of the connections. To bring only those
atlas images into the atlas view that contain differences of source and target regions from atlas image to atlas
image the difference button (lower left corner; exclamation point in yellow triangle) has to be clicked otherwise
all atlas image are displayed by selecting the "green plus" button. Before clicking on one of the image selections
the number of image columns, e.g., 3 can be determined. If the scaling of an image is adapted in one view port the
same action can be applied to all other view ports by checkmarking the "Sync views" checkbox.

Figure 6.7. The connectivity visualization in atlas images after setting 3 image columns,
difference button, "Sync view" and downscaling.

The colors of the regions are the same as defined in the mapping procedure and as shown in the hierarchy. All
images that are shown in the connectivity view can be exported by clicking on the camera button. The right mouse
click on one image allows the settings of coordinate system views:
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Figure 6.8. The settings of the coordinate system for all synchronized view ports.

Image 43 can be selected by clicking on the large rectangle with an arrow showing to the right, then zooming
in by clicking on the magnifier + button. To visualize the source with filled dots as neuron sources (outdegree
checkmarked) of connections and Y-like symbols for terminals (indegree checkmarked) with colors corresponding
to their source regions a connection map can be generated:

Figure 6.9. The connection map of sources and targets in atlas plate number 43.

By moving the mouse pointer over a region that contains source and/or targets a tooltip is opened containing
information of the region:
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Figure 6.10. The tooltip of the right anterior cortical amygdaloid nucleus region.

The symbol density, symbol size and symbol line width among other parameters can be adapted by using the
sliders at the bottom of the view port.

2. Tract tracing and 3D based visualization of connec-
tions

Using the same filters as defined in the example in section 1 the same connections based on publication filtering can
be visualized in 3D by clicking on "Views" -> "3D-View" and performing specific 3D settings as described earlier:

Figure 6.11. The 3D-visualization of the same connections as filtered in the example in
section 1.
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3. Source-target based atlas and 3D visualization of
connections
The two other possibilities for filtering connections are single or combinations of source and target region based
connection filtering. A left mouse click in the "Filter administration" frame opens the following menu:

Figure 6.12. The "Create filter" menu allows to select sources for connection filtering.

A window will be opened to "Select source regions for filter" in the interactive hierarchy view. By search the
abbreviation "SNC" (in the "Short name" field) of substantia nigra pars compacta a list of all abbreviations that
contain "SNC" is generated:

Figure 6.13. The source regions which contain "SNC" in their abbreviations,
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To select SNC only we can sort the "Short name" column by a left mouse click on the column header. The SNC
possesses the most inputs (173) and outputs (202) of all regions that contain "SBNC" as part of their abbreviations
(most of them are subregions of the SNC). The two rows of the left and right SNC are selected by a left mouse
click to highlight them in blue and then they are added to the selected region list by clicking on the green cross
right beside the "Table" frame.

Figure 6.14. Sorting and selecting of SNC.

The selected regions appear now in the "Selected regions" list. Further regions can added now by performing
search operations or just navigating through the hierarchy. If the source region selection has been finished the
filter has to be created by clicking on "Create filter".

Figure 6.15. The marked regions of the search result are transferred to the "Selected
regions" list for filtering.

After clicking on "Create Filter" the two regions should be found in the "Filter administration" table of the main
windows of the "Connectivity visualization" GUI.
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Figure 6.16. The source region filter is applied by clicking on it (highlighting in blue).

After clicking the source region filter it is highlighted in blue and all connections are filtered which receives
afferents from SNC. They are listed in the "Table View". Now this filter can be combined with any kind of other
source or target filters by logical operators and visualized, exported or stored as described earlier. The filtered
connection list can be exported into a csv-file. For example, all connections of one particular publication ("author
filtering") can be filtered and exported in order to visualize and analyze them by using connectivity analysis (see
below). Then a new project have to be generated and the tree of regions copied to the new project and at least the
exported connection list (csv file) can be imported. The new project would consist of all regions of the original
project, however, it contains only the connections of the csv file.
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Chapter 7. Connectivity analysis
The analysis of neuronal networks can be accessed by clicking on "Analysis" in the main window of neuroVIISAS
and then on "Advanced connectivity analysis". Analysis of networks is performed by calculating matrices, global
and local network parameters. Results are presented as sortable tables, parameter combinations in diagrams, 2D-
visualization of nested networks and 3D-visualization of rendered regions of a network. The first step of each
network analysis is the selection of regions.

Figure 7.1. The "Advanced connectivity analysis" main window.

The "Advanced connectivity analysis" main window can be customized by the user. Views can be docked and
undocked (re-intgrated into the main window) to allow an optimal visualization of specific analyses. The control
buttons are in the upper right corner of each view. The main window consists of 4 views:

1. Triangle hierarchy: Triangle visualization of complex hierarchies.

2. Miniview for magnification of parts of large matrices.

3. Tree hierarchy: The hierarchy navigation view that works similar as the hierarchy view in the main window
of neuroVIISAS.

4. Tab View: By selecting a tab at the lower border of the tab view.

The main window contains the menus "File", "Analysis panels", "Hierarchy panels", "MiniView" and "Results".
These menus will be introduced in the following sections.

1. Region selection of a network

By clicking the right mouse button in the "Triangle hierarchy" window the following menu appears:
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Figure 7.2. A right mouse click in the "Triangle hierarchy" windows opens the navigation
menu.

To build a specific network(e.g., the basal ganglia) out of the whole connectome regions or nodes must be assem-
bled. It is possible to search (Name: longname or Short name) for specific regions, e.g., basal ganglia and to add
one or several regions within the search function to the network:

Figure 7.3. The left basal ganglia node is added to the network.

By right clicking on "Expand all leaves" of the basal ganglia node the subregions of the basal ganglia are opened.
All subregions of these regions can be opened by clicking again on "Expand all leaves". Using the navigation
items of the menu:

• Expand all leaves (+ key)

• Open all

• Collapse one level ( - key)
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• Reduce to this level

• Expand all leafs in subtree (double click left mouse button)

• Collapse one level in subtree

• Switch sides

• Add submenu

• Remove submenu

It is possible to generate with a few mouse clicks a typical basal ganglia network of the left and right hemisphere
as shown in the following figure.

Figure 7.4. The selected regions of the basal ganglia of the left and right hemisphere at a
relative coarse level of resolution (level 14).

All regions that do not possess connections can be removed by clicking the right mouse button on the "Triangle
hierarchy" -> "Remove" -> "Remove regions without link". An "Undo" function for removing and adding regions
is available by pressing Strg+Z keys (switching back) and Strg+Y (switching forward. The selection of regions
can be stored in a "region filter" directory and used again ("File" -> "Save selection"). This procedure allows a
specific selection of regions of a specific network or partial connectome. The following example shows a selection
of all regions of the somatosensory barrel cortex at largest resolution with all input and output regions of the left
and right hemisphere. The prominent diagonal connectivities suggest strong local circuit information at a high
resolution (very fine subdivisions of regions):
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Figure 7.5. Somatosensory barrel cortex with all input and output regions.

This selection can be applied to the project hierarchy in order to obtain a reduced project that can be fast processed
and easily shared with other persons. To apply this selection to the project hierarchy or neuroontology click on
"File" -> "Apply node selection to project hierarchy":

Figure 7.6. The "File" menu with the "Apply node selection to project hierarchy"
selection.

After selecting "Apply node selection to project hierarchy" each node of the project hierarchy is selected that has
been selected in the triangle hierarchy:



Connectivity analysis

105

Figure 7.7. All regions are selected that has been selected in the triangle view of the
hierarchy.

A right mouse click on a node in the project hierarchy opens the menu for hierarchy processing.

Figure 7.8. Deleting non selected regions.

By selecting "Delete unselected regions" all regions are deleted that have not be checkmarked:
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Figure 7.9. Only selected regions remain after deleting the non selected regions.

Attention: The modified project hierarchy should be immediately stored under a new project name!

After selecting regions it is possible to go back to a previous state of the selection process by using the shortcut
Strg + z.

To calculate the "Adjacency matrix" the "Refresh" button or the "Enter" key must be pressed. By turning the
mouse wheel the view of the adjacency matrix can be modified. A right mouse button click on the adjacency
matrix opens the following menu:

Figure 7.10. The menu offers options for data documentation and export.
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The adjacency matrix can be configured by clicking on the "Settings" button, change the "Line thickness of the
grid" and "Choose a grid color". In addition a color scheme can be defined by clicking on "Change color values
of matrix". The color scheme can be saved as a xml-file.

Figure 7.11. The "Edge count" matrix after defining a color scheme.

Figure 7.12.

The same options are available for all other matrices of the analysis tabulators. By moving the mouse over the
elements of the adjacency matrix specific information of a connection is displayed in a tooltip, e.g., information
about the connection from the right parafascicular thalamic nucleus and the left caudate putamen complex.

Figure 7.13. Tooltip information of the right parafascicular thalamic nucleus and the left
caudate putamen complex.
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The rows of the adjacency matrix are sources of connections and the columns are targets. Hence, efferent/sending
regions are listed as abbreviations on the left side of the adjacency matrix and afferent/receiving regions are indi-
cated at the top. In most cases the ipsilateral connections are more abundant than contralateral connections that is
also the case in this example. The adjacency as well as all other matrices can be configured by the user:

Figure 7.14. The "Settings" menu of the matrix by clicking on the dark gray button on
the upper right corner of the "Adjacency Matrix" view.

The position of row and column names and formats, in this case full names, are selected. By double clicking on
a matrix element a navigation cross appears. On Linux KDE the double click is set automatically to 200 msec if
not specified. It is recommended to generate a .Xdefaults in the home directory of the user that contains "*.mul-
tiClickTime: 1000" and then open the shell and put in xrdb -merge ~/.Xdefaults.

2. The adjacency matrix

The connections of a network can be represented in a matrix and more specifically: the adjacency matrix (A).
In the most simple, case A contains only zeros and ones indicating if a connection exists or not. In the case of
neuronal networks that are based on metaanalysis of many complex tract tracing studies we can represent far more
information in an A than the existence or non-existence of connections. In the example of the basalganglia as
shown in the last section the number of connections between a source and a target is coded as gray values with a
scaling bar (0 to 56 connections). Because several authors may report the same connectivity numbers larger than
1 occur. By choosing the radio button "Adjacency matrix" a binary A will be calculated. This matrix contain all
those connections between sources and targets that are also located in higher levels (superregions), however, not
at lower levels (subregions):
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Figure 7.15. The binary adjacency matrix.

If only those connections should be shown that directly connect exactly the indicated source and target regions
(leafs) the radiobutton "Consider only direct edges" must be selected followed by the selection of the radiobutton
"Adjacency Matrix" and finishing by pressing the "Accept" button:

Figure 7.16. This binary adjacency matrix should be sparser because connection of
superregions are not considered.

By selecting "Number of authors" the A is calculated containing the number of authors that reported the connec-
tions:
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Figure 7.17. Number of reports of the connections.

The average weight, respectively, density of a connection is shown in the following figure:

Figure 7.18. Average weight of connections.

The adjacency matrix with standard deviation of weights are shown in the next figure:
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Figure 7.19. A relative large standard deviation of connection weights is found between
the left ventromedial thalamic nucleus and the left primary motor cortex.

An important derivate of the adjacency matrix is the discrepancy of reported connections. This is mean relation
of positive and uncertain weights and reports that explicitly document the non-existence of a specific connection
(weight: 0). The strongest discrepancy is one which means that at least the connection in one report is documented
as non-existent and in other reports it has a positive weight:

Figure 7.20. The representation of discrepancies of connection reports.

The type of tract tracing (anterograde, retrograde) that was applied to describe a connection is shown as follows:
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Figure 7.21. Types of tract tracing and combinations.

In most cases retrograde (r: blue) and anterograde (a: green) traces have been applied for a specific connection.
However, those connections that are reported with a retrograde and a anterograde tracer (cross checked) can be
considered as more reliable. "a/r" indicate tracers that are transported anterograde and retrograde. These can be
used in one study also with another tracer that is transported selectively anterograde, only: a+a/r. The weights or
densities of connections can be selected and indicated with different colors. The colors are defined in the menu
"Settings" -> "Change colors of connection weights" of the neuroVIISAS main windows. To indicate the weights
the radiobutton "Strongest weights" must be selected:

Figure 7.22. 12 classes of types of weights are shown.

By moving the mouse on an orange element of the matrix that is not listed in the scale, e.g. AGl_R (last row)
and STh_R (second last column), 7 reports are listed that describe the connection from the right lateral agranular
prefrontal cortex (primary motor cortex) to the right subthalamic nucleus with different weights. The relative part
of a specific weight is calculated and averaged to obtain a measure for the relative weight of a specific connection
with regard to all reports.
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The indication of weights can be combined with a numerical presentation (number of documented edges can also
be combined with numerical display).

Figure 7.23. Display of the values of weights within the adjacency matrix.

The frequencies of weights from different experiments and the type of detection (anterograde, retrograde) can be
visualized in terms of a reliability or validity matrix. The original weights of the matrix are related to a reliability
weight as shown in the table below. These reliability weights can be redefined by the user. Also tracing types need
to be weighted. If a connection has been detected by an anterograde and retrograde method it gets a relative large
reliability weight of 1. If the connection has been detected only by a retrograde method then the reliability weight
is 0.5. All reliability weights of each connection are added and displayed in the reliability or validity matrix.
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Figure 7.24. The selection of the validity or reliability analysis and the related reliability
weights.

Additional information like sums of matrix columns and/or rows can be displayed by clicking on the Right and/
or Down button in the Settings window of an adjacency matrix (upper right corner of the matrix window). The
superior levels of the hierarchy can be added to the adjacency matrix as well by checkmarking "Parent regions
in labels" and selecting the levels by the slider. The number of direct and cumulated connections of a leaf of the
hierarchy can be shown by clicking on the configuration-button of the hierarchy (yellow and black bars in the
hierarchy window).
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Figure 7.25. Additional information of matrices.

3. Further filtering and analysis options of the adjacen-
cy matrix

By clicking on the "Show table" radiobutton at the bottom adjacency matrix window the sums of indegrees, out-
degrees and maxima for each row of the matrix are computed in a sortable and exportable table.

The "Show table" function can be applied to any of the deviated adjacency matrices mentioned before and for
further matrices as well (distance, communicability, connectivity matching indices).

Figure 7.26. Row statistics of the adjacency matrix.

It is important to notice the the terms "Indegrees" and "Outdegrees" are used in another sense than in the "Local
parameters" table. A node of a selection represents itself and its possible subregions (which are hidden) with their
connections. Hence, the indegree of a node i that is computed after clicking on "Show table" is the sum of the
inputs to the subtree of i from any of the subtrees of the selection. Outdegrees is defined in the same way. In the
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column "Self-references" the number of connections within the subtree is shown. In the following figure these
definitions are illustrated:

Figure 7.27. Dashed arrows are indicating connections between nodes.

In this example of the gray nodes F, G, C, D, H and I are selected. In the table that is computed with the "Show
table" function the outdegree of node "F" is 4 and the maximum output (2) goes to the subtree of node "H". Hence,
node "H" is the name of the "Target" that receives most outputs from node "F". However, in the "Local parameter"
table the outdegree of node "F" is 3 (to nodes "G", "D" and "H").

Those regions that are reciprocally connected can be filtered in the adjacency matrix by opening the "Settings"
menu and checkmarking "Hide non reciprocal connections". Then all connections are shown in the adjacency ma-
trix that are reciprocal. However, all other connections are still available within the adjacency matrix. These "non-
visible" connection can be seen by moving the mouse over the black matrix elements. If a reciprocal connection
between two different regions posses two different weights then the largest weight is indicated.
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Figure 7.28. Reciprocal connections with positive weights.

The "Apply Filter" function is applied to the indicated values shown beside the adjacency matrix. All regions will
be filtered that are larger or equal like the value in the left field and smaller or equal like the value in the right
field. After pressing the button "Apply filter" the "Refresh" button should be pressed in order to apply the filter
to the regions in the triangle hierarchy.

The selection of regions which have collateral (axon branches) connections is performed by the following steps:

1. Analysis (Menu)

2. Advanced connectivity analysis (Submenu)

3. Hierarchy (Menu)

4. Automatic node selection (collaterals) (Submenu)

5. Enter or Refresh button

6. Consider only direct edges (and e.g. "Tracing type" selection)

7. Filter icon (upper right corner of adjacency matrix window)

8. Right mouse click in filter table

9. Move mouse to "Create filter"

10. Connection has to be a collateral

11. Click on the new filter row so that it appears highlighted (do not set a checkmark here!)

12. Click on Apply

After leaving the Filter function the filter is active as indicated by a yellow symbol beside the filter symbol! If
the filter should be removed click on "Remove filter" button. The filter can be stored or loaded by clicking on the
symbols in the lower right corner of the filter window.

3.1. Deleting several regions

Several regions can be selected by holding the Strg (Ctrl) key and clicking with the mouse pointer onto the leaves
of the triangle hierarchy that should be dropped after pressing the Del (Entf) key (the dropped regions are not
contained in the adjacency matrix anymore, however, their existence in the ontology is not effected).
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Figure 7.29. Selecting several regions in order to remove them

3.2. Selection and filtering of regions within the adjacency matrix

Elements of the adjacency matrix can be select by using the rectangular selection function that is activated by
first pressing Shift-button (and hold it) and then moving the mouse pointer over the region of interests within the
adjacency matrix.

Figure 7.30. The black and yellow dashed line rectangle indicates the selected regions.

Following the the selection step the selection can be applied to the hierarchy by clicking the right mouse button
and select from the pop-up menu "Apply selection to hierarchy". This process is meaningful to selected clusters
or densely connected regions within larger adjacency matrices.
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Figure 7.31. Applying the selection to the hierarchy.

3.3. Selection of >1000 regions needs huge matrices: how to save
random access memory

The expansion of complex hierarchies may result in the selection of thousands of connected regions. For small
matrices (< 1000x1000) RAM of 64 GB will allow normal working with neuroVIISAS. However, if the number
of regions is large like 40000 X 40000 then memory can saved by checkmarking the Save memory mode within
the "Setting" button at the upper right corner of the "Adjacency matrix window". In this cases a basic computation
of global and local network parameters is still possible, however, computations based on matrices are not possible
and matrices will not be computed.
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Figure 7.32. The "Save memory mode" switches off the matrix computations.

3.4. Interactive threshold dependent top-town assembling of re-
gions

The assembling of groups of regions that are densely connected is supported by automatically deselecting regions
that have a small number of connections while expanding superregions to subregions. This function is useful
to develop coarse networks in order to understand higher organization principles of connectivity, e.g., coarse
neuroanatomic network presentation in block diagrams. In the following a coarse network around the basolateral
amygdaloid nucleus (BL) is developed. Because regions of the spinal cord are not of interest the Pars cranialis
region of the central nervous system is selected as a starting point.



Connectivity analysis

121

Figure 7.33. Selection of the region Pars cranialis.

With a right mouse click in the triangle hierarchy the dialogue "Search and add regions" is opened and the "Baso-
lateral amygdaloid nucleus" should be searched and then added to the hierarchy.

Figure 7.34. The Basolateral amygdaloid nucleus has been added.

Then the Pars cranialis region in the triangle hierarchy is selected again and then a right mouse clicks opens a menu
where "Add" is selected and then "Restore removed childs". All child nodes of the prosencephalon are opened
including the ventricle regions which are removed by clicking on them and then pressing the Del key.
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Figure 7.35. Result after "Restore removed childs" from the Pars cranialis region have
been performed.

Then "Restore removed childs" is repeated after selecting the prosencephalon region and then for the brain stem
region. Superregion "large fibre systems" and "surfaces" are removed. Now the edge count display is selected
for the adjacency matrix (Click on "Settings" symbol at upper right corner of the adjacency matrix window and
selecting "Edge count" and "Display values").

Figure 7.36. After restoring two times child regions from superregions and new settings
of the adjacency matrix menu the RET (Retina) region shows only few inputs and outputs
and no connection to BL.

Now, all regions should be removed that have an input to BL that is smaller than 5 and that receive lower than 5
output from BL. Select the BL region in the triangle hierarchy and then perform a right mouse click and select the
menue item "Remove" and then select "Remove regions with low input from Basolateral_amygdaloid_nucleus_L"
and enter 5 as a threshold, finish by clicking on "Enter". Then this process must be repeated with the the output
filter "Remove regions with low output from Basolateral_amygdaloid_nucleus_L". Then the coarse adjacency
matrix is condensed. Retina (RET) and Mesencephalon (MEC) has been removed.
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Figure 7.37. Result after removing RET.

Then all removed children of the new superregions are restored as described before and the adjacency matrix will
look a little bit more complex as follows.

Figure 7.38. All restored child regions.



Connectivity analysis

124

Figure 7.39. After input and output filtering the adjacency matrix is condensed.

After restoring child nodes and removing new child nodes, if inputs or outputs are below the threshold, a final
adjacency matrix is available that can be compared with neuroanatomical textbook presentations, review articles
and some overviews of connectivity architecture in the discussion-sections of research articles of tract-tracing
studies.

Figure 7.40. A final addition of regions which are densely connected to the regions already
selected.

To open the Settings-Window for configuring the adjacency matrix the settings-Button at the upper right corner
of the Matrix-Window must be pressed.
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Figure 7.41. Settings Window for configuring the matrix window.

After pressing the "Right" and "Left" button the row and column histograms appear beside the matrix. By pressing
the right mouse button a threshold can be added and regions above the threshold are highlighted by magenta stripes.
Holding the right mouse button in the histograms move the threshold dynamically. The regions are marked by
rectangles. This selection can be fixed for further processing.
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Figure 7.42. Threshold based selection of regions.

If all regions which have contours should be selected under one or several regions which have been selected before
then select "Hierarchy" menue and then "Expand leafs with contours only":

Figure 7.43. Preselection of a region at an upper level of the hierarchy like the pons.
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Figure 7.44. Then all regions with contours under pons have been automatically selected.
These regions can be directly visualized in 3D.

The distribution of matrix values of a certain region within the matrix with the remaining elements of the matrix
can be compared in terms of statistics. Hold the "Shift up" key by moving the mouse by holding the left mouse
key over a region of interest of the matrix.

A yellow rectangle appears around the selected ROI. Then click with the right mouse key on the matrix and select
from the menu "Compare selection with complete matrix". Then the T-test statistics window appears. By clicking
with the left mouse button into the ROI and moving the ROI update the T-test result dynamically.
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Figure 7.45. A ROI in the adjacency matrix with the T-test statistics window.

To mark regions of the adjacency matrices a marker function is available. The shift-up key and mouse are used
to mark a region in the matrix followed by a right mouse click into the ROI and the selecting the options for the
rectangle-markers.

Figure 7.46. A red, green and blue rectanlel marker have been added to the adjacency
matrix.

After computing another matrix the selection can be copied by a right mouse click and selecting "Adopt the
marking from"
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4. Navigation in matrices
The views "Triangle hierarchy", "Matrix" (here "Adjacency matrix" tab) and "Tree hierarchy" are logically con-
nected, meaning that if a region in the "Tree hierarchy" is selected, e.g., lateral habenular nucleus left then the
corresponding triangle is indicated by a black rectangle and the corresponding matrix row is highlighted by a violet
stripe. Hence, it is possible to move fast through one view and get synchronized information from the other views:

Figure 7.47. Selected regions are highlighted in parallel in all three views. In this case the
lateral habenular nucleus left has been selected.

The second possibility to obtain synchronized views that is comfortable if matrices are larger is a double click on
a particular connection, e.g. CPu_L and MGP_L that will be highlighted by two violet bars:

Figure 7.48. A cross of violet bars indicates the connection between the CPu_L and
MGP_L.

Furthermore groups of regions are indicated after selecting a superregion in the hierarchy. A double click in the
middle of the stripes of magenta removes the highlighting.
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Figure 7.49. Highlighting a group of subregions by selecting a superregion.

4.1. Interplay of filtering, direct-indirect edge configuration and
types of matrices

The settings window of the adjacency matrix is needed to configure the adjacency matrix. The principal modes
of an adjacency matrix are direct edges or cumulated edges mode. Using the direct edge mode allows to select
8 different finer configurations like "number of authors", "Weight", "Average weight", "Standard deviation of
weights", "Discrepancy", "Tracing type", "Validity" and an "Edge property". The part "For analyses" allows to
define the type of matrix which should be used by connectivity analysis. The analysis can also be configured in
an appropriated way by opening "Settings for analyses". Then the type of edge weighting can be defined and the
matrix can be made fully reciprocal for reasons of comparison. Finally, edges can be filtered by a boolean approach
by clicking on the filter symbols. After applying such a filter a warning is shown.
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Figure 7.50. The settings menu for matrices (left), the settings menu for graph analyses
(upper right) and the "Filter for direct edges menu" which appears following pressing
the left filter button symbol at the upper right corner of the matrix window.

5. Visualizations of the adjacency matrix

The adjacency matrix can be visualized in 2D using nested circle layout with edge bundling and in 3D. The nested
circle layout is opened by clicking on "Hierarchy panels" -> "Circle hierarchy" then the following window is
generated:
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Figure 7.51. Circle hierarchy.

Options of the circle hierarchy can be accessed by clicking on the dark gray button at the upper right corner of the
circle hierarchy view. Circles can be labeled either with short or long names. Connection display can be switched
on or off and the connections can be highlighted by moving dashed lines. After double clicking on any node dashed
lines and highlighted borders of circles indicates pathways and targets.
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Figure 7.52. After moving the mouse pointer over a circle a tooltip will be opened. A
double click will show pathways to target nodes as dashed lines.

Magnification of a region of interest is performed by the "+ magnify" button (upper right corner). The image can
be shifted be leave the left mouse button pressed and moving the image.
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Figure 7.53. Magnification if a region shown in the previous figure. Short name are
displayed now.

Beside planar visualization the adjacency matrix can be visualized in 3D, too. Click on "Hierarchy panels" in the
main windows of "Advanced connectivity analysis" and select "3D-View". Then the checkbox "Display connec-
tions" must be clicked. Open the 3D menu by clicking on the dark gray symbol at the upper right corner of the
3D-view and checkmark "Use weight color for arrows" and "Use tubes for arrow shafts".
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Figure 7.54. Visualizing the adjacency matrix in 3D with a specific connection layout.

An important feature of the 3D view is a parallelized hierarchy navigation and 3D updating: Right mouse click
on image and start navigating the hierarchy. To continuously rotate in one axis or combinations of axis a stepwise
rotation function in the 3D menu is available to produce movies or videoclips.

6. Planar graph visualizations
A further option to visualize the content of the adjacency matrix is available by clicking on the menue button
"Others" in the "Advanced connectivity analysis" window. The GraphView window is opened after selecting
"GraphView". In the following example the "Smart organic layout" in combination with the "Bus router" of edges
has been selected followed by clicking on the "Update" button". Zooming is also supported by turning the mouse
wheel or by clicking on the icons.

Figure 7.55. A planar graph visualization (right window) of the adjacency matrix of an
unilateral basalganglia region selection (in the left window).

After synchronizing the left and right basalganglia regions the "Organic layout" and organic edge computation
provides the following result.
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Figure 7.56. The region of the right hemispheres are located in the upper part of the graph.

The complex connectivity of the Barrel field A1 can easily be visualized as shown in the following "Smart organic
layout" with "Bus router".

Figure 7.57. Barrel field A1 with thalamic input, intrinsic connectivity down to the cellular
level and connectivity to the adjacent barrel field A2.

The "Incremental hierarchic layout" allows edge bundling of sources or edge bundling of targets. To further reduce
the number of edges "Self-References" can be switched off and reciprogal edges can be combined by checkmark
the checkbox. The color of the edges can be related to the adjacency matrix "Get edge color from adjacency
matrix". The thickness of edges can be increase by using the "Line width" slider and the "Backgound value" can
be adapted to visualize very light or dark colours.



Connectivity analysis

137

Figure 7.58. The incremental hierarchic layout with some further option was used to
visualize the unilateral basal ganglia network.

To visualize left and right hemispheric networks along an axis of symmetry the option "Symmetric" has to be
checkmarked.

Figure 7.59. Symmetric visualization of left and right hemispheric regions.
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Many cortical regions consist of cytoarchitectonic layers. A layer-dependent connectivity visualization in combi-
nation with symmetry preserving visualization is shown in the following example. By checkmarking "Layers" the
layers (if some layers are selected as regions) are put in stack.

Automatic layering works if the longnames of regions have the ending ...L1, ...L2, ...L3 and so on.

Figure 7.60. Symmetric and stacked visualization of layered and non-layered regions.

To visualize symmetry in combination with hierarchical location a "Sync side" selection is necessary. Then "Sym-
metric" and "Display superior structures" must be checkmarked. For the visualization of the hierarchy the node
layout "Hierarchic goup layout" in combination with the edge layout "Bus router" is suitable:

Figure 7.61. Symmetry, hierarchy and color coded visualization of the number of
connections in between subregions of branches of the hierarchy.

The graph configuration menu has been divided into a "Layout" and a "Visualization" part. An interactive visual-
ization of a complex graph without edge crossing is available in the Layout tab.
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Figure 7.62. The menu tabs for layout and visualization of the graphview window.

7. Circular connectivity visualization using the Circos
table viewer

Circos is a visualization tool that can be used as a local Perl application or through a web-interface (http://
mkweb.bcgsc.ca/tableviewer/). The web-interface allows to import tables in the form of csv-text files. A circos
text file can be generated in neuroVIISAS by opening the export menue by a right mouse click on the adjacency
table and the selection of "Export matrix for circos".
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Figure 7.63. Color option (the color of regions; not the color of connections) and the
order of regions as well as regions names can be configured before the csv-table will be
generated.

Then the csv-file can be imported using the circos web-interface.

Figure 7.64. "Row with col order" and "row with col colors" must be checkmarked!

After pressing the "Visualize Tbale" button the circular layout of the imported table is calculated (this may take
some time).
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Figure 7.65. The circos layout of the bilateral basalganglia connectome.

The interpretation of some parts of the basic layout is shown in the following:

Figure 7.66. Interpretation of some regions of the circos visualization of the basal ganglia
network. A magnification around SNC_L (substantia nigra compact part) is shown.
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8. The table hierarchy of the adjacency matrix
To obtain information of a particular region with regard to all other regions of the adjacency matrix the "Table
hierarchy" can be used. The table hierarchy refers to the "Edge count" matrix! It need to be selected by "Hierarchy
panels" -> "Table hierarchy" then the "Table hierarchy" view is added to the four standard views:

Figure 7.67. By clicking on a row or region in the "Table hierarchy" this region is
highlighted in blue and the parameters of all other regions are calculated with regard to
the selected one.

The left caudate putamen region has been selected and the mouse pointer is moved to the last row indicating the
right subthalamic nucleus with a tooltip that shows in a short form the location in the hierarchy. The table consists
of 9 columns:

1. Index: the same index as in the sequence of rows (sources, efferent regions) in the adjacency matrix.

2. Name: long name of regions.

3. Short_name: abbreviation of regions.

4. Input: number of input connections from a region (and all its subregions!) to the region (and all its subregions!)
in the activated (highlighted) row (here: Caudate_putamen_L).

5. d in: distance (number edges, vertices) from any region to the selected (highlighted) region.

6. w+ in: average positive weight of output from any region to the selected (highlighted) region (average positive
input weight to the highlighted region).

7. w- in: average negative weight of output from any region to the selected (highlighted) region (average positive
input weight to the highlighted region).

8. Output: number of output connections from the activated (highlighted) row (here Caudate_putamen_L) (and
all its subregions!) to a region (and all its subregions!).

9. d out: distance (number edges, vertices) from the selected (highlighted) region to the any region.

10.w+ out: average positive weight of output from the selected (highlighted) region to any region (average positive
output weight from the highlighted region).

11.w- out: average negative weight of output from the selected (highlighted) region to any region (average positive
output weight from the highlighted region).
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For example, the left caudate putamen complex is selected and in focus. The relation to the left substantia nigra
compact part can be described as follows: The number of connections from the regions within the subtree of the
substantia nigra compact part to subregions of the subtree of the caudate putamen is 28 (28 inputs to caudate
putemen), The distance from the left substantia nigra compact part to the caudate putamen complex is very close:
only one edge (direct connection). The average positive weight of output from the left substantia nigra compact
part to the left caudate putamen complex is very large (4.823), vice versa the average negative weight of output
from the left substantia nigra compact part to the left caudate putamen complex is very low (-0.038). The number
of output connections from the regions of the subtree of the substantia nigra pars compacta to the caudate putemen
subtree regions is 17. The distance from the left caudate putamen complex to the left substantia nigra compact part
region is also short and reciprocal. The average positive weight of the left caudate putamen to the left substantia
nigra compact part is relative strong (3.293) and vice versa the average negative weight of the same connection
very small (-0.017).

9. Adjacency matrix based degree statistics
Descriptive statistics along the rows of the adjacency matrix is computed and represented in a table accessible
by clicking on the second "Degree statistics" tab beside the "Adjacency matrix" tab. The following table will be
opened:

Figure 7.68. The degree statistics table of the rows of the adjacency matrix.

The meaning of the columns are the following:

1. Name: the sequence of longname of regions is the same as in adjacency matrix.

2. Outdegree: Sum of outdegrees (outputs, efferents) of the selected region and all subregions of the subtree of
the selected region.

3. Maximum: the maximal outdegree of the region to one other (maximum outdegree of all elements in one row
of the adjacency matrix).

4. Target: the region that receives the maximum of outputs (indicated in 3. "Maximum").

5. Indegree: Sum of indegrees (inputs, afferents) of the selected region and all subregions of the subtree of the
selected region.

6. Maximum: the maximal indegree of the region to one other (maximum indegree of all elements in one row
of the adjacency matrix).
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7. Source: the source that sends the maximum of inputs (indicated in 6. "Maximum") to the region.

8. Self-references: The number of reciprocal connections.

9. Volume mm³: The volume of the region. If the region is not outlined then the volume is set to -1.

10.Number of subregions: the number of subregions of the region.

10. Reciprocity matrix
The reciprocity matrix is initialized by clicking on the Tab "Reciprocity matrix". Before the options for the adja-
cency matrix should be configured because the reciprocity matrix is derived from this preselection. In the follow-
ing example the weight matrix of direct edges has been calculated. Then the reciprocity matrix is selected and
calculated after pressing the Refresh button. The "Show table" radio button allows to sort the reciprocity quotients.

Figure 7.69. Reciprocity matrix of the edge weights of direct connections.

In the reciprocity matrix the red shades are coding a smaller output (efferent, row) or input (afferent, column)
value than the green shades. White means 50% output and 50% input of a reciprocal connection.

11. Distance matrix
The distance matrix (or cost matrix) is a symmetric NxN matrix and represents the minimal number of edges
(shortest path) between the source nodes (vertexes) in the rows
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and the target nodes in the columns. Those regions which are not directly connected have larger distances. In the
case of the basalganglia system there exist at least

one shortest path to connect one region with all others.

Figure 7.70. The distance matrix of the left and right basal ganglia system with a scale
of edges of shortest paths.

12. Extended distance matrix

The extended distance matrix combines the spatial distance between regions and the weights of connections be-
tween regions. Select the "Extended distance matrix" tab and then click on the Settings button.

The settings window allows to apply two different formulas and different scaling factors and and the offset S.

F * (spatial Distance) / weight + S. Large distances like 14000 µm of the spatial distance matrix are adapted to the
range of values of weights 1-4 . S determines the influence of the graph theoretical distance!

F1 * (spatial Distance) +F2 / weight + S. Spatial distances can be adapted by the reciprocal value of the mean
spatial distance (e.g. 0.0006). If the weight should have a two fold influence than the graph theoretical distance
then F2 = 2 and S = 1.

After pressing "Accept" the following extended distance matrix for the region of hippocampal formation has been
computed:
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Figure 7.71. The extended distance matrix with the settings menu.

13. Communicability matrix

The communicability G of a network was introduced by Estrada and Hatano (E. Estrada and N. Hatano (2008)
Communicability in complex networks. Phys Rev E77, 036111: http://pre.aps.org/abstract/PRE/v77/i3/e036111)
matrix. The communicability between a pair of nodes in a network can be considered as the shortest path between
them. The communicability has been generalized by considering the shortest path and all other walks between
pairs of nodes with lower contributions to the communicability function. According to Estrada and Hatano (2008)
the communicability function G between the nodes p (starting node) and q (target node) can be written as follows:

Figure 7.72.

A large communicability means that there exists many short shortest paths between a pair of nodes. A small
communicability means that there exists many long shortest paths between a pair of nodes (alternative paths (other
paths than the shortest paths between two nodes) are quite long). Because the computation starts with k=0 each
value on the diagonal of the communicability matrix is larger 0 (even if there exist no connection in the adjacency
or distance matrix).
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Figure 7.73. The communicability matrix of the left and right basal ganglia.

14. Generalized Topological Overlapping Measure
(GTOM)
The GTOM matrix was introduced by Yip and Horvath (Yip A, Horvath S (2007) Gene network interconnected-
ness and the generalized topological overlap measure BMC Bioinformatics 2007, 8:22). It is a measure of pairwise
interconnectedness that is proportional to the number of neighbors that a pair of nodes share in common. The
measure is a count of the number of m-step neighbors that a pair of nodes share and normalizes it to take a value
between 0 and 1.

Figure 7.74. The GTOM matrix of the left and right basal ganglia network.
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Figure 7.75. The reformatted GTOM matrix with a user defined color scale.

15. Joint degree distribution

The joint degree distribution (JDD) of an oriented network describes the distribution of probabilities that a ran-
domly chosen edge connects nodes that have the k1 indegrees and k2 outdegrees. The diagram shown below pro-
vides information how many nodes exists that have a certain number of indegrees and outdegrees. E.g., there exist
four nodes possessing 13 outdegrees and 12 indegrees. The tooltip in the diagram indicates that there exist two
nodes that have 21 indegrees and 15 outdegrees.
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Figure 7.76. Joint degree distribution of the directed basal ganglia system network.

16. Connectivity matching index of indegrees

The connectivity matching index between two vertexes p and q provides the amount of overlap of their connec-
tion patterns. Connectivity matching indices of a directed network can be computed with regard to indegrees,
outdegrees and both together. It is an indication of the extent to which the connectivity patterns of two nodes or
neuroanatomical regions coincide.
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Figure 7.77. The connectivity matching matrix of indegrees or afferents.

17. Connectivity matching index of outdegrees

The connectivity matching index of outdegrees or efferents is an indication of the extent to which the outdegree
or efferent connectivity patterns of two nodes or neuroanatomical entities coincide.

Figure 7.78. The connectivity matching matrix of outdegrees or efferents.
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18. Connectivity matching index of indegrees and out-
degrees

The connectivity matching index of outdegrees and indegrees is an indication of the extent to which the outdegree
and indegree connectivity patterns of two nodes or neuroanatomical entities coincide.

Figure 7.79. The connectivity matching matrix of indegrees and outdegrees.

19. Comparison of hierarchies (differential hierarchical
connectome analysis)

A list of selected regions (L1) can be compared with a second list of selected regions (L2) in order to detect 1)
identical regions, 2) regions of a superior level in the hierarchy, 3) regions of an inferior level in the hierarchy,
4) regions of L2 that are not included in L1 and 5) regions of L1 that are not included in L2. In the advanced
connectivity analysis window regions has to be selected. Such a list can be stored (File -> Save selection). Now
a second selection of regions has to be performed. Also, this second list of regions of interest can be stored. Now
it is possible to compare the two different selections of regions by opening one of the stored lists and compare it
with the actually displayed selection of regions (File -> Compare selection). Thereafter, a table is generated:
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Figure 7.80. Comparison table of two lists of selected regions. The actually displayed list
of regions is shown in the column "Current selection" and the list that has been opened
in the column "Opened selection"

Abbreviations of regions and the hierarchical level is displayed for each region. If a region that was contained
in the opened region file is a subregion (part of) a superregion of the actually displayed list than a "<" indicates
the relation: Ventromedial periaqueductal gray (from file loaded region) is part of the periaqueductal gray which
a region of the actually displayed list. "+-" means that a regions is included in the "Opened selection column",
however, it is missing in the "Current selection" column (vice versa "-+"). To obtain more specific connections of
smaller regions of the hierarchy in the "Current selection" the relation column can be sorted and all regions with
a "smaller than" relation can be simply added by clicking on the corresponding row.

A typical situation could be the following. A list of activated or hypoactivated regions is observed in fMRI or
cfos expression. Are the output targets of a specific region, e.g., cortical area like parietal association cortex,
included in the observed list and which regions that receive input from the parietal association cortex have not
been observed in the experiments. In order to perform a explorative differential connectome analysis we need the
list of regions from the experiment (experiment list) and a specific list of regions of the connectome (connectome
list). The region of interest could be the parietal association cortex which can be selected by applying the search
function in the lower left corner of the Advanced connectivity analysis window. Now, the parietal cortex appears
as a single node int the selection:
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Figure 7.81. A single node (region of interest) was added.

Figure 7.82. With regard to the last added node all output neighbors of this specific node
of the left hemisphere (and all its subtree nodes) should be added.
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Figure 7.83. Now we reduce the selection to hierarchy level 11 (because this level is
meaningful with regard to the structure of this specific hierarchy and the experimental
problem).

Figure 7.84. Now we have all output neighbors of the parietal association cortex.

In addition, we want to consider also second output neighbors of the parietal association cortex. Therefore, a right
mouse click in the triangle hierarchy is performed and we select "Add neighbors of all leafs" and use the same
parameters as shown above (output-neighbors, Left, Subtree). Then we get:
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Figure 7.85. A selection of all primary and secondary output neighbors of the parietal
association cortex.

This selection can be stored and used for comparison with the experimental list.

20. Filtering features of connections (edges)

The filtering of edges can be applied to direct connections only (connections between leaves of the hierarchy).

1) Open the "Settings" box (click on quadratic symbol at the upper right corner of the matrix display window).

2) In the "Settings" box select "Consider only direct edges" and select of type of information that should be applied
(e.g., "Tracing type")

3) Press "Apply" (in the "Settings" box) and then "Refresh" button (lower left corner of the matrix display window)

4) Open the "Filter box" window by pressing on the cone-shape icon at the upper right corner of the matrix display
window.

Then the following window with filter settings appears:
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Figure 7.86. Window with filter settings.

By clicking with the right mouse key into the list frame,s elect "Create". The following menu appears:
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Figure 7.87. The list of data feature for the filter definition.

In this case "Tracing type" has been selected because we want to select all connections that were detected by virus
tract-tracing.

Now the "Tracer code information" window is opened to allow settings:
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Figure 7.88. Tracer code information window.

After selecting the appropriate features the filter must be select by clicking on it (blue bar background) and then
the button "Apply" must be pressed. Now the filter settings of edges have been applied and only those connections
remain in the adjacency matrix that fulfill the conditions. Some connections were observed by non-viral-tract-
tracers and one connection by a viral tracer, only (gray).

21. Extracting a virus connections from a connectome
project

Virus tract tracing data are visible in the "Edit connections" window
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Figure 7.89. Virus pathway data in the "Edit connections" window in the "Paths" table.

To relate a virus abbreviation to a annotation of the virus and the category "virus" which is important for filtering
virus connections in the Advance d connectivity window, select the "Experiments" tab and click on "More". Then
sort the relation table by clicking on the viral column and perform the definitions:
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Figure 7.90. Upper window: The Experiment tab with the "More" button. Lower window
the tract tracing definition table with sorted viral column.

A further general presentation of virus tract tracing data is visible in table format: Analysis -> Project Statistics
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Figure 7.91. Project statistics table with "path" information of virus pathways.

The way through the following menus generates a adjacency matrix which contain only those connection which
have been described by virus tract tracing: "Advanced Analysis" -> "Hierarchy" -> "Automatic node selection
(Tracer code)" -> confirm "Viral" -> Setting for graph analysis -> Consider only direct edges -> (Visualization:
Adjacency Matrix) -> "Click to add a filter for the direct edges" -> Tracer code informations -> At least one tracer
code has to match the condition -> Category: Viral -> True -> Apply

Then the adjacency matrix shows all connections which are detect by virus tract tracing or by virus tract tracing
and non virus tract tracing. To remove regions which are not connected: Repeat right mouse click in hierarchy and
Remove regions without connections until no changes in the hierarchy occur. To obtain only those connections
which are detected only be virus tract tracing and non virus tract tracing methods the following filter must be
applied:
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Figure 7.92. Filter for virus tract tracing and non virus tract tracing methods.

The virus connectome matrix is shown below. In the "Info" window principal information of data selection is
shown.

Figure 7.93. A virus connectome.

22. Filtering of fixed regions
Regions can be fixed (they obtain an fixation index of 1) to filter these selected regions later on after adding all
efferent and/or afferent regions of the fixed regions (network embedding) . This can be performed on individual
regions or leafs of the hierarchy or by selection of multiple region in the local parameters table. In the following
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example all laminar subregions of the hippocampal and parahippocampal regions have been fixed. Then all efferent
regions and afferent regions should be added: right mouse click in the hierarchy window and selection of Add -
> Add neighbours of all leafs .

Figure 7.94. Preparation of adding new regions in dependence of an existing selection of
regions.

Then a list of all efferent and afferent regions is generated which can be further filtered.
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Figure 7.95. Filtered input and output regions of regions which have been selected before
and which appears as leafs in the hierarchy.

In order to add only those regions with more then 4 connections the list can be sorted by clicking on the "Edge
count" column and then select all regions with less then 5 edges (see following figure) and then click on "Remove
selected regions".
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Figure 7.96. Remove selected regions. The selected regions which have less then 5
connections are highlighted and can be removed after pressing the button "Remove
selected regions".

Furthermore the hierarchy depth to which the regions which should be added should belong can be adapted, then
all remaining regions should be added to the initial selection by clicking on "Accept". Then the Adjacency Matrix
looks as follows:
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Figure 7.97. All added efferent and afferent regions with more then 4 connections and
location at a level of hierarchy less than 16..

Now, all connection from fixed regions (intrinsic output to extrinsic region or intrinsic efferents to extrinsic re-
gions) can be filtered by applying e.g. the indirect edge filter in the upper right corner of the adjacency matrix.

After opening the filter table and right click with mouse in the table area click on "Create filter" and select "Filter
for fixed source or target nodes". In the following window selected if fixed regions should be sources or targets.
Select the new fitler row as shown in the following figure and click on "Apply filter".
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Figure 7.98. Filter all edges from intrinsic or fixed regions to non-fixed (extrinsic regions).

Then an adjacency matrix is computed which contains the output connections only from fixed regions.
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Figure 7.99. A presentation of all output connections (efferents) of fixed regions.

This kind of filtering can be applied to determine all regions which have connections to or get connections from
a network of interest (NOI) or a specified preselection of regions.

23. Randomization models and global network para-
meters

The tab "Global parameters" opens a table with 19 parameters and parameters estimations for the scale-free prop-
erty and the exponential distribution. All these parameters can be computed for 6 different types of surrogate net-
works with same number of nodes and edges as the real network that was build by the user, e.g., the bilateral basal
ganglia system. The rows of the table can be marked with the mouse and copied to a spreadsheet application.
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Figure 7.100. Global parameters table with the 6 types of randomizations. Below a
windows with result of a modularity computation is shown.

This analysis of global parameters shows the results of 1000 simulations of the directed bilateral basal ganglia
network consisting of 30 nodes and 332 edges. These 30 nodes and 332 edges are predetermined by the selection of
nodes to build the user defined basal ganglia network. This network has been simulated 1000 times using the Erdös
Renyi randomization and the average of each of the 19 parameters has been computed. Then 1000 simulations
using the Watts-Strogatz model (the #-parameter must lie between 0 and 1. A large β leads to a more uniform
randomization. A β of 0.2 is the default value) was performed (with 30 nodes and 332 edges). This has been
repeated with the Barabasi-Albert (#-parameter see above), the Eipert SF (#-parameter see above), the Ott-Hunt-
Ozik (OHO, J Ozik, BR Hunt, E Ott. Growing networks with geographical attachment preference: emergence of
small worlds. Phys Rev E Stat Nonlin Soft Matter Phys 69: 026108, 2004) and the rewiring models. The meaning
of parameters is listed in following. Notation (Rubinov M, Sporns O. Neuroimage 52: 2059-1069, 2010).

Models of randomization

The following random graph models are compared to the real network of the intrinsic amygdala connectivity. By
comparing the average path length and the cluster coefficient of the models with the real network it is feasible to
determine a model that is most similar to the real network.

1. Erdös Renyi graph

G(n, p) where n is the number of vertices and p is the probability that an edge (i, j) exists, for all i, j. The degree
distribution of the Erdös Renyi random graph is binominal in terms of

2. Watts-Strogatz graph

The small-world model of Watts-Strogatz is a random graph generation model that provides graphs with small-
world properties. The network (initially it has a non-random lattice structure) is build by linking each node to
its < k > closest neighbors using a rewiring probability p. Hence, an edge has the probability p that it will be
rewired as a random edge. The number of rewired links can be estimated by:

pE = pN < k > /2

3. Barabasi-Albert graph
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The Barabasi-Albert graph is used to generate preferential attachments between nodes. The probability pi that
the new node is connected to node i is

The degree distribution of a Barabasi-Albert network is scale free following the power law distribution of the
form:

4. Eipert graph

The modified Eipert model (EN: Eipert network) is based on the Barabasi-Albert graph. However, the algorithm
starts at a fixed number of nodes and edges are added iteratively.

5. Ozik-Hunt-Ott graph

The Ozik-Hunt-Ott model (OHO) (Ozik et al., 2004) is a small world randomization approach that was modified
for directed networks and a fixed number of edges. The OHO-model uses a growing mechanism in which all
connections are made locally to topographical nearby regions.

6. Rewiring graph

The rewiring-model connects each target of an edge of a network to another target node. The number of inputs
and outputs of each node in the rewiring is the same as in the real-world model.

Power law

∆ is the deviation (error) of an empirical distribution of degrees from the power law function. A small ∆ value
means that the empirical distribution is similar with the power law function.

Global parameters

1. N: set of all indices of nodes in the network (vertex = node).

2. L: set of all links in the network (link = edge = arc).

3. l: number of links in the network.

4. (i, j): a link between nodes i and j (i, j ∈ N).

5. aij: is the state of connection between node i and node j in the network. aij= 1 if link (i, j) exists; aij=0 otherwise
(aij=0 for all i).

6. Adjacency matrix A:
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1. Nodes: Number of nodes (vertexes, size of a graph) that represent neuroanatomical entities.

2. Edges: Number of directed connections in the network.

3. Self-references (o): Number of connections were source and target are identical.

Large o: Many self references occur in the network.

Small o: Few self references occur in the network.

Range: 0 (min) to number of nodes (max).

Type of measure: node.

4. Isolated nodes: Number of single nodes without connections.

5. Connected components: Number of networks that have internal connections, however, which are not connect-
ed with other networks.

6. Reciprocal edges: Mean number of reciprocal connections of the selected regions without self-references.

7. Average hierarchy depth: Mean level of all selected regions with regard to the root node of the hierarchy.

8. Average valency = average degree: Mean number of edges per node. The average directed neighbor degree
(deg) is

9. Heterogeneity (HVC): Coefficient of variation (V C) of the degreeall parameter.

If HVC = 0, all nodes have the same degree. The larger HVC the more diverse are the node degrees. In the
weighted case the versions of the degrees are used. The heterogeneity measure of Estrada (2010) was not
implemented because it is not defined for directed and weighted graphs.

10.Line density (Ld): Edge density in percent is the number of edges divides by the number of possible edges.
It is determined without self referencing edges.
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11.Diameter (Diam): Maximal path length between any pair of nodes. The diameter of a graph is the maximum
eccentricity of any vertex in the graph. That is, it is the greatest distance between any pair of vertices. To find
the diameter of a graph, first find the shortest path between each pair of vertices. The greatest length of any
of these paths is the diameter of the graph. A high graph diameter indicates that the nodes are very distant,
implying little graph compactness. Interpretation: Overall easiness of nodes to communicate or influence their
reciprocal function. Also a sign of functional convergence.

Diam = max{d(i, j)|d(i, j) < ∞}

12.Average path length: Mean of the distance matrix. The characteristic path length (L) is the same as the
average path length or the average distance and is also computed for an individual node i (Li). The sum of all
shortest paths between vertex couples divided by the total number of vertex couples. The average path length
can be regarded as a general parameter of graph compactness meaning that the overall tendency of nodes to
stay in proximity and an indicator of network navigability.

Interpretation: A high average distance indicates that the nodes are distant or disperse, implying little graph
compactness., vice versa, all nodes are in proximity and the graph is compact.

In the weighted case the distances d(i, j) are replaced by the weighted distances.

13.Average path length - Self-reference (Ls-#): Mean of the distance matrix without its diagonal for the directional
case:

14.Centrality CD: The number of links incident upon a node (i.e., the number of ties that a node has). The degree
can be interpreted in terms of the immediate risk of a node for catching whatever is flowing through the network
(such as a spike, or some information). This centrality (degree centrality) is defined for an undirected network
based on undirected degrees. A directed or weighted version is not available yet. For the calculation the directed
network is transferred to an undirected one.

15.Central point dominance (CDC):
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Where  is the maximum betweenness centrality. The directed and weighted
versions use the directed and weighted betweenness centralities.

16.Average directed degree deg

17.Average cluster coefficient C: A measure of local densely connected clusters within a network. The cluster
coefficient (Ci) for each node is calculated and then they are averaged. The cluster coefficient of a single node
is the number of its connections between all direct neighbors of a single node divided by the number of all
possible connection between the single node and its direct neighbors. The values are lying between 0 and 1.

18.Average flow coefficient (FC):

19.Small-worldness (S): This measure was introduced by Humpries and Gurney (2008). Small world networks
often have S > 1. C: Cluster coefficient, L: characteristic path length. The directed small-worldness (S#) has
been implemented in neuroVIISAS. If the Erdös Renyi (ER) Simulation is not explicitly exhibited by the user
by defining the number of iterations of the ER simulation then the ER simulation is performed one time, only
for computing Crand and Lrand. Hence, S will provide different values after pressing the Refresh button. To
obtain a meaningful value the ER simulation should be iterated 100-1000 times.

20.Modularity: The modularity measure M has been implemented according to Newman and Girvan (MEJ New-
man and M Girvan, Finding and evaluating community structure in networks, Phys Rev E 69, 2004). The
modularity measures the fraction of the edges in the network that connect vertexes of the same type (i.e., with-
in-community edges) minus the expected value of the same quantity in a network with the same community
divisions but random connections between the vertexes. Or with other words: Let M = {M1, ...,Mm} be a par-
tition of N. Mi is a group, module or cluster of vertices. With
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the fraction of edges that fall within group Mi ⊆ N and

the fraction of ends of edges that are attached to vertices in group Mi, the Modularity

whereby  is the fraction of edges that would connect vertices within group Mi if they were connected at
random. A large modularity implies that the fraction of edges that fall within groups is larger than expected
in the random case. The partition is generated by a “greedy” optimization algorithm. Starting with a partition
where every single node has its own group, stepwise those two groups are joined that increase Q most. The
algorithm ends if there are no more such groups. The weighted case is similar, only the aij are replaced by wij
and # is replaced by the sum of the edge weights

21.Transitivity = cluster coefficient: The transitivity (T) is a directed transitivity (T#). It is a quantity of directed
circles of length 3 divided by the number of possible circles referring to the neighbors of nodes.

Whereby tmax(i) = deg(i) ·(deg(i)#1)#2· rec(i) with deg(i) = number of adjacent edges of i and rec(i) = number
of reciprocal edges of i (the two directions of one reciprocal edge are considered as one reciprocal edge). The
degree deg and the reciprocity rec are defined as:

For the directed and weighted case:
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22.Global efficiency (GE): Is the sum of inverse values of the non zero non diagonal elements of the n x n
distance matrix divided by n(n-1). The average inverse shortest path length is the same as the global efficiency
(Latora and Marchiori, 2001), which is most commonly used as a measure of functional integration (Achard
and Bullmore, 2007).

The directed global efficiency GE→ and GE#w analog with d→(i, j) and d#w (i, j)

23.Harmonic mean HM=1/GE

The directed and weighted versions use the directed and weighted global efficiencies.

24.Vulnerability (V): The vulnerability V is the maximum relative decrease of the global efficiency removing
a single node.

Where GE(i) is the global efficiency of the graph (N\{i}, {(j, k) ∈ E | j 6= i 6= k}) that originates by removal
of node i and all edges adjacent to i. The weighted version is analog using the weighted global efficiencies.

25.Local efficiency (LE): The local efficiency indicates how strong neighbors of nodes are interconnected. For
each node i the inverse lengths of the shortest paths of the neighbors of i that are passing i are added. The local
efficiency is this sum divided by the maximal possible sum of paths between neighbors that are connected with
i. The efficiency of the network (global efficiency) is the average local efficiency of all nodes.

Directed local efficiency

Weighted directed local efficiency
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Whereby ni = |Ni| and djk(Ni), respectively, is the length of the shortest path between j and k that
contains only neighbors of i.

26.Cyclic network coefficient (CyclC→):The cyclic coefficient of the network is the average cyclic coefficient
of its nodes:

27.Directed assortivity coefficient (r#): This quantity was introduced by Newman (MEJ Newman Assortative
mixing in networks. Phys. Rev. Lett. 89, 208701 (2002)). It lies between -1 and 1. A positive value means that
the high-degree vertexes are more probably attached to other high degree-vertices and a negative value means
that high-degree vertexes are more probably attached to low-degree vertexes.

28.
Directed and weighted assortivity coefficient 

The correlation of the degrees of nodes that are connected: −1 ≤ r ≤ 1. Large positive values imply that nodes
are mainly connected to nodes with similar degrees. Large negative values imply that nodes with a large degree
are mainly to nodes that have a small degree. If r ≈ 0 there is no relation detectable.

A network possesses stronger or weaker scale-free properties. Networks that are scale-free have a degree distrib-
ution that follows the power law (fraction P(k) of nodes in the network having k connections to other nodes.

The values of α and γ are calculated and the deviation (error) ∆ from the theoretical power law distribution is
computed. If ∆ is small than the degree distribution lies close to the theoretical power law distribution of degrees.
The real bilateral basal ganglia network has a α of 0.09 and a γ of 0.03. The error ∆ is small: 2.3. In addition the
average cluster coefficient is relative small: 0.516. Considering both quantities the real network is scale-free and
follows the power law distribution. However, the degree distribution may follow an exponential distribution:
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This distribution is compared with the real network and the randomized networks and parameters α and γ and the
error ∆ are shown in the last row of the table. Beside the global modularity measure the modularities of nodes are
calculated and circular arranged. By moving the mouse over a node a tooltip with further information is opened:

Figure 7.101. Visualization of modularity. Tooltips are opened if the mouse is located on
a region circle.

24. Cycle counts
Circular connections may constitute an essential structural element of neuronal connectomes. It is possible to
calculate the number of cycles that are traveling through a particular region of the network. By clicking on the
tab "Cycle counts" it is asked how large should be the largest cycle. Large cycle (>8) occur much more often and
it could take much computation time to determine them. The processing time is indicated in the "Idle" bar at the
lower right corner of the undocked "Cycle count" window. A cycle size of 1 means a reciprocal connection.

Figure 7.102. The cycle count window. Values are sorted by the 3rd column.
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25. Motif analysis
Subgraphs or Motifs of networks can be analyzed after pressing the "Motifs" tab. Then the following view appears:

Figure 7.103. The main window of motif analysis.

Motifs can be build manually or automatically. By clicking with the right mouse key into the "Motif" frame choose
from the PopUp menu "Automatic Motif generation" and then 3 motifs without self-references. 13 motifs will be
generated and the Motif main window should look like this:

Figure 7.104. Motif windows with 13 directed 3 node motifs.

In the "Motifs" frame the 13 motifs are listed. The first one is shown by default in the "Canvas" window. The
isomorphic search results of each motif of the current network, e.g., the bilateral basal ganglia system are shown
in the "Search results" frame. The motifs in the "Motif frame can be clicked" and a graphical representation
will appear in the "Canvas" frame. The motif frequencies in the "Search Results" frame can be opened to obtain
information which reach contribute to particular motifs:
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Figure 7.105. The "Canvas" frame shows the most complex reciprocal 3-13 motif which
was opened in the "Motif" frame and in the "Search results" frame.

Furthermore, the appearance of each region in motifs is calculated after pressing the "Frequency of regions" button.
In the following example the 9364 5-node motifs have been calculated and the complete reciprocal motif that is
the last one in the list has been selected. Then a isomorphism search by clicking on "Search motifs" button has
been performed and a frequency of 44 has been determined. To obtain information about the contribution of the
selected regions of the network to the motif 9364 the following table is opened after clicking on " Frequency of
regions" button.

Figure 7.106. Frequency distribution of single regions in motifs.

Now the motifs distributions should be compared with different randomizations by clicking on the "Statistic
search" button. Then choose a randomization type and the number of randomization, (e.g., 100 or 1000). The
computation can be distributed on several CPUs and/or CPU core by adapting the "Thread count" parameter.
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Figure 7.107. Statistical motif analysis using 100 directed Ott-Hunt-Ozik randomizations.

The frequency of a motif in the real network is indicated by a filled blue circle. The single motif frequencies of the
100 randomizations are indicated with black points and the percentile of motif frequencies from randomization
with a red filled rectangle. The table is sortable by clicking on column headers and can be exported to spreadsheet
applications.

The meaning of columns are listed:

1. Number f1: Frequency of motif in graph.

2. Number f2: Frequency of motif in graph without repeated use of edges.

3. Number f3: Frequency of motif in graph without repeated use of nodes.

4. p-value: Probability that motif frequency in a random graph is greater than in the real graph (this p-value is
not a level of significance of a statistical test). Large value (1): Frequency of motif in random graph in the
randomization samples is larger than in original graph. Small value (0): Frequency of motif in random graph
is smaller (or equal) in the randomization samples than in original graph. A p of 0.05 means that in 5% of the
cases (total number of randomizations) the motif frequency was larger in the randomized networks.

5. z-value: (f1 - mean value) / standard deviation.

6. Mean value: Mean frequency of motif in randomizations.

To build a user defined motif first click on the "New" button and give the new motif a name. Then right mouse
click in the "Canvas" frame and set the node. Right click on a node a define a connection. Several user defined
motifs can be generated an stored for later usage.
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Figure 7.108. Using another selection of regions (143) with 1011 edges of the left
prosencephalon the circular 4 node motif was found 8 times through the regions shown
in the "Search results" frame.

The statistical analysis of this single motif provides the following results:

Figure 7.109. The frequency of the circular 4 node motif in 1000 Erdös Renyi
randomizations.

In 1000 Erdös Renyi randomizations the circular 4 node motif occurs statistically significant more (on average
407,779) often than in the real network (8 manifestations).

The frequency of participation of a particular region within a motif is calculated by clicking on the "Frequency
of regions" button:
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Figure 7.110. Computing of frequencies of a region in a specific motif. The caudate
putamen (CPu) participates 24 times in the motif 3-13 the fully reciprocally connected
motif. Frequency columns can be sorted.

26. Local parameters

The local parameters tabulator opens a table, the modularity window and the PCA analysis window. The compu-
tation of local parameters of the bilateral basal ganglia networks leads to the following table:

Figure 7.111. The table of local network parameters.

Each column is sortable by clicking on the column header and the column can be exported to a spreadsheet ap-
plication.

Parameters can be selected by clicking on the Settings symbol (gray rectangle at the upper right corner of the
parameter table):
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Figure 7.112. The parameter selection for the local parameter computation.

The calculation of weighted local parameters is done by clicking on "Weighted analysis" then the weighted local
parameters are computed:

Figure 7.113. Some weighted local parameters.

Local parameters produce a high-dimensional data space that can be visualized by applying a parallel coordinate
diagram;
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Figure 7.114. Parallel coordinate visualization of local parameters.

A right mouse click on the diagram opens a menu for export the diagram, for sorting the parameters by similarity
and switching on and off region names.

In the following basic definitions are shown that are used to further define in particular local parameters:

1. Node, vertex

The smallest subunit of a network. With regard to connectomes a node is a circumscribed or disjunctive region
that contains neuron perikarya (sources of physiological action potential) and/or axonal terminals (targets of
physiological action potentials).

2. Set of indexed nodes

The set of all indices of nodes is N={1, 2, 3, ... n}

3. Number of nodes

The number of nodes (regions, vertices) is n=|N|

4. Edge

A directed edge (i, j) ∈ N ×N is the line that connects vertices i and j with source i and target j. The set of
directed edges E is E ⊆ N × N

5. Edges

The number of edges (connections, links) # is # = |E|
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6. Set of edges

The set of all not self-referencing edges is # = |L|

7. Graph

G = (N,E)

8. Adjacency matrix

The adjacency matrix (connectivity matrix) A is

9. Weighted matrix

The weighted matrix W is

whereby wij is the weight of the edge (i, j) that connects i and j. 0 ≤ wij ≤ 1.

10.Path

A sequence of vertices (v1, ...vk) is a path from (v1 to vk) if ∀i ∈ {1, ..., k − 1} : (vi, vi+1) ∈ E. The length
of a path v1, ..., vk is k − 1.

11.Distance matrix

The distance matrix D is

where

12.Degree all

Self-references of nodes are not considered for all three degree measures. deg(i) = degall(i)

13.Degree out
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14.Degree in

15.Neighborhoods

Out-neighbors of i:

In-neighbors of i:

All neighbors of i:

The meaning of parameters is given in the following list:

1. Index: the index of the region starting with 1, the first region or most left located region in the hierarchy of
selected leafs.

2. Name: Long name of the region.

3. Fixated: Indication if region has been fixed to prevent extension when the hierarchy should be interactively
expanded.

4. Hierarchical level (HD): Level of a region in the hierarchy or distance from the root node.

5. Reciprocity (REC): number of reciprocal connections of a region without self-references.

6. Degree all (DGall(i)): Input and output or afferent and efferent connections of a region. See definition of Degree
all.

7. Degree out (DGout(i)): Output or efferent connections of a region. See definition of Degree out.

8. Degree in (DGin(i)): Input or afferent connections of a region. See definition of Degree in.

9. Convergence divergence coefficient (CDC): degree in divided by degree out.
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10.Laterality all (LatAll): Number of ipsilateral connections of a region divided by its degree all. In the weighted
case the sum of weights is applied.

11.Laterality out (LatOut): Number of ipsilateral output connections of a region divided by its degree out. In the
weighted case the sum of output weights is applied.

12.Laterality in (LatIn): Number of ipsilateral input connections of a region divided by its degree in. In the weight-
ed case the sum of input weights is applied.

13.Laterality reciprocal (LatRec): Number of ipsilateral reciprocal edges of a region divided by the number of all
(ipsi and contra) reciprocal edges of this region.

14.Katz: Katz index or Katz status index or alpha centrality is a measure for the direct and indirect input of a
node.. Sum of direct and indirect input of a node weighted with α

k (k: pathlength of input, α: between 0 and the
reciprocal of the biggest absolute Eigenvalue of the adjacency matrix). Values are normalized by the quadratic
mean of the quotients Indegrees/Katz Status Index.

The attenuation factor α has to be smaller than the reciprocal of the absolute value of the largest eigenvalue of
A. For a better readability and comparability of the results, in neuroVIISAS the Katz centrality is multiplied

by the mean of the quotient  of all nodes with CKatz(i) > 0. Hence, the values lie in the same range
as the indegrees

15.Number of triangles

The maximum number of possible triangles that can be deviated from a complete reciprocal triangle is 8.

16.Number of weighted triangles

Instead of the sum of triangles (t→(i)) the sum of geometric means of edge weights of each triangle is calculated.
The following example provides (wij · wjk · wik)# as the summand:

17.Circle length (LC(i)): Length of the shortest path to the node itself. If the path does not exist: 0.
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18.Undirected cyclic coefficient (CyclC): The undirected cyclic coefficient as published by (Kim et al. 2005)
Cyclic topology in complex networks.

With

19.Directed cyclic coefficient (CyclC→): A publication about the directed cyclic coefficient is unknown. The
directed cyclic coefficient is implemented here as follows:

20.
Directed weighted cyclic coefficient :

A publication about the directed weighted cyclic coefficient is unknown. The directed weighted cyclic coeffi-
cient is implemented here as follows:

with  is the weighted version of disti(j, k) with the weighted path length.

21.Eccentricity out (EccOut): It is the output eccentricity and can be interpreted as the maximum output distance
from the current node i to any other or in other words: Eccentricity out is the output eccentricity of the vertex i
is the maximum distance from i to any vertex. Interpretation: Easiness of a node i to be functionally reached by
exactly those node that receive inputs from node i. Type: node centrality index. Eccout(i) = max{d(i, j) | j ∈ N}

22.Eccentricity input (EccIn): It is the input eccentricity is the maximum output distance from the current node i
to any other or in another words: Eccentricity in, the input eccentricity of the vertex i is the maximum distance
from i to any vertex. Interpretation: Easiness of a node i to be functionally reached by exactly those node that
have connections to node i. Type: node centrality index. Eccin(i) = max{d(j, i) | j ∈ N}

23.Cluster coefficient out (CluCOut): Directed output cluster coefficient is the edge count between Output neigh-
bors / Largest possible number of neighbors.
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24.Cluster coefficient in (CluCIn): Directed input cluster coefficient is the edge count between Input neighbors /
Largest possible number of neighbors.

25.Cluster coefficient all (CluCAll): The directed output and input cluster coefficient is the edge count of all
neighbors divided by the largest possible number of neighbors. In the weighted case the aij are replaced by
the wij .

26.Cluster coefficient triangle based (CluCTriag): The triangle based cluster coefficient (Fagiolo, 2007) of a node
n is the number of triangles around n divided by the maximum possible number. In this version of the cluster
coefficient reciprocal edges to a neighbor of a node n can affect the cluster coefficient of node n. In the other
version only edges between neighbors of n have an influence to the cluster coefficient of node n.

27.Cluster coefficient of second neighbors (CLuC2): The cluster coefficient of second neighbors (Hierarchical
directed cluster coefficient of second (indirect) neighbors) CLuC2(i) is the number of edges between the 2nd
neighbors of node i, divided by the maximum possible number of edges. In the weighted case it is the sum of
weights of the edges between the 2nd neighbors of node i, divided by the maximum possible sum. With

the set of second neighbors of node i is:

In the weighted case the aij are replaced by wij .

28.Average neighbor degree (degNB(i)): The non-weighted average neighbor degree NB(i) of node i is
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29.Weighted average neighbor degree:

30.Variation coefficient of neighbor degree (VCDG(i)).

The weighted case is analogue.

31.Locality of node i (Loc(i)). The locality index of node i is the fraction of edges adjacent to nodes in Ni# whose
source and target lie in Ni# .

The weighted case is analogue. A value of 0 means that the node is isolated. The larger the value, the less edges
connect the neighborhood of i to outside node. The maximum of one is reached if the neighborhood of i is not
connected to outside nodes.

32.Closeness centrality out (CCOut): Closeness centrality of outdegrees of node i (CCOut(i)). Reciprocal average
distance to all reachable nodes (Out). Interpretation: Probability to be functionally relevant for other nodes of
the network that are connected receive (these are the input nodes to node i) connections from node i. Type:
centrality measure; node centrality index. The following expression defines the indices of those nodes from
which node i can be reached:

33.Closeness centrality in (CCIn). Reciprocal average distance to all reachable nodes (In). Interpretation: Proba-
bility to be functionally relevant for other nodes of the network that are connected to (these are the input nodes
to node i) node i. Type: centrality measure; node centrality index. The following expression defines the indices
of those nodes which can be reached from node i:
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34.Betweenness centrality (BC(i)): Number of shortest paths from node i to node j by passing node k divided by
the number of shortest paths from node a to node b (including paths from a to a).

Where ρj,k is the number of shortest paths from j to k and ρj,k(i) is the number of shortest paths from j to k that
pass through i. The directed and weighted definitions are the same.

35.Eigenvector centrality (EC) was introduced 1972 by Phillip Bonacich (Factoring and weighting approaches to
status scores and clique identification. Journal Mathematical Sociology 2: 113-120). The eigenvector centrality
EC(i) is the i-th component of the eigenvector with the largest corresponding eigenvalue of the adjacency matrix
resp. weight matrix. The largest eigenvalue of the adjacency matrix A of graph G has to be determined. λ

m is
the largest eigenvalue and xm the corresponding eigenvector solving the equation

The Eigenvector centrality should be considered only, if all nodes are connected at least with all nodes.

Interpretation: An important node is connected to important neighbors.

Type: point centrality measure.

36.Subgraph centrality (SC) is the value of diagonal elements of the communicability matrix.

The subgraph centrality of the network is the average subgraph centrality of its nodes.
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37.Page rank centrality (PRC(i)) with damping factor 0.85 and initial page rank probability 1/n. PRC(i) = ri
where r is the solution of the linear system

with the damping factor α = 0.85, the identity matrix I and the diagonal matrix B, whereby

In the weighted case the weight matrix W is used instead of A and the weighted version  of the
outdegree.

38.Flow coefficient (FC) is calculated as the number of actual paths of length 2 divided by the number of all possi-
ble paths of length 2 that traverse a central node (Honey CJ, Kötter R, Breakspear M, Sporns O (2007) Network
structure of cerebral cortex shapes functional connectivity and multiple time scales. PNAS 104: 10240-10245).
Number of paths of length 2 between neighbors of a node i that pass node i divided by the maximum possible
numbers of sub paths.

In the weighted case we define the flow coefficient as the sum of weights of paths of length 2 between neighbors
of a node i that pass node i divided by the maximum possible sum.

39.Stress (S): Number of shortest path through the current node. Can indicate the relevance of a protein as func-
tionally capable of holding together

communicating nodes. Type: centrality measure.
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The directed and weighted definitions are the same.

40.Shapley rating (SR(i)): The Shapley rating is a measure that provides information about the loss of connectivity
following the removal of a node. (Kötter 2007). Because it is a sum of the differences of connected components,
negative values occur. The components that are connected with a region are subtracted by the components that
are not connected with a region.

Where SCC( ˆN ) is the set of strongly connected components of ˆN. The smaller the value is, the more impor-
tant is the node in the sense of connectivity of the graph. Because of the exponential number of subsets, this
parameter can be approximated for large networks, only.

41.Z-score of outdegrees (ZOut), indegrees (ZIn), outdegrees and indegrees (ZAll). Similar values could indicate
similar roles. The Z-score is calculated as proposed by Guimera and Amaral (2005). Let Mi be the module
containing node i. degx(i,Mi) x ∈ {in, out, all} is defined in the participation coefficient. Similar values could
indicate similar roles.

is the mean and

the standard deviation of the within module Mi degree distribution. Then the z-score is defined as

and analogous

with the weighted versions of the mean and standard deviation. A value above one or below minus one implies
that a node has significantly more or less edges from, to or from and to nodes in its cluster than the average
node in its cluster has.

42.Partition coefficient of outdegrees (PCOut). The partition M = {M1, ...Mm} is generated as described in the
definition of modularity. (Guimera, Amaral 2005).



Connectivity analysis

194

with x ∈ {in, out, all} and

(Number of edges from i to vertices of Mj).

43.Partition coefficient of indegrees (PCIn). (Guimera, Amaral 2005).

(Number of edges from vertices of Mj to i).

44.Partition coefficient of in- and outdegrees (PCAll). (Guimera, Amaral 2005).

(Number of edges between i and vertices of Mj).

with the same x and weighted definitions of degrees. One has 0 ≤ PC(i) ≤ 1. If PC(i) = 1, the node i has no
edges (in, out, all). If PC(i) = 0 all edges (in, out all) come from, go to or stay in the same cluster. The larger
PC(i) the more clusters are involved in the edges of node i.

45.Input radiality (RadIn): The radiality of a node Rad is a measure of the distance of a node to all other nodes.
Nodes that have a small radiality have larger distances to other nodes than those with a greater radiality. Pe-
ripheral nodes have smaller and central nodes have larger values. Diam: Diameter of the graph.

In the weighted case the weighted distances are used.

46.Output radiality (RadOut)
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In the weighted case the weighted distances are used.

47.Output centroid value of a node (CenOut): With gout(i, j) = |{k ∈ N | d(i, k) < d(j, k) < ∞}| and gin(i, j) = |{k

∈ N | d(k, i) < d(k, j) < ∞}| which are the number of nodes closer to node i than to node j with regard to In-
and Out-distance, the centroid value is defined in the following.

Cenout(i) = min{gout(i, j) − gout(j, i) | j ∈ N \ { i}}

48.Input centroid value of a node (CenIn):

Cenin(i) = min{gin(i, j) − gin(j, i) | j ∈ N \ { i}}

In the weighted case the weighted distances are used. A value < 0 implies, that there exists a node that is closer
to most other nodes. A value ≥ 0 implies, that this node is most central in the network. A value = 0 implies,
that there are more than one most central nodes.

49.Hub: Hubs and authority can be defined recursively. Hub nodes are pointing to nodes that have a large authority
and authority nodes are pointing to nodes that have a large hubness. Hubs are pointing to nodes that have
many inputs ("information collectors", "convergent nodes"). if a node has a large hubness then it have man
connections to nodes that have large authorities. Hubs are bridges between different communities of nodes:
they have small cluster coefficients and large flow coefficients.

50.Authority: a node that have a large authority is pointing to nodes that have many output connections or that
have a large hubness.

51.

To obtain a network that contains only regions that have at least one input and one output (condensed network)
the local parameter table can be sorted first DG Out column and then mark all values that are zero and click on
the button "Remove selected regions". Maybe this must be repeated several times. The same procedure has to be
performed for the DG In column.

Correlation coefficients of the local parameters are calculated by checkmarking "Show correlation coefficients"
and clicking on the "Refresh" button.

Figure 7.115. Correlation coefficients of local parameters.

27. K-cores and S-cores analysis
A k-core is a maximal subset of vertices such that each is connected to at least k others in the subset. k-cores
can not overlap. The result of a k-core computation is the set of all k-cores in a network. Subsets are visualized
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by concentric circles. The region(s) in the outer circle are those which have the lowest number of connections or
no connections. The smallest circle in the middle contains regions with the largest number of connections. The
algorithms removes iteratively regions and all their connections from the set beginning with the regions which
have the smallest number of connections.

Figure 7.116. K-core of a set of selected regions.

The weighted version of the core analysis is the s-core analysis. The sum of weights is used by the same algorithm
as used for the k-core computation. The step-width for the weighted subsets has to be defined before. In the figure
below stepsize 0.5, 1.0, 2.0 and 3.0 was applied.
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Figure 7.117. S-core with parameters 0.5, 1, 2 and 3 for each window.

28. Vulnerability analysis

The changes of the network structure following the deletion of a region or a connection can be computed. Here
the average closeness is used to indicate positive (average closeness decreases) and negative changes (average
closeness increase, e.g. in the case of the removal of an isolated node that have inputs or outputs only) after
removing a node.
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Figure 7.118. The average closeness decrease for 4.353% if the ventro anterior thalamic
nucleus is removed. The mean node and edge vulnerability is indicated below the table.

Figure 7.119. The vulnerability matrix display the change of the closeness of the network
if a particular edge is removed.
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29. Rich-club coefficient (Rich club phenomenon)

The rich-club coefficient phi is the ratio, for every degree k, of the number of actual to the number of potential
edges for nodes with degree greater than k. (Julian J. McAuley, Luciano da Fontoura Costa, and Tibério S. Caetano,
“The rich-club phenomenon across complex network hierarchies”, Applied Physics Letters Vol 91 Issue 8). The
rich-club coefficient can be computed for each occurring degree of edges of a network in the Advanced network
analysis window by selecting the corresponding tab "Rich-club coefficient".

In the following the major steps of determining and visualizing rich-club regions are described.

1. Calculate the table of rich-club coefficients (Click on "Rich-club coefficient tab" and then the "Refresh" bottom).

2. Now you must define your rich-club (it is not automatically computed!) in the following way: Decide which
coefficient should be a convenient threshold (e.g. if coefficients are between 0.5 and 1 you may consider only
those regions with more connections than 21 (Degree k=21) which corresponds to a coefficient of 0.82. So, the
threshold is 0.82 and the corresponding "Degree k" is 21.

3. Now switch to the "Local parameters tab" and press "Refresh" bottom.

4. Sort the "Degree all" parameter by clicking two times on the DG_All column header then the regions are sorted
in descending order by the DG-All parameter. All regions / nodes larger than Degree_ALL 21 belong to the rich-
club that you have defined.

5. If you like to visualize rich-club members and other nodes as well as their connections you can do the follow-
ing: Select the rows (hold shift key and select the last row larger than 21 "Degree k"). Then the rows should be
highlighted in blue indicating that they have been selected.

6. Now select "Other" from the menu issues at the top of the "Advanced connectivity analysis" window and select
"Selected nodes and neighbors in circle view".

7. The new windows offers different possibilities to visualize your selection. Don't forget to press the refresh
bottom after changing checkmarks. (Slide bars are used for changing size of circles and region abbreviations). By
clicking on the background you will see color coded (black) connections of the regions that belong to the rich-
club (having degrees > 21), yellow connection of direct connections of rich-club members to other regions and
blue connections are connections between other regions. The selected nodes (rich-club members) are arranged in
the inner circle or lower arc and the remaining nodes are shown in the outer circles or outer arces ordered by the
degree of the neighborhood. Furthermore, you can hide connections within or between layers of nodes by pressing
the right mouse bottom (unselect checkboxes in the popup-menu).
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Figure 7.120. The rich-club coefficients for the degrees of edges of a network.

The rich-club coefficient is also computed for 1000 rewiring simulations:

Figure 7.121. Rich-club coefficient using 1000 rewiring randomizations.
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A significant difference of the rich-club coefficient of the real network to 1000 rewiring simulation can be esti-
mated by subtracting the standard deviation from the "phi(k) 1000 randomization" and adding (2 sided). If the re-
sulting deviation does not reach the rich-club coefficient of the real network then it can be considered as significant
different from the randomized networks. Now a threshold of e.g. rank > 28 in dependence of the rich-club coeffi-
cient can be determined and regions of the local parameter table having a degree all larger than 28 can be selected:

Figure 7.122. Selected regions with degree all larger than 28.

Now the relation of the high lighted regions which belong to the rich-club can be visualized with regard to all other
regions of the network (rich club regions, feeder regions from first neighbors, local regions from 2nd neighbors;
Collin et al. 2013): Other -> Selected nodes and neighbors in circle view.
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Figure 7.123. Half-circle visualization of regions belonging to the rich-club (lower half-
circle).

The rich-club coefficient table can be exported by Ctrl+C and imported into a spreadsheet application to get a
diagram of rich-club coefficients in dependence of ranks:



Connectivity analysis

203

Figure 7.124. Rich-club distribution in an external spreadsheet application.

30. Visualization of local parameters

Those regions of the network which were traced before can be visualized in 3D and the local parameters are
displayed in 3D. Firstly, it is necessary to compute the local parameters by clicking on the "Local parameters"
tab. Then the 3D view must be opened by clicking on "Hierarchy panels" -> "3D-View". Click in the 3D view
with the right mouse button to open a menu and select "Show local parameters" and select, e.g., "Shapley" (small/
negative Shapley rates indicate a great importance of a region in a network. The visualization is computed and
may look like this:
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Figure 7.125. Local parameter visualization: the Shapley rates has bee selected.

A classification of Shapley values into 7 classes is shown. The smallest Shapley value was determined for the
caudate putamen complex because it very strongly connected (and therefore is most important for the network). By
clicking on the caudate putamen row in the local parameter table the caudate putamen is automatically highlighted
in the hierarchy view (lower left corner). Because the Shapley value of the caudate putamen is relative small the
font is zoomed down to visualize the local parameter quantities. Those regions which are selected for the network
have to bars in the hierarchy view: the first indicates the color and the second the quantity of the local parameter.

31. Principal component analysis of local parameters

Principal component analysis (PCA) of particular local parameters has been proposed by Echtermeyer et al. (2011)
(C. Echtermeyer, L. da Fontoura Costa, F.A. Rodrigues, M. Kaiser. Automatic Network Fingerprinting through
Single-Node Motifs. PlosOne. 6 components (local parameters) are used for PCA: DG all, AvgDG nb, CluC All,
CluC 2, VC DG, Loc. The PCA is performed automatically within the calculation of local parameters and results
are displayed in the following window:
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Figure 7.126. APCA analysis window.

A right mouse click on the table allows to export the table in csv format. A right mouse click on the PCA-plane
or the circular layout offers image exports (eps, png etc.). Edges in the circular layout are color coded: yellow
edges indicate connections of direct neighbors of the node in the center. Turquois edges indicate connections (to
direct nodes or indirect nodes) of indirect neighbours of the node in the center. Blue edges indicate connections
of the node in the center.

The PCA can also be performed by user defined combinations of local parameters by opening the parameter
selection menu and marking those parameters that should be applied to PCA:
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Figure 7.127. Parameter selection for the PCA analysis.

The two strongest contributions of variables to the first and second component are shown in the "Share" column
of the table. The contribution of variables in percent is displayed. The first component (e.g., DG All = 0.429 and
Share=75,053%) is represented by the x axis and the second component (e.g., DG All= -0,362 and Share=13,201%)
is assigned to the y axis. "Share" is the percentage of the variance of a component of the total variance. Here, the
variance can be interpreted as a measure of information content. The two axes that possess the largest variance
are used to dispose the regions in the PCA-plane. The gray values of the background of the image with circles and
names of regions show the probability for a node to lie in this area (light values: high probability, dark values:
low probability) The x-axis is most influence by the locality index (Loc) and the two cluster coefficients due to
the fact that the normalized degrees have a small absolute value and the VC DG has a small variance. By clicking
on the central circle AGl the motif is displayed in circular graph layout.
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Figure 7.128. Caudate putamen complex (CPU) network relations after PCA.

CPu has been selected by a left mouse click then it is surrounded by a green circle. CPu circle (first ring) is put in
the middle of the circular graph layout. The regions of the outer ring (second

neighbors of the CPu) are strongly connected. The second neighbors of the outer ring are weaker connected to
first neighbors of CPu in the inner ring.

Figure 7.129. Ventromedial thalamic nucleus (VM) network relations after PCA

The 2nd neighbors of the VM in the outer ring have three times more connections between the inner and outer
ring than inside the inner ring. This can be visualized by clicking on one region within a ring: then the connection
from this particular region will be highlighted.
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Figure 7.130. Lateral globus pallidus (LGP) network relations after PCA.

The first neighbors of LGP are stronger connected under themselves than with 2nd neighbors of LGP.

Figure 7.131. Parafascicular thalamic nucleus (PF) network relations after PCA.

The first neighbors of PF are strongly connected with the second neighbors of PF but less to other first neighbors
of PF.

32. Metric Multidimensional scaling
MDS calculates the differences of connections of regions. If the difference of connections of two regions is small
then the regions are closely positioned to each other in the MDS diagram. The Hamming distance (L1 norm) of
binary vectors of outputs and inputs to all connected regions is used as a distance measure. In comparison to non-
metric multidimensional scaling (NMDS) where ranks or orders of regions are considered MDS has the advantage
to work with distance information.
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Figure 7.132. MDS of regions belonging to the basal ganglia circuits. CPu and MGP
are closely related to each other because they do not have large differences of their
connections.

33. Hierarchical cluster analysis
Methods of hierarchical cluster analysis can be used to compute clusters of a region lists. Here, the macaque71
dataset of the macaque brain has been used. Based on a list of regions a new variantclass must be build which
contains all regions of the original list of regions that should be clustered. Then cluster analysis can be applied to
this variant. The data has been imported into neuroVIISAS and a project file has been saved. Within the project a
new variantclass has to be build by a right mouse click on "Variantclasses in the tabulator window "Variants" of
the main window. The new variantclass is defined after clicking on "Create new Variantclass".

Figure 7.133. Defining a new variantclass to prepare hierarchical cluster analysis.
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Within the Variant the name "hiera1" is assigned and then the definition need to be accepted by clicking on
"Accept":

Figure 7.134. Definition of the variantclass.

After accepting the definition the following dialogue may appear, where "Yes" should be selected:

Figure 7.135. Accepting the root of the regions in the data container.
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Now a new variant within the variantclass "hiera1" can be defined by selecting "Create new variant from contain-
er":

Figure 7.136. The new variant has to be build.

Now the variant must be selected:

Figure 7.137. Selection of the new variant.

By selecting "Analysis" menu in the main window and clicking on "Advanced connectivity analysis" the advanced
analysis window will be opened. After pressing the "+" key the "hierarchy" (list of depth 1) will be expanded
as shown:
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Figure 7.138. The adjacency matrix and list of regions in the triangle visualization of the
macaque connectivity dataset.

Clicking of "Others" and "Hierarchical clustering" opens the hierarchical clustering dialogue (see last figure). The
hierarchical cluster analysis generates a clustering of regions depending on their connections. This new clustering
is displayed in the main window (not at this step in the "Advanced connectivity analysis" window).

Figure 7.139. The result of region clustering using hierarchical modularity analysis is
shown in the region frame.

If the frame with the clustering result is active (light background) then the connectivity analysis functions of the
"Advanced connectivity analysis" window will be applied to the clustering result:
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Figure 7.140. The clustering result after expanding the triangle hierarchy by pressing "+"
and the resulting adjacency matrix.

There are several options available to perform hierarchical clustering:

1. Merging clusters with minimum distance of their gravity centers

2. Merging clusters with minimum distance of two contained regions

The "gravity centers" and the "two region" method can be applied to the "connectivity matching out", "connectivity
matching in" and "connectivity matching all" measures. A further clustering method is the hierarchical modularity
clustering and the Girvan-Newman method. The latter, is based on betweenness calculation of all edges. Then
the edge with the highest betweenness is removed and the betweenness of all edges affected by the removal is
recalculated. These steps are repeated until no edge remain.

Directed modularity clustering

This method is based on the paper of Leicht and Newman (2008, Community in structure in directed networks).
It is computed as a global parameter, within the modularity analysis and within hierarchical clustering.

Connectivity pattern clustering

To determine regions that build groups of similar connections the following clustering method can be applied.
After defining a variant of the hierarchy open the Advances analysis window and select all regions that should be
clustered. Then select "Other" and "hierarchical clustering". Choose the clustering method "Connectivity pattern
clustering":
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Figure 7.141. Connectivity pattern clustering window.

The goal of the "Connectivity pattern clustering" is to assign the regions to a given number of cluster in a way, that
regions of one cluster are similiar in their connection pattern referring to the clusters. That means, two regions of
a cluster have a similar amount of output connections to regions of cluster1, a similar amount of input connections
from regions of cluster1 and so on for each cluster. The clusters are denoted as "Layer".

Define the number of expected clusters. For example, 6 layers of the cerebral cortex or 10 layers of the spinal cord
or 3 layers of the allocortical regions or 7 layers of the olfactory cortex.

The "same layer" option shows the clustering in the above described way.

The second option "different layers" first calculates the clustering in the described way assigning the regions to the
"Layers", but than rearrages the regions in a way that all regions of one "Layer" are distributed to different clusters.
So in each cluster is maximal one region of one "Layer". The distribution to the clusters is choosen that way, that
the number of edges inside the clusters is maximized. The value "Minimum size of layer relative to the average
size" controles how equal the sizes of the "Layer" will be. The maximal value 1 means, that all "Layers" should
contain, as precisely as possible, the same number of nodes. Lower values allow "Layers" to become smaller than
the average size, so that other "Layers" get bigger. The option "Analyze region frequency" counts the occurrences
of regions containing a special character string followed by an underline and a number and shows the frequencies
in a table.

The number of connections of an original layer of a topographic regions within a cluster is written to a table that
appears after computing:

Figure 7.142. Frequency of connections of a region within a cluster.
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The adjacency matrix of a cortical connectome before clustering shows the original arrangement of cortical layers
subdivided by regions and within regions by cortical layers.

Figure 7.143. Original adjacency matrix of direct connections.

After computing and opening a new "Advanced connectivity analysis" window the clusters have been selected:
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Figure 7.144. ThThe connectivity pattern within each of the 7 clusters is stronger than
to other clusters,

The result can be interpreted as an maximization of connections between clusters of cortical layers (different
father (topographic brain region) region with same cortical layers). Or with other words a "thick layer" regional
rearrangment has been computed.

The clustering result after playing the "different layers" method:
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Figure 7.145. Connectivity patterns after applying the "different layers" method.

The result can be interpreted as an maximization of connections between cortical layers within a cluster (same
father (topographic brain region) region with different cortical layers). Or with other words a "thick column"
regional rearrangement has been computed.

The Markov Cluster Algorithm (MCL) is an unsupervised clustering technique for graphs (Van Dongen, S. (2000)
Graph Clustering by Flow Simulation. PhD Thesis, University of Utrecht, The Netherlands. http://micans.org/
mcl/). Random walks on the graph are evaluated to detect those nodes where walks flows together.

The meanings of parameters are as follows (matrix values are normalized between 0 and 1):

"Maximum value considered zero (>=0)" (Default:1.0E-7): Test if matrix values are zero. Values below this thresh-
old are set to zero (convergence can be faster).

"Maximum difference between values (>=0)" (Default: 1.0E-7): If difference of two values are below the threshold
then they are considered as equal (termination of computing)

"Loop gain (>=0)" (Default: 0): Probability for considering a connection on the diagonal. If values > 0 then con-
nectivity loops or selfconnections are used. If 0.5 is set as a loop gain, then each value on the diagonal is set to 0.5.

"Inflation exponent" (Default: 2.0): Exponent for adjacency matrix. Exponent is iteratively applied matrix ele-
ments.

34. Diagrams of local parameters
Any local parameter can be defined as an x- or an y-coordinate to visualize dependencies and frequency distribu-
tions. Before using the diagrams the local parameters must be computed.
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Figure 7.146. The Shapley rates are assigned to y coordinates (dependent variable) and
the DG All variable to x values (independent variable).

Projects may require a standardized view of different diagrams. By clicking on the dark gray button at thee upper
right corner of the diagram view the number of diagrams can be determined.

Figure 7.147. Definition of a diagram panel.

35. Pathway analysis

By clicking on "Other" and "Find path" the following window will be opened.
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Figure 7.148. The "Find path" window.

Now, a source node has to be specified by clicking on the "Source" button, e.g., "cpu" in the "Short name" filed
and press ENTER. Then the target node must be specified, e.g., pg (pontine gray). The search that is apllied is
the "Shortest ways" mode. Search will be executed after pressing "Find path". A scrolable list of possible paths is
generated and the paths with level of hierarchy are shown in the right subwindow.

Figure 7.149. The first found path is highlighted. It crossed 2 time the hierarchy from level
11 to 10 and from 10 to 11. Therefore, a "2" is shown in the column "Hierarchy levels".
The "Path length" is 2 because two edges are necessary to realize the path from CPu to
PG. Edge weight is indicated by colors as defined before and the number of authors that
have described the particular connection is displayed, too.

The next mode "Maximum path length" allows to specify the maximal pathlength, e.g., 3. After search has been
performed the table contains 278 possible paths of the length from 2 to 3 edges. Paths are sorted first by "Path
length" and secondary by "Average weight" to obtain the shortest apths with largest average weight for each group
of path length first.
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Figure 7.150. The 3-edges pathway with lowest level corssings and largest average weight
from CPu to PG.

The next mode allows jumps in the hierarchy (pathway can be resumed from an upper or lower level of a region)
and can be combined with the option "Maximum path length". This mode is performed in parallel (threads) using
all cores of a machine because many alternative pathways (here: 1179) in a large set of possible pathways have
to be analyzed.

Figure 7.151. A region can be selected to indicate its connections (dashed lines) and by
electing an edges information is provided in a tooltip. The hierarchical organization of
subregions is displayed by thin black lines.

The frequency of regions contained in the list of found paths is displayed in a table that is opened after clicking
on the "Frequency of regions" Tab.
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Figure 7.152. The table displaying the frequency of regions in pathway need to be updated
before results are shown. In this case the "Lateral_hypothalamisc_area_L" is involved in
88 different paths of length 3.

The frequency of edges is shown in the following table:

Figure 7.153. The edge between the CPu_L to the LHAa_L, LH_L and TuLH_L is used
most often in pathways of the length 3.

To reconstruct a circuit, the source and target region can be the same. Further regions that should occur in the
pathway can be added to proofe if acertain pathay exists.
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Figure 7.154. The indirect basalganglia path through predefined regions has an average
weight of 1.5 and passes 14 levels of the hierarchy.

Exploring the pathways can be done by defining the source, e.g., caudate putmanen and the source pontine gray,
then define the maximum length of pathways. Then the results can be sorted (sorting is performed first by the path
length automatically lollowed by sorting the average weight after clicking on the "Sort" button).

Figure 7.155. 279 alternative pathways from caudate putamen to the pontine gray have
been found.

By selecting "Frequency of regions" the frequency of regions in the detected pathways are calculated. Zona incerta,
the lateral hypothalamic area and the medial agranular prefronatal cortex occured most often in the 279 pathways.
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Figure 7.156. The frequency of regions (within the 279 found pathways) after sorting
(clicking on column header "Path length: 3").

The frequencies of path sequences is calculated in the "Path sequence frequencies" table.
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Figure 7.157. The pathway segment AGm->PG occurs in 28 different pathways from all
279 determined pathways.

36. Project analysis

To obtain a quantitative overview of a neuroVIISAS project Analysis -> Project statistics can be selected (the
calculation may take some time related to the size of a project (30 MB project without rendered data my take 10
seconds). Then the following list of tables is calculated:
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Figure 7.158. Part 1 of the project analysis.

Figure 7.159. Part 2 of the project analysis.
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The results of a evaluation of a whole project is displayed. A few regions with the largest number of direct con-
nections of the ipsi- and contralateral hemisphere are presented (no connection of subtrees are considered here
(indirect connections)). In the last table, regions are shown which have a contour, however, no connections. This
table could be useful for atlas based connectome analysis because it provides an overview of all those regions
which are explicitely defined in an atlas, however, of which connection are unknown, so far.
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Chapter 8. Simulations
Simulations can be defined, scripts can be generated and results can be visualized on Windows and Linux instal-
lations of neuroVIISAS. However, to let the generated PyNEST scripts run an installed NEST version on a Linux
machine is necessary. So far, neuroVIISAS allows the usage of the multicompartment model and topology module
of NEST. The simulation interface is opened by clicking on the "Simulation" tab in the "Advanced connectivity
analysis" window. NEST must be downloaded from the NEST webpage, then the following installation steps in
the directory where NEST has been unpacked are necessary:

Configure installation: ./configure - -prefix=/usr

Compile: make

Change to root: su

Install: make install

Test: python import nest

Test : nest - -version

After updating NEST it could be possible to update numpy, matplotlib by YAST2 , or install TK backend by
YAST2.

For a first installation of NEST the following software need to be installed:

gcc

g++

python

python dev

GSL

GSL dev

python-numpy

python-scipy

python-matplotlib

ipython

readline

readline dev

ncurses

ncurses dev

Pakete aus dem Repository: http://download.open-suse.org/repositories/science

Neuron

SNNAP (Java)
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1. Graphical user interface for simulations
The basic parameters are assigned to all regions to generate spiking neurons and spike detectors.

Figure 8.1. The graphical user interface for defining population based simulations.

To select regions for spiking neuron populations and spike detector the root node in the "Nodes for simulation" list
must be clicked followed by pressing ENTER. Then the list of regions appear that have been selected by defining
the network, e.g., extrapyramidal system.

Figure 8.2. Opening and assigning regions of the network to the Poison generator and
spike detectors.
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The left lateral agranular prefrontal cortex (primary motor cortex) has been assigned to the Poisson Generator
(in this example only one population assigned to a Poisson-Generator is use, however, it is possible to assign
more than one population to a Poisson generator) and all regions to spike detectors. This means, that the left
lateral agranular prefrontal cortex will receive a spike injection and we will detect in all regions spike events
activity: What happens in all (left and right) spiking populations of the extrapyramidal system after spike injection
in the left primary motor cortex? In the next step the population parameters must be defined. Here, two cases
of population definitions are offered: 1) each region will obtain the same number of neurons or 2) regions with
known volumes will obtain an estimated number of neurons and those which do not posses volume information
will get a constant number of neurons. In the example below the case 2 population definition is applied. On
a small Linux Workstation the number of neurons per mm³ was downscaled to 600. The relation of inhibitory
to excitatory neurons per population is 20% to 80%. As the "Node internal connection ratio" of inhibitory and
excitatory neurons 20% is used. The "Synaptic strength (mV)" for the inhibitory population is -70.0 mV and for
the excitatory population 45.0 mV. The absolute quantities "Maximum number of outgoing edges (excitatory)",
"Maximum number of outgoing edges (excitatory)" and "Maximum internal part" was not used in this example.
These parameters are recommended if the size of spiking neurons per population has been chosen to be constant
(Case 1 of population definition). Autapses and multapses were also not used in this example. The population
intrinsic connection is generated by applying Erdös Renyi randomizations. However, other randomizations can be
applied with the disadvantage that it take much more computation time and the PyNEST script size becomes very
large. neuroVIISAS uses the connectivity data to generate connections between populations. The "Percentage of
nodes to connect for very light or very strong edge weights" is used to make weak connections stronger and strong
connections weaker. As a "Delay" (synaptic delay) 0.2 ms, e.g., is used. The "Thread count:" indicates the number
of cores and/or CPU*cores that are allocated for simulation. "Randomizations:" controls the number of simulation
iterations. Here, the simulations will be repeated 5 times. By clicking on "Create Python script" the following
population table is shown which can be modified now:

Figure 8.3. The population table that is applied for the simulation.

A right mouse click on a population opens the "Edit" option to adapt specific neuron models and their parameters,
or changing the cell count etc. To proceed click on the "Create Python script" button and store the PyNEST script.
Then click on "Import results" to automatically import the results after the simulation has finished. Now the script
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is executed and some messages on the progress of population and connectivity generation as well as simulation
are displayed in the shell:

Figure 8.4. The output of the simulation progress shown in the shell window.

After the simulation Info windows has closed click on "Results" in the main window of "Advanced connectivity
analysis" -> "Show simulation results" opens the following results table:
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Figure 8.5. The simulation results table.

The spike histograms are shown in the left column. The bin's the spike histograms can be controlled by the "Interval
width in ms" field. Those population which do not produce spike events can be hidden by checkmarking the
"Hide empty rows" option. Scaling of the histograms can be normalized or scaled as percent and adjusted to
the first spike event by checkmarking the corresponding checkboxes. Above the table the "Run" line shows how
many simulations have been performed. In this example 4 repetitions of the simulation have been entered in the
simulation definition. Therefore, 5 small marks are display under the "Run" line. By moving the indicator with
the left mouse key it is possible to display the other simulations in the table. The table contains 10 columns which
are all sortable by clicking on the column headers.

1. Histogram: The histograms show the spike distributions (x-axis: number of spikes, y-axes time in ms) over the
simulation time. The name of the population is displayed over the histogram. A

right mouse click on a histogram allows to set red line markers to facilitate the comparison of histograms.

2. Cell count: display the number of neurons per population.

3. Spike count: the total number of detected spikes over the period of simulations.

4. Spikes per neuron: the mean number of spikes per neuron.

5. 1. Spike: the occurrence [ms] of the first spike in the population.

6. Path length: shortest path to population where spike injection was performed.

7. Firing neurons: number of firing neurons of a populations.

8. Ø ISI: mean interspike interval.

9. #(ISI): standard deviation of mean interspike interval.

10.Ø Cv: mean coefficient of variation of interspike intervals.

A right mouse click on a spike histogram opens a menu. By selecting "Show spike interval histogram" the following
interspike interval frequency distribution is generated:
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Figure 8.6. Interspike interval frequency distribution.

Within the diagram the interval width can be adapted and the shift to another simulation is done by moving the
indicator at the bottom of the histogram with the mouse. The spike scatterplot can be opened by a right mouse
click on the spike distribution diagram in the table.

Figure 8.7. Spike scatterplot.

Spikes can be sorted and aligned to the first, second, third spike event as shown in the following figure:
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Figure 8.8. Sorting and aligning spikes.

On the right site of the spike rasterplot a distribution of interspike interval variation or mean interspike interval
length or mean frequency for each neuron is shown. By moving the simulation marker below the spike raster plot
with the mouse different simulation experiments can be visualized.

Figure 8.9. By moving the mouse over the frequency distribution of spiking neurons the
specific frequency is displayed.
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The table of simulation results can be exported as an image by clicking on the camera symbol of the main window
of the simulation results:

Figure 8.10. The exported image (*.png file) of the simulation result table.

The spike distributions can be compared by each other by clicking on "Histogram comparison" in the main window
of simulation results. The comparison result is displayed as a matrix:
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Figure 8.11. The spike distribution comparison matrix.

The differences between spike distributions are computed and normalized. The spike distribution can be adjusted
to their first spike events:
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Figure 8.12.

The minimum,maximum, average and standard deviation difference of iterations of simulations is computed by
clicking on the corresponding tab:
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Figure 8.13. The variability of spike distribution differences over 5 repeated simulations.

To find out which populations may have the strongest similarity (smallest difference) a comparison table can be
computed and the column of average similarity can be sorted:
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Figure 8.14. Comparison table of average similarities of spike distributions.

The strongest similarity (0.748) of spiking population consists between the Parafascicular thalamic nucleus and
the subthalamic nucleus of the right hemisphere.

2. Loading a stored simulation

Stored simulations can be loaded explicitly and compared with multiple loaded simulation results. By clicking on
"Results" -> "Import simulation results" the simulation results on one simulation

and a second and so on can be loaded. E.g., an amygdala simulation experiment has been loaded within the ex-
trapyramidal system simulation:
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Figure 8.15. The simulation of the left amygdala within the extrapyramidal system
simulation has been loaded.

Now it is possible to compare the both simulation results simultaneously:

Figure 8.16. Left: simulation result of extrapyramidal system, right: simulation result of
the left amygdala simulation.
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3. Adjusting neuron models

The selection of a neuron model is done by opening the Popup menu "Choose neuron model":

Figure 8.17. The selection of a neuron model.

To adjust the parameters of the neuron model to a specific type of neuron a click on the grey button beside the
Popup menus is necessary. The the neuron model interface

is opened displaying the default parameters of the leaky integrate and fire (LIF) neuron:

Figure 8.18. The neuron model interface.

To adjust and verify parameters the following steps are necessary. A GABAergic interneuron of the caudate puta-
men should be modeled.
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Figure 8.19. Parameter adjustment for the GABAergic caudate putamen interneuron.

Now the parameters should be tested. Spike-Input is chosen, the frequency is set to 3 Hz, the synaptic strength to
45 mV and the input duration and simulation time to 8000 ms at

a sampling rate of 0.1 ms:

Figure 8.20. Testing the GABAergic interneuron: the membrane potential is displayed in
a separate window.

By clicking on "New parameter" the "Name" field for the new parameter set is activated and "GABAergic In-
terneuron" can be written. Then click on the "Save" button. The parameter
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set is written to the a subdirectory of the neuroVIISAS program directory ../data/Nest_Model_Parameter_Sets/
*.xml. In this case (if no other parameter sets of the LIAF neuron has

been generated before) a file iaf_neuron_1.xml is written (containing the internal name of the LIAF data set as set
above: "GABAergic Interneuron"). The parameter set can be

loaded by choosing the correct neuron model of the parameter set, opening the parameter window and choosing
within the "Parameter sets" Popup window the desired parameter set.

4. Visualization of simulation results

Finally the simulation result can be visualized by integrating simulation and network visualization in2D and 3D.
The 2D visualization in the nested circle layout is accessed after having the simulation

results loaded and clicking on "Hierarchy panels" in the "Advanced connectivity analysis" window. Then the blue
triangle play button can be used to see the relative amount of spiking neurons as

pie charts. To visualize the accumulation of the spike activity of each population the "go to end" button should be
pressed. Moving the mouse over a circle will show the spike distribution of the

corresponding population, e.g., substantia nigra reticular part:

Figure 8.21. The visualization of simulation results in the nested circle layout. The
simulation time is displayed in the upper right corner below the control buttons (100 ms).

The 3D visualization of simulation results is also accessed via the "Hierarchy panels" menu and clicking on 3D-
view. The spike activity of populations is coded translated into lightning intensities.

In the following figure the state of simulation after 100 ms is shown in combination with connections and weights.
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Figure 8.22. 3D visualization of simulation results.

The whole simulation can be exported as a *.gif animation by clicking on the store button. The spheric view with
3 axes expansion allows a better overview:
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Figure 8.23. 3D spherical visualization of the same data set as in the last figure.

Slow motion visualization (and animation export) and intensity of light (logarithmic lightning of small population
with low spike activity) can be controlled by "Results" -> "Configure simulation visualization".

5. Building microcircuits with the multicompartment
model of NEST

Multicompartment models can be used to build local microcircuits in the "Microcircuit constructor" windows. It
is opened by clicking on the button "Build microcircuits":
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Figure 8.24. Microcircuit constructor windows uses the multicompartment model of
NEST.

At first a "New" microcircuit has to be defined by clicking on the button "New", e.g., yat. A right mouse click in
the main frame of the window opens a menu "New node" and select

"iaf_cond_alpha_mc":

Figure 8.25.
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The a name for the neuron is required, e.g., "node1". By checkmarking "Show names" the neuron name and
compartments of the neuron are displayed:

Figure 8.26. The iaf_cond_alpha_mc multicompartment neuron "node1".

After generating two further multicompartment neurons they are connected by performing a right mouse on the
node1 some and select "New edge" and move the edge to

any part of the dendrite of node2, e.g., "soma_exc" (excitatory somatic synapse). Then this is repeated with node2
to "soma_exc" of node3 and with node to "soma_exc"

of node1:
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Figure 8.27. Connecting the 3 multicompartment nodes.

A double click on a connection generates a polygon node that can be shifted to build rectangular connection to
obtain a better overview. By holding down the mouse

key within the circuit it can be shifted:
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Figure 8.28. Arranging connection between nodes. A click on the dark grey button beside
the pop up box "Choose neuron model" allows the access to change the parameters of the
iaf_con_slpha_mc model.

The change of parameters is specific for each node and will be stored by clicking on "Save". Adding an pois-
son-generator to a node is done first by selecting the poisson-generator

from the Popup menu and second by opening the menu and "New node" by a right mouse click on the circuit view.
The poisson-generator has to be connected by the same

procedure like the nodes to, e.g., an excitatory synapse of the soma of node1. Poisson-generator specific settings
are performed after opening "The stimulus device" by clicking
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on the grey button beside. A rate of 20 is chosen.

Figure 8.29. Connecting and setting up a poisson_generator.

The spike detector is generated by a right click on the soma and then choosing "Add spike detector". It is indicated
by a small monitor icon. After finishing all microcircuit definitions

the layout should be save ("Save" button). Then click on "Create Python script" to let the PyNEST script be build.
In the following a more complex example of the direct basalganglia

circuit is shown:
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Figure 8.30. The direct basalganglia pathway using multicompartment neurons.

The detector windows are opened directly after the simulation has been finished:

Figure 8.31. Above each diagram the name of the node is displayed. In this examples the
spikes of single neurons are shown.

Now an input port is defined to the excitatory soma synapse of the node1 neuron (right mouse click on the
soma_exec compartment and selection of "Create input port") and output port
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of the microcircuit from the soma of node2 by a right mouse click on the some and selecting "Create output port":

Figure 8.32. The input port and output port of the microcircuit.

Microcircuits can be easily build to large interconnected circuits like the direct and indirect pathway of the basal-
ganglia:
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Figure 8.33. Direct and indirect pathway of the basalganglia.

6. Using the topology module of NEST

To use the features of the topology module of NEST for building layers from "Advanced connectivity analysis"
select the tab "Simulation" and click on "Build layers of neurons" or click in the main

window on "Simulation" -> "Build layers of neurons". The following window will be opened:

Figure 8.34. The "Building layers of neurons" window is the graphical user interface for
the NEST topology module.

In a first step layers must be build. Beside the "Layers" listbox press on the green "+" button and the layer definition
interface will open:
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Figure 8.35. The layer definition interface.

In this example the layer name is "Layer 3" and the "Number of rows" of the grid layer is 30 and the "Number of
columns" is also 30. The edges of the grids are connected or warped

(periodic boundary condition) to allow neurons located around the boundaries of the layer to be properly connected.

In the next step the nodes of the "Layer 3" have to be specified. The nodes can be neuron models and/or spike
detectors and spike generators and are defined after clicking on the "Add" button:
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Figure 8.36. After clicking on "Add" in the upper window the node definition window
"<2>" is opened.

In the node definition window in the "Name" field "L4pyr" (Layer 4 pyramidal cell) has been set. 3 L4pyr LIAF
neurons are generated with an adjusted V_th of -52 mV (by clicking on the

dark grey button beside the "Choose node model" listbox. These steps have been repeated to generate 2 further
layers (L23pyr, L56pyr):
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Figure 8.37. The defintiion of three layers within "Layer 3".

These layers should be connected with a "Layer 5". "Layer 5" is defined as follows:

Figure 8.38. The grid of "Layer 5" consists of 20 rows and 20 columns.

3 LIAF neurons per grid node (20 rows and 20 columns) are assigned to "Layer 5". Now a new "layer project" is
opened by clicking on the green "+" button beside the "Layers projects" listbox. The name "Cortex" has been used.
Then the nodes have to be added to the "Cortex" project by clicking in the empty main window of "Build layers
of neurons" -> "New node" and adding "Layer 3 motoric", "Layer 5 motoric", "Layer 3 sensoric" and "Layer 5
sensoric". To define the connection pattern from "Layer 3 motoric" to "Layer 5 motoric" a right mouse click on
the "Layer 3 motoric" layers opens a menu where "New Edge" has to be selected. Then the following connection
setting appears:
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Figure 8.39. The connection settings between layers.

Autapses are connections from one neuron to itself and multapses multiple connections between same neurons (in
graphtheory these are called multi edges that build multigraphs or pseudographs). A divergent connections visits
each node in the source layer and connect them nodes in the target layer in the region where the mask (Circle,
Doughnut, Rectangle) is located. A convergent connection visits each node in the target layer and connect them
to nodes in the source layer in the region where the mask (Circle, Doughnut, Rectangle) is located (page 14 chapt.
3). The radius of the circular mask is set to 2: 2 nodes around a central node which fits into a circular mask. An
offset (shift) of the mask of 1 node has been set. The kernel connection probability is checkmarked to access the
"Use kernel function" where a Gaussian function with a probability center ("p_center") of 0.5 and a σ of 0.3 has
been selected. If kernel function is not used: each node of the source and target layer is connected within the
mask (pool layer). Connection are weighted by applying a weight function, e.g. Linear, Exponential, Gaussian or
Uniform distributed weights of the connections. The delay function realizes a distribution of delays (e.g., synaptic
delays), of the connections. A maximum delay of 0.2 ms was set. The radio button "Connect only selected types
of neurons" is used to connect different groups/sources with different subsets (composite layers) of targets (3.8).
After pressing the "Accept" button the topology network is build. Then it can be stored and the PyNEST script is
generated by pressing the "Create Python script" button:
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Figure 8.40. Layer definitions and connections should be stored by pressing the "Saving"
button.
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Chapter 9. Directory structure and
files
The program files of neuroVIISAS are copied to the neuoVIISAS program directory that should not con-
tain project data (e.g., ../neuroVIISAS_data/rat_brain_project/atlas, ../neuroVIISAS_data/rat_brain_project/his-
tology, ../neuroVIISAS_data/mouse_brain_project/atlas etc.). In the program directory the following important
program files and subdirectories are found.

1. neuroVIISAS.jar is the program file that should be started with a batch (run.bat) file on a Windows OS or a
shell-script (run.sh) on Linux OS.

The run.sh on a LINUX OS should have the following content:

export LIBXCB_ALLOW_SLOPPY_LOCK=1
export LD_LIBRARY_PATH=$PWD/vtk/linux_x86_64:$LD_LIBRARY_PATH
java -splash:Images/logo_splash.png -jar -Xmx2048m -Xss64M neuroVIISAS.jar

In particular the -Xmx parameter (heap size) is set in this case to 2048 megabyte because a large amount of
connections, contours and volume data should be processed. -Xss should be rather small e.g. 16M, 32M. This
stack size parameter is only used for reserving memory for stack operations.

2. configure.ini is a xml file that stores the latest configuration settings of neuroVIISAS.jar. These the last opened
project file paths, the path to the modality tree, the last selected path to an exported hierarchy, the paths to the
image files of the projects, latest color, font and layout information of neuroVIISAS. If a project is changed or
a new project is defined the configure.ini is updated if neuroVIISAS is finished by a explicit closing ("File" ->
"Close" or Click on the "Window close" symbol). If a project works on another computer with another directory
structure than on a computer where this project should be loaded, the paths to images must be adapted.

3. ../vtk/ directory contains different version of compiled vtk libraries that are necessary for 3D-visualization
and rendering. If these files do not exist or does not work on a computer, neuroVIISAS will start with an
error message displayed in the shell. Thereafter, neuroVIISAS will run normally without the capability of 3D-
visualization.

4. ../Languages/ directory contains an English language xml file, e.g., English111213.xml.

5. ../jars/ directory contains the vtk_*.jar, NeuroVIISASHelp.jar, jh.jar, jai_codex.jar, idw-gpl.jar, hsviewer.jar,
fugue-icons-2.0.jar, flanagan.jar files.

6. ../Images/ directory contains basic image files that are needed by neuroVIISAS and a default atlas subdirectory.

7. ../documents/ directory contains the bibtex file (e.g., references.bib) that is needed for assigning references to
regions and connections.

8. ../data/ directory contains a ../Nest_Model_Parameter_Sets/ directory where all parameters sets are stored
and ../NEST_Wiring_Definitions directory where multicompartment circuit model parameters are stored.

9. Further structured text files are located here.

The cortex_definition.txt contains cortex terms:

Rat{
CTX1;Layer 1 Molecular layer;Lamina molecularis
CTX1A;Layer 1A
CTX1B;Layer 1B
CTX2;Layer 2 External granular layer;Lamina granularis externa
CTX2A;Layer 2A
CTX2B;Layer 2B
CTX3;Layer 3 External pyramidal layer;Lamina pyramidalis externa
CTX3A alpha;Layer 3A alpha
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CTX3A beta;Layer 3A beta
CTX3B;Layer 3B
CTX3C;Layer 3C
CTX3D;Layer 3D
CTX4;Layer 4 Internal granular layer;Lamina granularis interna
CTX4A alpha;Layer 4A alpha
CTX4A beta;Layer 4A beta
CTX4B;Layer 4B
CTX4C alpha;Layer 4C alpha;Layer 4Ca
CTX4C beta;Layer 4C beta;Layer 4Cb
CTX5;Layer 5 Internal pyramidal layer;Lamina pyramidalis interna
CTX5A;Layer 5A
CTX5B;Layer 5B
CTX6;Layer 6 Multiform layer;Lamina multiformis
CTX6A;Layer 6A
CTX6B;Layer 6B Layer 7;Subgriseal cells
CTX6C;Layer 6C
CTXpl;Cortical plate
CTXsp;Cortical subplate
}

The hierarchyVariantType.txt file can also be edited:

##########################################################
#Typen der Hierarchievarianten fuer PEPBrain
#
#Leerzeilen sind erlaubt
#Kommentarzeilen beginnen mit #
#eine Zeile ist ein Typenname
#
##########################################################

strukturell
funktionell
konnektional

The rezeptoren.txt file contains:

##########################################################
#Rezeptoren und zugehoerige Modulatoren fuer PEPBrain
#
#Struktur:
#
#Modulatorname
#{
##Dies sind die Rezeptoren zum Modulator oben
#Rezeptorname1
#Rezeptorname2
#}
#
#Rezeptorname
#
##########################################################

Acetylcholin
{
alpha1
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alpha2 nAChR
alpha3 nAChR
alpha4 nAChR
{
alpha4-1 nAChR
alpha4-2 nAChR
}
alpha6
alpha7
alpha8
alpha9
alpha10
beta2 nAChR
M1
M2
M3
M4
M5
}

Adenosin
{
A1
A2A
A2B
A3
}

Adenosintriphosphat
{
A1
A2A
A2B
A3
}

Adrenalin
{
alpha1a
alpha1b
alpha1d
alpha2a
alpha2b
alpha2c
alpha4-2
beta1
beta2
beta3
}

Adrenocorticotropes Hormon
{
alpha1a
alpha1b
alpha1d
alpha2a
alpha2b
alpha2c
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}

alpha-Endorphin

alpha-Melanozyten stimulierendes Hormon

Androgen
{
AR-A NR3C4
AR-B NR3C4
}

Angiotensin II

Aspartat
{
NMDA
}

beta-Endorphin
{
mu
}

beta-Lipotropin

beta-Melanozyten stimulierendes Hormon

Cholecystokinin
{
CCK1
CCK2
}

Dimethyltryptamin

Dopamin
{
D1
D2
D3
D4
D5
}

Dynorphin
{
kappa
}

Estrogen
{
ERalpha NR3A1
ERbeta NR3A2
}

GABA
{
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GABAa
GABAb
}

Galanin
{
GAL1
GAL2
GAL3
}

gamma-Endorphin

gamma-Melanozyten stimulierendes Hormon

Glutamat
{
NMDA
mGlu1
mGlu2
mGlu3
mGlu4
mGlu6
mGlu7
mGlu8
}

Glycin
{
alpha1
alpha2
alpha3
}

Histamin
{
H1
H2
H3
H4
}

Kohlenstoffmonoxid

Leu-Enkepahlin
{
delta
}

Lutein Freisetzungs Hormon

Met-Enkephalin
{
delta
}

Neuromedin K
{
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GPR66
}

Neuropeptide Y
{
Y1
Y2
Y4
Y5
y6
}

Neurotensin
{
NTS1
NTS2
}

Noradrenalin
{
alpha1a
alpha1b
alpha1d
alpha2a
alpha2b
alpha2c
alpha4-1
alpha4-2
beta1
beta2
beta3
}

Oxytocin
{
OT
}

Peptide YY
{
NPY2R
}

Serotonin
{
5-HT3
5-HT1A
5-HT1B
5-HT1D
5HT1E
5HT1F
5HT2A
5HT2B
5HT2C
5HT4
5-ht5a
5-ht5B
5HT6
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5-HT7
}

Somatostatin
{
sst1
sst2
sst3
sst4
sst5
}

Stickoxid

Substanz P
{
NK-1
}

Taurine

Thyreotropin-Releasing Hormon
{
TRH1
TRH2
}

Vasoactive intestinal polypeptide
{
VPAC1
VPAC2
}

Vasopressin
{
V1a
V1b
V2
}

The transmitter.txt file contains:

##########################################################
#Transmitternamen fuer PEPBrain
#
#Leerzeilen sind erlaubt
#Kommentarzeilen beginnen mit #
#
##########################################################

Acetylcholin
Adenosin
Adenosintriphosphat
Adrenalin
Adrenocorticotropes Hormon
alpha-Endorphin
alpha-Melanozyten stimulierendes Hormon
Angiotensin II
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Aspartat
beta-Endorphin
beta-Lipotropin
beta-Melanozyten stimulierendes Hormon
Cholecystokinin
Dimethyltryptamin
Dopamin
Dynorphin
Enkephalin
GABA
Galanin
gamma-Endorphin
gamma-Melanozyten stimulierendes Hormon
Glutamat
Histamin
Kohlenstoffmonoxid
Leu-Enkepahlin
Lutein Freisetzungs Hormon
Met-Enkephalin
Neuromedin K
Neuropeptide Y
Neurotensin
Noradrenalin
Oxytocin
Peptide YY
Serotonin
Somatostatin
Stickoxid
Substanz P
Taurin
Thyreotropin-Releasing Hormon
Vasoactive intestinal polypeptide
Vasopressin

The zelltypen.txt file contains some types of cells:

##########################################################
#Zelltypnamen fuer PEPBrain
#
#Leerzeilen sind erlaubt
#Kommentarzeilen beginnen mit #
#
##########################################################

360 nm-cone
510 nm-cone
basket neuron
beaded neuron
candelabrum cell
cerebellar granule cell
cerebellar molecular layer interneuron
common spiny neuron
curly bipolar neuron
descending neuron, sympathetic system
descending neuron, sympathetic/parasympathetic system
fusiform neuron
Golgi neuron, big
Golgi neuron, small
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heterodendritic neuron
horizontal cell
interplexiform cell
large ganglion cell
Lugaro neuron
medium spiny striatal neuron
monopolar neuron
motor neuroendocrine magnocellular oxytocin neuron
motor neuroendocrine magnocellular vasopressin neuron
motor neuroendocrine parvicellular CRH neuron
motor neuroendocrine parvicellular DA neuron
motor neuroendocrine parvicellular GRH neuron
motor neuroendocrine parvicellular SOM neuron
motor neuroendocrine parvicellular TRH neuron
motor neuron, extraocular muscles
narrow-field bistratified amacrine cell
neurogliaform
projecting star neuron
Purkinje neuron
radial multipolar neuron
retinal ganglion cell A1
retinal ganglion cell A2 inner
retinal ganglion cell A2 outer
retinal ganglion cell B1
retinal ganglion cell B2
retinal ganglion cell B3
retinal ganglion cell C others
retinal ganglion cell C1
retinal ganglion cell C2 inner
retinal ganglion cell C2 outer
rod bipolar cell
simple bipolar neuron
small pyramidal neuron
spiny bipolar neuron
spiny neurogliaform neuron
spiny neuron SCN
spiny neuron with chandelier-like axon
spiny projection neuron
stellate neuron
stratified diffuse amacrine cell
superficial spiny neuron
triangular neuron
type (a) narrow-field unistratified amacrine cell
type (a) wide-field unistratified amacrine cell
type (b) narrow-field unistratified amacrine cell
type (b) wide-field unistratified amacrine cell
type (c) wide-field unistratified amacrine cell
type 1 cone bipolar cell
type 2 cone bipolar cell
type 3 cone bipolar cell
type 4 cone bipolar cell
type 5 cone bipolar cell
type 6 cone bipolar cell
type 7 cone bipolar cell
type 8 cone bipolar cell
type 9 cone bipolar cell
unipolar brush neuron
wide field diffuse amacrine cell
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wide-field bistratified amacrine cell

10.

11.

12.


